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I would like to take this opportunity to introduce I-Cliqq to you all, and also let 
everyone know a bit about myself, and how we intend to go forward. Before 
mentioning anything else, I would like to express my thanks to God, without 
whom, I should say nothing of substance is really possible. We honor God for 
all the talents pooled in I-Cliqq, and I express my thanks for my gift. I also 
wish to thank my wife and family, for their undying support in our endeavors. 
  
 I am Saeed Shekari, creator and programmer of I-Cliqq Embroidery Software. 
I hope you all enjoy the work that has gone into I-Cliqq's baby version 1.0. All 
associated with I-Cliqq hope that you enjoy the software, and over the next few 
months you will all begin to learn a bit about the development stream , and 
become familiar with the people that will fly the I-Cliqq brand name. I am 
proud to say the pool includes a small, but dedicated global team that spans a 
few continents. 
 
Our work will be expanding over the coming months as we attempt to bring 
you the most productive and efficient functionality. What you do not see 
immediately, you will surely see as our development stream kicks into gear. 
We appreciate all feedback, although I-Cliqq must follow a prioritized 
development stream. 

 
 
Saeed Shekari 
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Chapter 1 

Getting Started 
Welcome to I-Cliqq Professional Embroidery  Software. 

The developers of I-Cliqq bring you a fusion of programming brilliance 
coupled with digitizer creativity & knowledge, infusing the logicality of 
fluent  processes to make your everyday embroidery tasks simpler, more 
efficient, and profitable. 

The manual, incorporates practical text, combined with video clips of the 
strategic features, giving you the ability to learn feature operation more 
visually. The I-Cliqq user forum will also contain frequent tips, tricks and 
new screen video. Updates to new features may have downloadable clips on 
the user forum or at www.i-cliqq.com 

Video Clips contain  information related  to function data.  Your media 
Player has controls to pause, rewind etc as you need so you have no 
limitation to seeing the clip well. It can also control the view speed. 

Please feel free to visit as often as possible to find extended product 
information and limited time offer specials on add-on options which will 
appear onsite from time to time. You will be required to log in securely, and 
your software should be open to access any downloads/updates. 

I-Cliqq features important protection for your investment .Your installation  
individually coded for  each purchaser so the contents of your package : 

a) Installation CD 
b) USB ‘Hardlock’ Protection Key 

should receive maximum protection from you, as the purchaser of I-Cliqq 
software. I-Cliqq features Integrated Security Trace for your protection of 
investment. Your package should be fully covered by business insurance. 

*Note : Package content may vary according to country. 

 

http://www.i-cliqq.com/�
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In the event of any of the package content, related to your serial codes 
being discovered in the hands of criminal or pirate elements where it may 
be deemed that you as the user have wilfully compromised your package, 
I-Cliqq reserves the right to terminate the package code. Your 
authorization codes, and package content should be kept separately and 
securely, ensuring maximum protection. Under the terms and logical 
recommendations, no full part of your package can really reach another, 
except by you, the user. 

 

The most important part of your software is the ‘Hardlock’ 
Protection Key. 

In the event of a malfunction , it must be returned to I-Cliqq. In the event of loss , 
a new package will need to be purchased. 

• Tip: You can install the Hardlock to a USB adapter linked 
from inside a small safe, if you are in an easily compromised 
studio or business premises. 

• The contents , clips and imaging in this manual, are intended 
to be representations and may differ slightly in the actual 
software due to ongoing developments and product 
modifications. I-Cliqq, while always attempting to display 
current information, reserves the right to change 
specifications without notice. Generally, you shouldn’t see 
any totally confusing variance from actual functions. Should 
you require to see a video clip update on any specific aspect, 
feel free to email I-Cliqq developers and we’ll make it 
available on the website/forum. 
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Product level features 

I-Cliqq is built on each subsequent product level, so some 
features of this manual may not be applicable to your product level 
– but use the opportunity to view all features, to decide how best 
the possible option you can always add, can enhance your 
business. 

 

Product levels TBA 

 

 

 

Mouse Conventions 
This manual uses the following  common conventions for mouse 

actions, and most are in accordance with universal mouse action. 



I-CLIQQ User Manual- all rights reserved 
All content remains the property of I-Cliqq  

4 

for your convenience. I-Cliqq can also be used with a tablet/pen 
combination 

 

Convention Symbol Description 

Click  Click the left mouse button 
 

Right-Click  Click the right mouse button 
 

Double-Click  Click the left mouse button twice without moving the 
mouse 
 

Click-Drag  Click the left mouse button and move the mouse 
 

Release  Release mouse button 
 

Shift-Click   Hold down the ‘shift’ button on the keyboard and Click 
 

Ctrl-Click   Hold down the Ctrl button on the keyboard and Click 
 

Alt-Click   Hold down the a button on the keyboard and Click 
 

Shift-Drag  
 

Hold down the ‘shift’ button on the keyboard and Drag 
 

Ctrl-Drag  
 

Hold down the Ctrl button on the keyboard and Drag 
 

Alt-Drag   Hold down the Alt button on the keyboard and Drag 
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Installing  I-Cliqq Professional Embroidery Software 
I-Cliqq software installation data comes on CD/DVD-ROM. To 

install I-Cliqq , follow the step by step installation instructions 
below: 

1) Put the installation CD into the CD drive on your computer. 
The Setup program will run automatically. If the Setup does 
not start, run Setup.exe from the installation CD. 
The Setup window appears next: 
 

Click on  the ‘Next’ button  
 
 

2) The following dialog will ask you the installation components 
and folder 
 
Click on ‘Next’ to install the software on the default location 
 

3) Following dialog will ask you the Program Folder 
 
Click on ‘Next’ to select the default program folder 

4) A progress meter will display file copy progress. 
 
 

5) When The file copy is complete, the following dialog will 
notify you of the Hardlock Driver setup. To Proceed Click on 
‘OK’ 
 
 
 

6) Depending on your Windows setup, the following dialog may 
be displayed to ask you the  preferred language,  
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you may select ’US English’ and Click on ‘Next’ 
 

7) Click “Next’ from the welcome dialog to install the  Hardlock 
driver. 
 
 

8) Setup will ask if you want to install Acrobat Reader. Select 
‘Yes’ to install Acrobat Reader or select ‘No’ to skip this step. 
You will need Acrobat Reader to be able to open user 
manual. Acrobat Reader is an external program, and can be 
installed separately. Most generally already use Acrobat for 
PDF viewing. 

 
9) Select ‘Finish’ to exit the installation program.  

 
 
Note: If for any reason you wish to uninstall the program, Select 
‘Add/Remove Programs’ program icon from Start > Control Panel. 
From the appearing window, select  ‘I-Cliqq’ and press on the 
Add/Remove’ button. 

The I-Cliqq installation does not modify any existing software icons 
on your system. 
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Registering  the Activation Key Code 
Once you have installed the I-Cliqq program, you have to 

register a key code. Activation Key code is a registration code you 
will receive from your distributor to allow the software to run. 

The activation key code file may come in two forms: 

1. An executable file like “ABCDE (I-Cliqq Level 2).exe” 
2. A text file like “ABCDE.x” 

 
To use the executable key code file, simply run it before starting the 
program, the key code will be registered automatically.  

To use the text file, simply copy it into I-Cliqq installation folder (the 
default location is ‘C:\Program Files\I-Cliqq2009’).  

If you start the program without registering any activation key code, 
you will be asked to enter a key code. The I-Cliqq Embroidery 
Software Activation dialog will be displayed as follows:  
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I-Cliqq Embroidery Software Activation 
 

 
 

You have to enter your activation code.  

Note: If you close the dialog without entering the key code 
correctly, the program will terminate abnormally and you will 
receive some error messages (use v + a + y to close the 
application). 

To enter the key code at this stage, you have to open the key-
code file which is in text format (‘ANCDE.x’) using Notepad (you 
can open Notepad on Start > All Programs > Accessories > 
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Notepad) and copy the code (press v + A then press v + 
C ) and paste/insert it into the Activation Code edit box (click on 
edit box and press v + V). Depending on your Operating 
System, you may also Right Click in the box, and a flyout showing 
‘Insert’ will appear. Select that. 

You can also enter the key code by running ‘Enter Key-Code’ from  
I-CLIQQ program group. If you upgrade your I-Cliqq program 

from a lower level to a higher level, you will receive a new key 
code from you distributor. You can enter the new key code using 
‘Enter Key-Code’ Program. 

Note: Using an incorrect activation key code will cause the 
product hardlock to terminate. It is highly recommended to 
keep a copy of your activation key code file in a safe place . 
If you have  lost your activation key code, please contact 
your distributor or I-Cliqq with your registered business 
details and Product Serial Code. 

Initializing and Running   ‘I-Cliqq’ 
Once you register the activation key code, you can start I-Cliqq 

by selecting it from the ICLIQQ program group, or you can double-
click the I-Cliqq icon on your desktop to start the program. 

*Note: I-Cliqq features Integrated Security, so when you 
double-click the program icon, startup will take some time, 
depending on the speed of your system. 

 

 

 

 

 

 

 



I-CLIQQ User Manual- all rights reserved 
All content remains the property of I-Cliqq  

10 

 

 

 

 

The program’s mask/ User Interface appears as below: 

 

 
 

I-Cliqq program mask 
The initial startup screen will appear dimmed. Click File >>New, and 
the active screen will open. 

All Toolbars are can be docked practically and the UI can generally be 
set up to suit any user preference. 

You have the freedom to streamline your interface at any time or 
restore toolbars at will. 

Your opening screen will appear blank- this image merely shows an 
open design.You can swap around your toolbars, anytime you want 
to, and this will be the UI that you see on each program start. 
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Chapter 2 

Basic Procedures 
I-Cliqq allows you to produce high quality embroidery through its 

easy-to-use, intuitive clicks, commands and tools. This chapter 
shows you how to create and open designs and how to work with 
commands, dialogs boxes and windows. 

Starting I-Cliqq 
Double-click the I-Cliqq  icon on your desktop to start the 

program. Alternatively, select I-Cliqq from the ICLIQQ program 
group, in the Start Menu. 

I-Cliqq opens according to the Preferences settings. The default 
setting is to open ‘Last Edited Designs’, but you can also customize 
the settings as you prefer the program to open. 

Once you start I-Cliqq, you can use commands or tools, and 
dialogs to complete your tasks. You select commands in I-Cliqq in 
the same way as other Windows applications, from menus, 
toolbars, or popup menus. Keyboard shortcuts are also available 
for the most commands. 

You will find similarities in some of the the tools, in relation to 
commonly used graphics programs, and as a novice or professional 
it is a reasonable assumption that you have had exposure to other 
similar or graphics programs – so  to all ends you will find I-Cliqq 
based on some commonalities, making your experience seem 
familiar and simple . 

I-Cliqq provides the tools, but embroidery is an age old art form 
requiring skills and continual practice to become competent as a 
designer. Technology assists to automate or partially automate 
some processes, but this should not be seen as an ‘end’, just as a 
practical assistance to creating designs. We, at I-Cliqq  believe in 
sound business advice, and our focus is on ‘need and requirement’ 
rather than just selling a software product. 
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Double Click the program startup icon that will appear on your desktop 
after installation. 
 

 
 
The splashscreen startup will appear. Startup time may vary according to the 
types of programs on your computer, and the general speed of your computer 
system. I-Cliqq  goes through a series of security procedures before initiating. 
Please be patient as I-CLIQQ Embroidery Software starts up.  
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The default screen will open , with all features dimmed. Click on 
File>>New , and the default opening screen will appear with all toolbars 
lit, and the screen default grid will show up.   You are now ready to 
explore the I-Cliqq interface.  
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Click on the small triangles on the lower right of icons, to expand or float 
the toolbars to new positions. You can dock these toolbars horizontally or 
vertically, in positions that appeal  to you.  
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If you close any of these toolbars at any time, they just revert to their 
original status as when you first expanded them. If you inadvertently 
close any, they have not disappeared, and there is no cause for alarm. 
Simply check their initial status. If you close any other toolbars, or wish 
to select any, then look in the dropdown menu VIEW> TOOLBARS, and 
you can simply check or uncheck toolbars to view. 
 

 

 
 
Hold down with the left mouse button on eg. The blue area of the 
toolbar, and drag to a new position to dock it. 
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Step 1: Check this aspect each time you install, or upgrade. 

 
Tools >Preferences>Screen Calibration 

 

 

Follow the instructions as shown. This procedure ensures you see designs 
in their correct proportions. If you reinstall the software, remember to 
check this aspect.  
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Notes : My Calibration Settings 
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Properties Box 

 

Click the shown Icon to open the main Properties Box. 
ae You can also use these keys to open/close Properties.  
The Properties Box controls all the advanced stitch parameters. Before 
trying anything regarding that, you might want to get familiar with the 
positioning of the Properties Box. It has a few settings that you can 
control, regarding where the dialog box sits in your screenspace.  
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Controlling the Properties Box Position 
 

 
 

Positioning the Properties box has a few simple options. 
 
 
 
 

 This icon highlights when the Properties Bar is undocked. Click it 
to roll the properties box up/down. 
 

 This icon displays when the Properties Bar is Docked. You can 
switch to the left or right of the screen.  You will see this dimmed 
view, if the bar is undocked. 
 

 Undock the Properties Bar 
 

 Dock the Properties Bar. 
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Create the optimum position for your convenience by experimenting with the 
simple controls. You can dock it ( to the left or right) , undock and float it , and 
roll it up/down. The properties box also slides in/out. If you double click in 
open screenspace, it hides. Double clicking any object will slide it open again. 
As you float your cursor over the edge, you’ll see a line control highlight. You 
can also click that to slide the sidebar closed. You can slide it open at any time 
by clicking against the screen edge. See screen video to see the operations in 
action. You can reposition the Properties Box at any time. No program restart is 
required, and no designwork  is affected. 
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Tabbed Page Information 

 

 
 
As you click on each tabbed page, you’ll see a caption for each as shown. The 
tabbed pages contain the advanced parameters for each stitchtype, and will 
always let you know current object parameters if you click on a native object. 
The tabbed pages display object related information. As you click on different 
objects, you’ll see the Properties box update to current information relating to 
that object. The Tabbed pages highlighted at the time, are features or functions 
related to the selected object. 

View the video clips to see a few basic actions and operation of the tabbed page 
setup. 
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Using toolbars 
Toolbars give you easy access to frequently used commands. 

You can choose to show or hide them for convenient or to increase 
your working area. 

To show or hide toolbars, from menu, select  View > Toolbars. 

 

 
 
Select the toolbar you want to hide or display. 

Tip: I-Cliqq toolbars are dockable. To move a toolbar to a more 
convenient position, click-and-drag it. To dock it in its normal 
position, double-click the toolbar title. 

 



I-CLIQQ User Manual- all rights reserved 
All content remains the property of I-Cliqq  

23 

Selecting options from toolbars 
 

 
 

• To find out what each  button icon does, rest the pointer 
over the icon. A ‘flyout tip’ appears, displaying the name of 
the icon, you can also see the shortcut of the command. 
 

• Click the icon to activate the command. 
 

• If the icon has a black triangle on its lower right corner,  
o Click on the black triangle to see more icons 

available on a panel. These panels are dockable. To 
move a toolbar to a more convenient position, click-
and-drag it. To dock it in its normal position, close 
the toolbar by clicking on the  button. 

 
 
o View the video tutorial taking you though a few of 

the screen functionalities. 
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Using popup menus 
Right-clicking on a selected object opens a popup menu 

containing frequently used commands. The content of this popup 
menu depends on the tool you are using: 

The Popup menu when using the Object Edit Tool    

 

 
 
A similar menu appears  when using Node Edit Tool  

A similar menu appears  when using Stitch Edit Tool  

The Popup flyout menus are interactive with functions in use.  If 
you see a function ‘greyed’ out, or dimmed it is either not selected, 
or ‘inactive’ during  the current operation. The commands in the 
different popups differ, according to the tools/functions in use at 
the time. 

Note: A frequently used command is Properties. This opens the 
Object Properties dialog for the selected object. You can also select 

 (Standard Toolbar) to open properties dialog. 

Tip: If you double-click on an object or selected object(s) (when 
using Object Edit Tool (  ), the Properties dialog will open and 
the parameters of the selected object(s) will be shown. 
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‘Undo’ and ‘Redo’ commands 

This is a standard operating procedure, common to numerous programs. 
 

 

Use Undo (Standard toolbar) or press v Z  to undo command 
Use Redo (Standard toolbar) or press q v Z to redo command. 

Tip: Clicking on the icon ( ) next to Undo and Redo icon, will open a 
popup menu and lets you  select a stage of ‘undo’ or ‘redo’ in the preset 
levels. 

Note: If Undo or Redo icons are dimmed, it means there are no commands 
to undo or redo. 

You can undo the effects of most commands. If you change your mind, 
you can redo them . I-Cliqq can remember unlimited commands, but the 
undo level default is the last 16 commands used. You can change the undo 
level from the Preferences dialog. To open the Preferences, select Tools > 
Preferences…, Preferences dialog will open, Click on the General tab-page. 
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General Notes 

 

 

• Special notice : Any and all design reference in  avi clips, is merely for display 
purposes. 

No part of the clips may be used in reference to any companies with branded 
names, copyright logos, or trademarked imaging – all these remain the intellectual 
property of the respective companies. Design data displayed is merely from designs 
produced with permission , and under license. Imaging is merely part of I-Cliqq 
functioning display and should never be regarded as anything outside such. No part 
of any image viewed, shall be misunderstood as any kind of endorsement, or 
infringement on any company/groups intellectual property rights. Any special 
notification of unintentional breach should be communicated directly to I-Cliqq. 
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Notes 
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Preferences 
 

 
 

Change undo levels on the general page of ‘preferences’ dialog 
 :This option will define the undo levels. 

 

:  If Undo after save is checked , you will be able to use the 
undo command after you  have saved your design. 

View the video to take you through the general preferences. 
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Grid Preferences: 

 : This uses the workspace background color 
to determine the grid color. 

 

 : This option is only active if you 
are using ‘Background Color’ and the slider controls the grid 
appearance with the lowest setting being a soft appearance, and 
the highest being very distinct optically. 

 

 Check this radio button to select a custom grid 
color. 

 

 
Click the triangle to open the color selection box, and simply 

click on a desired grid line color. 
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General/Save/View/Options 
Go to dropdown menu Tools > Preferences 
 

View: has sub-preference menus to allow you to customize 
design views. 

Options: Here, you can check or uncheck to allow digitizing 
beeps. 

*To hear sounds, your system requires a sound card. In general, 
most Audio Functioning is controlled by your operating system.   

I-Cliqq Sound Feature is meant for digitizers working in 
production environments, and it can be unchecked if you prefer to 
use your own music, other sound ambience or work in silence. 

I-Cliqq also allows you to designate an image editor.  

(See Ch 16) 
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Preferences Dialog Box 
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Opening designs 
 

 
 

Ctrl+O  allows you to Open designs, or you can simply use the 
File>Open command to open designs from your created 
directories. 

Tip: Clicking on the icon ( ) next to   Open icon, will open 
a popup menu and lets you select one of the last 10 opened 
designs. 

You can open I-Cliqq vector embroidery files, as well as most 
popular stitch files. You can also open I-Cliqq font files and motifs 
to modify. 

 

*Specifications of vector import files can change without notice due to 
ongoing format changes within industry. 

 

 

 

To open a design 

1) Click on  Open icon, the Open dialog opens. 
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2) Select a folder from Look In list. 
3) Select a design or designs 

• To select a range of items, select the first item and 
then hold down q and select the last item. 

• To select multiple items, hold down v as you 
select. 

 
4) To choose a specific file type, click on File of type and 

select your desired file type. 
5) Click Open. 
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Creating new designs 

 
 

 Use New (Standard toolbar) to start a new design with the default 
template. 

Whenever you click on the   New icon, a blank design ( “untitled” ) 
opens using the default template. Save it with a new name. 

You can create ‘templates’ for different default values. If I-Cliqq detects 

any user template, whenever you click on the  New icon, to start a new 
design a dialog opens and lets you choose a template for that new design. It 
is also possible to choose a template for a design which is already created.  

See Design Templates for details. 
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Saving designs 

 

 
 

Saving designs is as simple as any other normal Windows functioning: 
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File> Save, and Save As commands allow you to save, or overwrite files 
as you desire. Machine Files ( eg dst., dsb. etc should be  ‘EXPORTED’ to 
save these types) 

 

 

 

 Export 

 Import 

These icons are visible on the Standard Toolbar. 
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 Print Design 

 

 
Related Design Print options are visible in the FILE dropdown 

menu. 

 Cut 

 Copy 

 Paste 

The basic icons on the Standard Toolbar are also available in the 
FILE dropdown menu. 

 

 

 

 

I-Cliqq remembers the last accessed folder with regard to Save, 
Import, Export facilities, so makes your tasks simpler. 
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Saving and Backing Up- General Notes 
 

Backing up in any business is an ‘imperative’ to avoid design/data loss. 

Although I-Cliqq features a design backup, this will not assist you in the 
even of a total computer crash or hard drive failure. 

All businesses today invest in different forms of data backup. Online 
backup systems are gaining in popularity. 

I-Cliqq recommends the use of an additional hard drive and/or external 
hard drive. Most sysyems today come with automatic backup software that 
just needs to be set up once with the user designating important folders/files 
etc.  

ALWAYS take the time to back up your custom creation/settings 
folders from the C:\Program Files\I-Cliqq2009 folder. If  your have 
specially created fonts, motifs, templates or profiles, backing these up is 
an imperative. 

 Due to the frequent changes performed on embroidery designs, I-Cliqq 
recommends this initial method as opposed to CD or DVD , so that you have 
the most current updated files. 

You can, as an additional precaution periodically save to DVD or CD and 
store in a separate location from your business premises, as no degree of 
business insurance can replace your design data if lost due to fire or theft. 

 

Backing up data is the sole responsibility of any computer user. 
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My Backup Notes/Codes/Locations 
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To save a design 

1) Click on Save icon.  
If this is the first time you have saved the design, the 
Save As dialog opens. 

2)  

 
 
 

3) Select the folder where you want to save the design 
from Save In list. 

4) Enter the name for the design in the File name field. 
5) Click Save. 
6) Generally, be cautious in your use of Save, and Save 

as, you have the power to overwrite files. 
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TIPS 

Tip: Once you have  saved a design, every time you click Save on the toolbar 
the file will be updated. If you see “Save’’ as grey, it indicates no changes have 
occurred. 
 

Tip: I-Cliqq will save your designs every 15 minutes ‘automatically’ by 
default. You can change the incremental save period. 

The Auto-Backup option will let you work without worrying about losing 
your design, but it is recommended that you save your design early and 
often. Create a filename as soon as you start a new design. 

Auto-Backup will backup your design (under the name 
“Auto_Backup_Of_DESIGNAME.clq”) in the same folder as the main 
design. 

 

Whenever you save your work, I-Cliqq will make a backup of your old 
design (under the name “Backup_Of_DESIGNNAME.clq”) in the same 
folder as the main design, then will save your design and finally will remove 
the Auto-Backup file.  

 

You can set the Auto-Backup time from the Preferences dialog. To open the 
Preferences, select Tools > Preferences…, Preferences dialog will open, Click 
on Save tab-page. 
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Save page of preferences dialog 
 

 
 
 

 :  

This option enables or disables Auto-backup option 

 : 

 Adjusting this option defines the time between each  Auto-backup 

: 

If this option is enabled, it will make a backup whenever you save the 
design. 
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Exporting Stitch Files ( Machine File data) 
 

 
 

Use Export (Standard toolbar) to save stitches in any 
standard stitch file formats. These are the files that you will send 
to your embroidery machinery. 

To export stitch files: 
1) Select Export. Export dialog will open. 
 

 
 
2) Select the destination folder that houses your machine 

file data. 
3) Select export format ( eg DST) from Files of type list. 
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4) Enter the name of the design in the File name field. 
5) Click Save. 

 
You can change stitch export settings from Design Properties. 

These are the output defaults that affect your saved machine file.  

 

 

 

To change export settings 
1. Select File > Design Properties…, design properties will 

open. 
 
2. Select Output Defaults tab page and change the settings 

and select OK. 
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 Importing designs 
 

 
 

Use Import (Standard toolbar) to merge a design with the  
current design. 

To import a design 

1) Select Import.  Import dialog will open. 
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2) Select the target folder that houses the file you wish to 
import. 

3) Select the  import format from Files of type list to limit 
the list of files to a specific format. 

4) Rest the pointer over the design and click to select it. 
5) Click Open. 
 

The desired file will then open in the workspace. 
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I-Cliqq Workspace with  open design files. 
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I-Cliqq Intelligent Jump Setup 
Extra jumps before long jumps , and shorter jump length 

between objects will help in preventing thread breakage on your 
machine and will increase your machine working time efficiency. 
Intelligent setup and use of this feature , can also save you many 
unnecessary needle breaks that often occur in sudden jumps. To 
single head, and multi-head users alike, costs are always a 
concern. Most do not weigh up long term  losses , and most are 
sometimes not even aware that their business is sustaining 
avoidable losses. 

Check your machine manual for its most effective jump 
parameter setup, in order to help you set up the I-Cliqq related 
parameters that become effective on your machine. I-Cliqq files 
will generally override some machine functions, but some 
machinery features independent jump control capability via its 
control panel, so depending on how the machine files are read into 
the machine, some machines will require setting adjustments, via 
the control panel. 
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You can change the jump length factor by clicking on 

Stitch>>Change Jump Length. 
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This will apply to the selected objects, or all objects as per the radio 
button selected. 
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You can also click  on the Color Manager to open Design 
Properties and set Output Defaults. 
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View Video Tutorials to see functions in action. Take note of 
small additional features that may be displayed at the same 
time. 

Features are not shown in total  isolation, because that is not 
the nature of the software. In function–specific clips you will 
also see references to related functions, that you will again 
see expanded on later, in those function clips. In this way, we 
introduce you to the interactive functionality so that by the 
time you have completed the tutorial, you will have the 
interactive mindset of the software, in your mind too. As you 
become fluent in tasks, you will find other shortcut 
methodology is also integrated in the program, and there is 
not just one specific method of accomplishing a task string. 

The clips are designed to give you a general overview of the 
main performance methods of I-Cliqq. 
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The dropdown ‘File’ menu also contains the File Import /Export functions 
among other frequently used general functions. 
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Design Browser 

You can use Design Browser to browse designs from your hard 
drive/s. 

To open designs using the Design Browser 
1. Select File > Browser…, Browser dialog will open. 

 

 
 
 

2. Select a folder from the folder list panel on the left. 
3. Right click on design, a popup menu will open and the 

design view border will be displayed in grey. 
4. Select Open all Selected to open the designs or choose 

Select for open to add the design to the selection and 
when finished selecting, choose Open All Selected to 
open all selected designs. 

 
5. Tip: You can Cut, Copy and Paste designs from a folder 

to another. If you click and drag a design and drop it into 
a folder, a copy of that design will be created in the 
destination folder.  
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I-Cliqq supports common drag, drop, swap functionality of 
the common operating systems. 

Tip: Double click on a design to view it in single form in the  
browser window. To return to multi view mode, double click on the 
design again, or press ESC 
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Click on 3D View, to view the design in 3D view style. 
This is commonly known as Simulation or Sewout View. Visual 

enhancements are undertaken on a continual basis and additional 
capabilities may be added without notice. Visit the forum to check on 

update information. 
 

 
 

Double click on the design or press ESC to return to multi view 
mode. 
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Design information and database 
Design Information dialog : You can check detailed design 

information. 

To view design information 
1. Open the design using Open 
2. Select File > Design Information…, Design Information 

dialog will open. 
3. Select Statistics tab-page to view design information. 

 

 
 

You will get some information about the file, stitches, colors and 
thread usage for each color and total thread usage. 
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To view design database 
To view design database: from Design Information dialog, select 

Archive tab-page. 

In this page, you can define the fabric type, yarn used to 
embroider the design, customer name and designer name. You can 
add a note to your design. You also have the option to define the 
design category. 

This information will be saved with the design and if you complete these 
fields whenever you create a new design, you will be able to search the 
designs by the information at the database as well as other search items like 
design size, colors, stitches, through I-Cliqq Search Utility from the 
Windows Explorer.  

See I-Cliqq Search Utility for details. 
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Modifying design category database 
You can add, remove or change the items defined in design 

category of the Archive page.  

 

 

 

To add an item or sub item 
1. Click on the item you want to add a sub item to.  
2. Right click, popup menu will open. 
3. Select Add item or Add sub item, an item captioned ‘New 

Item’ will be added to the category 
4. Enter the item caption from the keyboard. 
5. Click on a blank area to finish. 

 
 
 
 To remove an item 

1. Click on the item you want to remove, the item will be 
displayed with a blue background. 

2. Right click, a popup menu will open. 
3. Select Remove item, to remove it. 
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To rename an item 

1. Click on the item you want to rename, the item will be 
displayed with a blue background. 

2. Click on the item again and wait for one second, the item 
caption will be displayed within a box 

3. Enter a new name 
4. Click on a blank area to finish 

 

 

 

Searching and opening designs from windows explorer 
 

I-Cliqq provides a search utility integrated with windows 
explorer. To search designs from windows explorer, rest the 
mouse over a folder or hard drive and right click, a popup menu 
will open, select Find I-Cliqq Embroidery ,  I-Cliqq search utility will 
open. 
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Find I-Cliqq Embroidery 
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Chapter 3 

Viewing Designs 
I-Cliqq provides multiple interchangeable viewing methods to make it 

easier to work with your design. In this chapter you learn how to use Zoom 
and Pan tools. You will also learn how to view designs in different view 
styles and how to show or hide various workspace and design elements with 
the available display settings. You can show or hide outlines, needle points, 
connectors, stitch directions.  

Zooming in and out 
You can magnify your view of the design to focus on individual 

stitches or other details, or zoom out to display more of the design 
in the window. 

I-Cliqq provides a variety of easy methods to zoom in and out 

 Select Zoom (Edit and Digitizing toolbar) to zoom in and out, 
when using this tool, the pointer will change to  

• To zoom in, rest the zoom pointer over the design 
working area and click to display a design at twice its 
current size 

• To zoom out, hold down q (the zoom pointer 
changes to ) rest the pointer over the design working 
area and click to display a design at half its current size. 

• To zoom in by window (zoom box), click and drag to 
open a window on the design working area 
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Whenever you use Zoom, any current command will be 
terminated and Zoom will be activated as the current command. 
You can use the  Zoom tool without terminating a command. For 
example while you are digitizing an object, like running, you can 
zoom in and out and then continue digitizing. These commands are 
called  ‘ transparent commands.’ 

Zooming in/out with your mouse wheel is a simple transparent 
command. 

 
 

To zoom in and out transparently 
 

• Press F2 to activate Zoom 
 

o To zoom in, rest the zoom pointer over the design 
working area and click to display a design at twice 
its current size. 

o To zoom out, hold down q (the zoom pointer 
changes to ) rest the pointer over the design 
working area and click to display a design at half 
its current size. 

o To zoom in by window (zoom box), click and drag 
to open a window on design working area 
 

• Press Z to display a design at twice its current size. 
• Press qZ to display a design at half its current size. 
• Press F3 to display previous zoom 
• Press F4 to zoom to all objects 
• Press F5 to zoom to the selected objects 
• PressqF5 to display the design at actual size 

 
 
You can use all the above transparent zoom commands within 

any other command. 
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Tips: 

 If your mouse has one wheel (  ), to zoom in according to a 
specific point on design, simply place the mouse pointer over your 
desired focal point and scroll the wheel.  If you scroll the wheel 
forward, the design will be zoomed in and if you scroll the wheel 
backward, the design will be zoomed out. I-Cliqq intelligent zoom, 
keeps the object centered, so if you place the mouse pointer over 
the center of any object/s and scroll your mouse wheel, those 
objects are the focus of the zoom. 

If your mouse has two wheels (  ), you will have to hold down 
q then start scrolling. 

Tip: While you are digitizing, press ( for Full Screen Preview.  

 

 

Once you set the display to full screen mode, press ( again or 
press s to set the screen  to normal mode again. When you are 
in Full Screen Preview mode, the only active command will be the 
command you were using before full screen mode. This is helpful 
to digitize, and reduce eye strain. 

Ctrl+F9 – Allows you Fullscreen + Open Toolbars View. 

Return to Normal Screen by tapping the same keyset. 
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v(  Press these keys to view fullscreen WITH toolbars in use. 

You can revert to the normal screen by tapping the same command keys. 
Using these features, will let you work in maximum screenspace. It’s also 
very useful on laptops. 
 

 

Stitch Type Toolbars in use are visible in this mode. 
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Panning across designs 

To use Pan, open Zoom Panel by clicking on  
 

 

Click on triangle shape to open zoom panel 

Select Pan (Edit and Digitizing toolbar), move the pointer 
over a point on design window, then click and drag the screen to 
any direction, to view parts of a design that are not currently 
visible in the design window. 

In addition to the scroll bars, panning provides a quick way to view parts 
of the design which are not currently visible. Panning is typically used after 
zooming in on an area.  

Panning transparently 
 

• Press F6 to activate Pan transparently. 
 
You can press F6 to pan across designs while you are 

digitizing without terminating the command. 

Tip: You can also use scroll bars on the design window to scroll 
the design. 

Tip:  If you are using a dual scroll-wheel mouse (  ), you can use 
the wheels to scroll across designs. 
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Tip: Auto Scroll command will scroll the design automatically 
while you are digitizing. Auto Scroll will act automatically by 
default, but you can disable it, or have it active but make it work 
whenever you are holding down the q key. To change the Auto 
Scroll option, select Tools > Preferences…, Preferences dialog will 
open, Click on View and select Paths tab-page. 

Autoscroll Preferences 

 

 
 

Set auto scroll options from the ‘view’ page of preferences  
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If this option is checked, Auto Scroll will act automatically, if it is 

unchecked, Auto Scroll will be disabled. 

 
If this option is checked, Auto Scroll will act only when you have 

held down the q key and moved the pointer close to the design 
window border ( edge of the screenspace. 

The workspace is also referred to as the ‘canvas’ . You can 
change this size at any time in the Design Properties Dialog. 

 

 
You can set the speed of Auto Scroll using this track bar 

 

 

Edge Sensitivity : This is a convenient setting, which can be 
adjusted to an individual preference. Setting the pixels (generally 
a setting of 35 pixels may be deemed sufficient as a maximum, 
and a minimum may be 10 pixels from the edge) , controls the 
distance away from the edge that ‘autoscroll’ will activate at – so 
basically autoscroll will become active at eg 35 pixels from the 
workspace edge, moving your design within a convenient range. 
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Check a radio button to effect a scroll preference. You can 
change these at any time. Midway Scrolling may suit the designer 
operating on larger designs. Some users prefer to scroll manually, 
so you can opt for the scroll by ‘shift’ key is that is your 
preference. 

 

Dynamic Zoom 

 
Tap ‘B’ to show /hide the Dynamic Zoom Window. 

This window is resizable by dragging to a practical size 
anywhere, and I-Cliqq remembers the last position/size. 

 

(See also Chapter 16) 
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Design viewing settings 

Dropdown menu : Tools >>Preferences >>View 
In this dialog box, you’ll find View sub preference settings. 

View video to see how these settings affect overall View 
capability. 

You can change the display setting to view object paths 
(outlines), needle points, thread between objects, stitch directions, 
machine function symbols. You can also show or hide objects, or 
even lock or unlock objects. You will also learn how to change the 
thread colors and background color. You can also select a 
background image for the 3D view style. 

 

 

 

 

Viewing stitches and outlines 
Viewing modes are easily changed by just a click, and allow you 

to switch and swap between view modes that you find most 
convenient during different parts of the design process.*Tip: 
Always refer to Stitch>>Always Refresh setting, to see whether it 
is : 

Checked or Unchecked – this influences the view, if objects are 
selected, or if you need to perform object travel etc. The preferred 
setting is : 
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Always refresh ‘on’ (checked) 
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View Settings 

 

 
Click the small triangle to open the alternative view flyout. 

 

Select Draft View (View toolbar) to display only paths 
(outlines). When you select this mode, outlines will be displayed 
the same as needle colors, in other view styles, outlines will be 
displayed in the color defined in Preferences. For more details see  
View settings. 

Select Normal View (View toolbar) to display outlines and 
stitches. Right click to change Normal View settings. 

Select Enhanced View (View toolbar) to display outlines,      
stitches and stitch points. Right click to change Enhanced View 
settings. 

  Select Stitch View (View toolbar) to display only stitches.  
      Right click to change Stitch View settings. 

 

Select 3D Sewout (View toolbar) to display a design as it 
appears on fabric. Right click to change 3D View settings.  
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Tip: To view an Object Outline while in 3D mode, tap the L key. 
This will display the object outline if you wish to digitize in 3D 
mode. Tap L again to hide the outlines. 

 

 Select Stitches Enhanced View (View toolbar) to display 
stitches and stitch points. Right click to change Stitches Enhanced 
View settings. 

 

Select View Special Functions (Machine Functions toolbar) to 
display machine code symbols applied to each object. 

 

 
 

 

 Select Connectors (General Toolbar) to display thread 
between objects and see machine functions (connectors). 

 

 

 Antialaias Mode – This shows a smooth line effect in Normal 
View modes. 
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View Design Start/End and Autoset Design Center. 

 

 View Design Start/End Indicators:  This shows you the 
design start /end Indicators in red/green. 

 

 AutoSet Center : Clicking this icon Actively sets the design 
start/End to the center. If a hoop is displayed, it will automatically 
detect the hoop center. If no hoop is in the screenspace, it will 
automatically set the DESIGN start/end to center.  

 If Autoset Center is ‘off’, you will see these 2 icons 
highlighted. Clicking each , and selecting a position, will allow you 
to manually set the start end positions, or create a custom position 
if necessary. 

 

 

 

 

 
 

Tip: You can change additional  view settings from Preferences, to 
change the settings, select Tools > Preferences…, Preferences dialog 
will open. 
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Note: Stitches will not be displayed in Draft View mode. Make 
sure to set another view mode if viewing stitch files. 

 

 

 

 

 

 

 

3D View settings 
Click to view the video tutorial on basic view settings. 

All the parameters in this page will affect 3D View style. 

You can change light source position for a different appearance of 
designs. View Style will change the 3D View appearance method on screen. 
Thicker thread view in zooms will display the thread thickness according to 
the zoom factor. Increased zoom factor will mean increased thread thickness. 
If this option is unchecked , threads will be displayed with a constant line 
width in different zoom factors. 
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Note: You can change Sequin Color and Sequin Diameter to 
change the sequin appearance in 3D View. These sequin 
parameters will be effected on all the objects except Sequin Run. 
Whenever you open a stitch file including sequins, you can change 
the sequin appearance from this page. Sequin Run has its own 
sequin view parameters. 
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Enhanced View settings 
You can choose stitch point symbols for Enhanced View. Symbol 
colors can also be changed. To change Enhanced View settings, 
open Preferences dialog and click on View and select Enhanced 
tab-page. 

All the parameters in this page, will  be effected in Enhanced View 
mode. 

 

 

 High Resolution ( Antialias Mode) gives you a higher 
resolution view. 

 

 

 

 

 

 

 

 

 

 

 

 



I-CLIQQ User Manual- all rights reserved 
All content remains the property of I-Cliqq  

78 

Viewing Jumps/Stitches 

 

 
 

You can set colors , and indicators  for stitches and jumps. Once 
set, these will display in the respective related view modes. 
Remember to set solid colors carefully, depending on the screen 
backgrounds you choose. Eg. Do NOT set ‘Stitches’ indicators as 
RED, if you work on a permanent RED screen background. The 
same should be observed with any other solid color settings. 
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View objects first / last stitch 
 
I-Cliqq  allows viewing each object’s first and last stitch in 

Enhanced or Normal View. You can choose a symbol for object’s 
first and last stitch for Enhanced or Normal View. Symbol colors 
can also be changed. 
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To change Enhanced View settings, open Preferences dialog, 
click View and select Object tab-page. 

 

 
 

All the parameters in this page will be effected in Enhanced or 
Normal View mode. 

 
You can select a view symbol, by clicking on the associated radio 

button. 
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Outline View settings 
 

You can choose the outline display color. You can change these in relation 
to your images being used, or the background color you have chosen  

To change outline view settings, open Preferences dialog, click 
View and select the OUTLINES  tab-page. 

All the parameters in this page will be effected in Normal and 
Enhanced View modes. 

*Tip: Because the intelligent logic of I-Cliqq uses some specific 
colors during onscreen operations, the user is required to exercise 
some degree of care, when choosing and setting colors of outlines 
etc. Your best results for your onscreen work, will be to avoid 
using conflicting colors. 

An example: ‘View Unstitched’ which actually shows you an instant 
visual sequence of stitched vs unstitched areas in a pattern , is by default 
assigned ‘BLACK’ for maximum screen visibility. Although you have the 
option to change this color in relation to specific backgrounds etc, you may 
wish to practically set ‘Outline ’ color to example , the color of the active 
objects in your Palette/Color Management Setup. Taking care in assigning 
functional colors , will give you the most pleasant onscreen working 
experience. 
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Changing needle colors- Color manager 
I-Cliqq features effectively one of the most intuitive, functional 

and intelligent Color Management features in the world today. 

Display of ‘needle sequence’ is always an irritation for many a 
designer, and while its always difficult to present, I-Cliqq gives you 
some definite power over this display. 

The Color Manager is intuitively linked by color to object 
capability, and used in conjunction with Object Manager gives 
you total control over instant re-sequencing  by color or object 
groups. 

Color Palettes can be just normal screen colors, or you can 
select from a simulated thread color range to give you a realistic 
idea of your every creation. 

This Color manager is  ‘dockable’  horizontally, so it can be 
moved like most other similar functional toolbars. 

The look is very simple, and streamlined and while it way seem 
to be just an indicator of color, with some practice and play, you 
will discover that it is actually a core object color, and sequence 
controller. 

There are various palette selection and effect methods. I-Cliqq 
features the power of drag/drop/swap technology to make your 
tasks pleasant, simple and actually fun in this predominantly 
‘Business Tool Application.’ 
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Eyedropper Tool 
 

 

Have you ever struggled over matching colors for presentations?? Well, 
struggle no more. I-Cliqq provides you with an intuitive tool range in line 
with One-Click modality, and functioning throughout the software, featuring 
the ‘intelligent click!’ to make your tasking as simple , and powerful as 
possible. 
Whether you’re a corporate or fashion digitizer, imaging and color 
matching is a part of everyday requirement. There’s no way to escape 
it, and it has to get done. How many times have you tried matching 
screen color to images, or needed to know a closest thread match 
from HSB or RGB color compilations? 
 
*Note – Screen Color is no substitute for actual thread color, but 
allows you to put together effective visual presentations fast.  

The feature is simple, and the results fast and practical. 
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Select the  Eyedropper Tool while a stitch object is selected. 

Float the cursor over an image containing the color you wish to 
match.  

 The mouse cursor icon will change as soon as you click on the 
tool. 

Click when you see the desired color in the Eyedropper color view 
window. The new object color is visible instantly. 
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It works best with solid color imaging, and reasonable resolution. 
Generally most corporate imaging is basic solid color, but you are not 
limited to this. General 300dpi photo imaging will also give you 
excellent result. If the resolution is too low, then the detection 
sensitivity may detect an odd shade, so you may need to select a few 
times if you have really scratchy and poor images. Sometimes you 
may just see a group of objects just referred to as ‘object’ in a video 
clip – this is just used in reference to a selected ‘object group’ or 
‘color’. The video clips are very simple, and explain concepts within a 
few minutes of viewing each. Your chosen media player can ‘loop’ 
each one for you, so you can watch it as many times as you feel 
necessary. 

The simplest way of digitizing, is to effectively use contrasting colors 
to your image, to create the initial design, because this is sensible for 
easy visibility and effective editing etc while your design is in process. 
‘Color Dropping’ can be performed last, because its usually applied to 
color groups. In I-Cliqq, this is simple. All you do is click on any color 
block in Color Manager, and you will see the color group selected. 
Offset or duplicate and offset your image if you wish to discard one 
after use. 

Once you see the selected color ( surrounded by black handles it will 
appear ‘dashed’ in its native color) – just click on the eyedropper tool, 
and click on any image color, and the detected shade is assigned 
instantly. 

You may then assign actual thread colors for your reference and 
production worksheet, but your ‘presentation simulation’ is DONE!  
No more time wastage trying to wade through 16 million hues, to try 
to emulate your image specifications. I-Cliqq has done it for you in 
just a click. 
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Changing design working area, background color and 
background image (for 3D  Fabric View) 

 

 

 
Click the icon to open Design Properties. 
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You can set the working area size, change the background color 
and select a background image for 3D View style. 

 

The design working area, is the area workspace you see covered 
by the grid. This designwork area, screenspace, or workspace is 
also sometimes referred to as ‘the canvas’ , making you, a thread 
artist! 

 
 

To change these settings, select File > Design Properties, to 
open Design Properties dialog and select Background tab-page. 

To change the design working area, change Page Width and 
Page Height parameters. 

To change background color, move cursor over the color palette    
and click-drag to set the background color. You can also select a 
predefined color from Background Color List. 
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To open a background image: 
1) Click on this button to open background image dialog 

to select an image for 3D View mode. 
 

 
 

2) Select a folder from Look In list. ‘Background’ folder 
will open by default  

3) Select an image 
4) Click Open. 
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Changing design working area, background color and 
background image (for 3D View) 

How to disable the feature: 
 

 
 

 
Click on this button to exclude the background image. 

Once you have selected a background image, Use Background 
Color option will be enabled on Design Properties dialog. You can 
set this option to mix a  background color with background image 
to create different fabric color effects. 
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Select this option and experiment with changing background 

color to mix background colors with a background image, to create 
different fabric color effects. 

Note: Background imaging  for applique’ will only be displayed 
in 3DSewout View mode. 
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Displaying stitch direction 
 

To display stitch directions, Select View > Workspace > Stitch 
Directions or press a & : an arrow at the end of each stitch 
will show you the stitch direction. Repeating this command will 
hide Stitch Directions. 

 

Stitch Direction ON will give you an indication of the 
design pathing  for flow of the design. This mode does not 
influence the design in any way except to indicate the 
direction of stitching. 

 

 
 
Note: Stitch direction will not be displayed in 3D View 

mode. 
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Displaying the grid 
 

 
 

 Click Grid (General Toolbar) to show or hide the grid.  

Right click on the Grid icon to change Grid settings. 

Grids help you accurately align or size objects. Default grid 
spacing value is 10mm x 10mm. Grid value will change according 
to the measurement unit you select.  
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Changing the grid spacing 
I-Cliqq offers you the flexibility to switch seamlessly between Inches 
and Metric Unit Measurements. You also have the added flexibility of 
saving any design with your desired grid setup, whether its in inches, 
or metric units. 
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To change the grid spacing, select Tools > Preferences…, 
Preferences dialog will open, click on General tab-page. You can 
also right-click on Grid to display settings. 

 

 
 

This is the Preferences Dialog where you can adjust numerous 
settings. You can experiment, and always  reset them. 

These settings remain active unless modified. Last settings become 
the default. 
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You can set grid spacing practically with 0.01mm accuracy. 

If you choose Inch units, the grid spacing will be shown as 1/32, 
1/16, 1/8, ¼, ½ and 1 inch. 

 

 

 

If the Draw Grid Over Images option is checked , the grid will 
be drawn over images. If unchecked, you’ll see the grid, but it will 
not intersect  the image. 
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To save your custom grid settings with the current design, check 
the shown box in Preferences. This feature is invaluable if you’re 
learning measurement systems, and also if you need to save specific 
designs in different measurement setups. Together with the system 
onscreen ‘Ruler’ that shows you Metric/Inch factors simultaneously, 
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you should be adept at both measurement systems within a short 
time. 

 

You can also simply set your grid colors to any practical color that suits 
your visibility. 
Further, you can also set the sharpness factor by adjusting the grid 
visibility slider. If you prefer a very outstanding grid, you can 
increase the slider factor. 

 
If you prefer a passive grid visibility, decrease the factor. 

The updated view is available after you click ‘OK’. 

 

 
If you check this option, I-Cliqq will save designs with the Metric/Inch 
units. 
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This image shows a tiled view of designs with different grid 
measurement unit setups. 

 

 

 

 

 

 



I-CLIQQ User Manual- all rights reserved 
All content remains the property of I-Cliqq  

100 

 

Adding and removing guidelines 
 

 
 
You can add horizontal and vertical guidelines to the design 

working area and use Snap to Guidelines whenever you want to 
create accurate design guidelines. 

 

 

To use guidelines : View>>Toolbars>>Rulers must be checked. 
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To add a guideline  
1. Rest the pointer over the rulers on the top or left side of 

design working area. 
2. Click and drag the pointer to design working area and 

release the mouse button on a desired point.  
If you click and drag on vertical ruler (on the top of the 
working area), a horizontal guideline will be added, and if 
you click and drag on vertical ruler (on the left side of 
the working area), a vertical guideline will be added. 
 
 

To delete a guideline  
1. Rest the pointer over the guideline 
2. Right click, a popup menu will open, select Delete 

Guideline  
Tip: you can click on the guideline and drag and drop it 
over the rulers. 
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To lock or unlock guidelines 
1. Rest the pointer over the guideline 
2. Right click, a popup menu will open, select Lock 

Guideline  
To lock all guidelines, select Lock All Guidelines 
To unlock all guidelines, select Unlock All Guidelines 

 
 

 

 

 

 

Note: Once a guideline is locked, it can not be deleted unless 
you unlock it. 

 

View the screen video to see a few operations on Grids/Guidelines.
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Show or hide cross-hair cursor 
 

 Select Cross Hair Cursor (General Toolbar) to show or hide 
cross hair cursor. 

 
When you choose to show the Cross Hair Cursor, a vertical and 
horizontal line will display with the pointer on design working area. 

 

 
 

The General Toolbar can be docked vertically or horizontally as you 
prefer. 

Most I-Cliqq toolbars feature full docking capabilities as is practical, 
allowing you to set up your screen interface just as you prefer. You 
can color buttons, and button backgrounds with reasonable color, 
making your interface as attractive and visible to you as necessary. 
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Measurement units 
You can select Metric or Inch unit systems for all displays or 

measurements. To change the units, select Tools > Preferences 
>> General tab-page and select Millimeter or Inch units. You can 
switch between the measurement systems at any time in the 
design process without restarting the program, so if you are 
learning you can always use this for reference purposes. 
Millimeters is actually the ‘Metric’ system of measurement, and the 
most accurate for embroidery purposes. 

 

 
 
 

I-Cliqq gives you numerous measurement tools, evident in all the tooltips 
you can activate .Whether its stitch lengths , grids, guides, vector outlines 
or onscreen active rulers, your data intake is always constant and flexible 
to suit your every need. 
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Measuring distances on screen 
To use Measure, open Edit Panel. 

 

 
 

 Select Measure (Edit & Digitizing toolbar) or press & to 
measure distances on screen. Simply drag from an initial point of 
reference, to a second point of reference, and you’ll see the ruler 
measurements update as you drag. 
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Measured distances will be shown in millimeters and inches . 

This feature is excellent for those learning metric, or if you have 
clients giving you design measurements in inches. 

Tip: For an accurate measurement, you can use Snap to 
Objects, Grid and guidelines. You can also zoom in before you 
measure. The measurement is not affected by zoom factor and is 
always the actual size. 
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To measure a distance on screen 
 

1) Select Measure tool, or select Edit > Tools > Measure, 
or press &  key from keyboard. 

2) Click and drag the pointer to the end point and hold the 
mouse still. 
 
• Measured distance (D:81.18 mm) 

 
• Measured angle in degrees (eg. 49 º) 

 
• Measured horizontal distance (Dx: 53.29) 

 
• Measured vertical distance (Dy: 61.23) 
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Note: Press - to snap to stitches or objects for an accurate 
measurement. 

 
If you drag to measure onscreen, the ‘ruler’ will remain onscreen 

until you drag to masure again. 
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Positioning zero (Origin) point on the design working area. 
When you open a new design, initially the zero point will be 

located at the center of the working area. Horizontal and vertical 
rulers will be graded according to this point as you can see on the 
rulers. You can change this point and set it to your desired point.  

 

 

To position or reposition zero (Origin) point 
1. Rest the point over the intersecting area of the rulers at 

top left corner of the design working area. A hint 
displays. 

2. ‘Rulers’ Toolbar must be activated to dispose the zero 
point. 

3. By performing this action, you can align the grid to 
images. 

4. Click and drag the pointer to the desired point on your 
design working area and release the mouse button. Two 
horizontal and vertical lines will be dragged while you 
move the pointer. 

5. You can move the zero point as often as required by 
repeating the process. 
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Grids and guides are useful for alignment purposes, ensuring a high 
degree of accuracy when setup correctly. These can be used for 
alignment of imported designs , aligning images , setting up your 
image before digitizing , creating editing guides for node correction in 
linear work , and generally seeing that design creation is accurate. 

It ensures the setup is best for machine production. Its also 
handy when setting up continuous designs, so you can display the 
machine head spacing distances accurately. If your product level 
contains the ‘shapes’ and ‘paths/outlines’ options, you can also use 
these tools interactively with your grid and rulers to create 
multiple visible guide markings for your designwork and delete 
these objects at will. 

There is no set ‘rule’ as to what you may use as guidelines. The 
vector/outline tool is instantly available to create quick guides that 
you can simply delete after use. If you do use the vector tool to 
create guides, remember that these can also be converted to 
stitches , so be sure not to select them if you are converting 
specific objects to embroidery. 
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This image shows guidelines only. Grid is switched ‘off’ 

Guidelines show as a dashed line. 
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Highlight 

 
 

Highlight activated, shows you generally ‘short stitches’ in any design 
immediately, letting you see trouble spots instantly. Its related feature is 
‘Filter Short Stitches’ 
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The integrated Highlight feature in I-Cliqq assists you especially in assessing 
the integrity of machine files. 

Highlight icon  

 Image 1 

 Image 2 

 

Switching the Highlight feature ON, shows you indicators of where short 
stitches are located in your design files. Image 2 shows you the visual effect. 
You can preset a specific value. The default maximum length setting is 
0.5mm which effectively means the software will show you any short 
stitches of 0.5mm and below. 
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Objects to Highlight 

 

 
 

You can use the selection filter by simply checking/un-checking  the stitch 
types to be highlighted. These can be adjusted at any time. In essence, this 
allows you to check specific stitch types, or all. 

 

The Stitch Type default is set to ALL. 

You can select Normal Stitch which allows you to check topstitching. 
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If you select Underlay/Travel Stitches – then highlight will show only 
short stitches in the underlay and travel stitching. 

 

Additional Preferences 

 
 

The preferences dialog contains numerous user preferences that you can 
use to tailor the appearance of your screen, and also set the variance on 
options. The default duration of ‘hint display ’ is 0.5 seconds. You can adjust 
the onscreen display by using the Hint Duration slider. 
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Hints 
 

 

 

 
 

 Hints are sometimes just called ‘Information Tooltips’. These display as 
you rest your mouse cursor over icons, to give you an indication of what 
each ‘icon’ means, in the way of its related functioning. Spending some time 
in just floating your cursor over icons, assists in letting you become familiar 
with the icons. Hints also display while digitizing , or when you perform 
operations on objects. Eg. Move/rotate. These are excellent visual indicators, 
assisting you in being accurate onscreen, with ease. 
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Transparency  
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If you are running a capable computer with good resources, you might want to 
change the transparency settings. You can also leave these at ‘minimum’ or reset 
them at any time. In general, changing the Properties Transparency may cause a 
noticeable difference if you have poor system resources , so in general, to see 
performance in such options, you need to have a system with optimum resources , 
because general industry use of vector graphics programs, and general memory 
intensive work is common. 

 

 

 

Tips 

 

 
In general, you may have many programs, and many folders. Most use PC’s 
for personal uses like playing games ,listening to music, and storing pictures 
and video. Try to keep your hard drive uncluttered. Make sure that you have 
at least 75% free space at all times. Invest in an external drive/drives because 
you can store information like pictures/video/music on these without totally 
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slowing down your computers. Most people believe that because a HD 
seems ‘large’ , its ok to utilize all the space. This is a common 
misconception , and many have numerous errors, because the operating 
system cannot carry out commands, because the system processor is under 
strain…So, bear in mind that you need to keep your system well 
‘maintained’ to ensure good performance.  

 

 

 
3D Tab Page 
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This is also referred to as 3D Sewout View mode.  This setting controls 
the general appearance of the simulated thread view. The settings 
are simple and self explanatory. To experiment with the different 
light source effects or view styles, simple select a setting and click 
OK. 

 

 
An example of 3D Sewout  Mode. 
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Design Tab View 
View >Toolbars> DesignTab View Toolbar 
 

 
I-Cliqq allows you to see an image preview of the tabbed 

designs. This toolbar can view on the left or right of the screen. 

Floating your cursor over open designs shows you a preview, 
and clicking on any will open the design . 



Chapter 4 
 

Defining and Manipulating Objects 
 
Here you will get familiar with ‘objects’ and their creation. 
I-Cliqq is similar in operation to popular graphics programs so if you are 
basically familiar, you will find objects very simple to understand. In an 
embroidery program the objects are stitch data and elements relating to stitch 
data. 
 
View the video tutorial on the basic stitch types and how these translate into 
object data. 
 
I-Cliqq provides a variety of methods to create these objects and operates on 
some properties of Bezier Modes adapted for the purpose of object creation. 
The clips will use the method of ‘arc-spline’ creation which most may find as 
the most fluent and simple method of object creation. Advanced users may find 
the other 3 methods useful at different times within design creation. The 
digitizing toolbar becomes visible only when a stitch type is selected for use, 
but you can switch between modes seamlessly even while digitizing. 
 
As you become familiar with the stitchtype buttons ( icons) and their creation 
capabilities, you will be able to set the creative embroidery designer in you free, 
as you enter the world of  I-Cliqq and the power of stunning yet functional 
embroidery creations. The stitch types most commonly used are satin and 
‘tatami’ stitching. An internet search of embroidery stitch types will reveal that 
many similar types are known by different names across the world, but the 
general output results are all basically the same. 
 
The difference with I-Cliqq, is the power you are given to manipulate 
parameters of such creations to give you possibly the most beautiful adaptive 
stitch types and effects known in the world today. 
 
I-Cliqq  will let you decide for yourself how the ancient and beautiful art has 
been modified by our technology and innovation to provide you, the user with 
in many cases, the most powerful embroidery creation tools on the planet. 
 
 
 
 
 
 

I-Cliqq User Manual 123 



In this chapter you will also learn various ways to select and modify the 
objects in an embroidery design. The Object Manager will help you to 
easily change objects order. You can group and ungroup, lock and unlock, 
show and hide objects. I-Cliqq provides various ways to select objects. 
You can  also use keyboard shortcut keys to travel over objects and 
stitches. ( See Shortcut Keys and the Video regarding Shortcuts) 
 
When you edit objects, the stitches will be refreshed automatically and 
instantly. Always Refresh ON is the default mode of higher operations in 
I-Cliqq although you can perform most tasks of creation with this feature 
set to ‘OFF’ but when treating a design with high end functions like 
INSERT of objects, Travel by stitches on objects etc, Always Refresh 
needs to be set to ON. Having the feature set to OFF also gives you an 
alternate type of view mode while working, but it can be set to ON 
anytime within the design process as necessary. If you want the stitches to 
be refreshed after editing, you can set stitch refreshing mode to off. When 
stitch refreshing mode is set to off, the stitches of the selected object will 
not be shown until the object is deselected then the stitches will be 
refreshed and displayed. To set the stitch refresh mode to off, from menu, 
select Stitch > Always refresh or press CTRL + Enter. 
 
 Shortcut keys are displayed in all dropdown menus, and appear on 
every icon/button hint where possible. Eg..The stitchtypes of Satin = 
‘s’ , runstitch = ‘r’.  Refer  to ‘Shortcut List’. You can print out the 
reference guide. 
 
I-Cliqq will ‘remember’ the last refresh mode, next time you start the 
program. 
 

 
 

 
 
 

 
 

 
View Changes on selected objects when Ctrl+Enter is pressed. 

If deselected, the view automatically changes to ‘stitched ‘ again as the 
refresh is now being performed  as soon as the object is inactive. 
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Object edit tool 
 

 Object Edit Tool is the default active tool. This selects onscreen 
objects. 

 
Selecting all objects in a design 

 
 

The 3 buttons associated  with Select/Deselect and Invert Selection are easily 
recognizable. Float your cursor over buttons to see the related ‘hints’. 
 
Deselecting objects 

 
Click ‘Deselect all’ icon (Property toolbar) to deselect objects. 
 
Tip: you can also deselect objects using the following methods. 

• Press  s 
• Select another object. 
• Click an empty area on the design working area. 

 
 

Invert selection 
 
Click Invert Selection (Property Toolbar) to invert selection. 
 
Tip: Invert Selection merely swaps selected objects. 

If you had object 1,2 and 3, and have selected object 1: Pressing Invert 
Selection , now shows object 2,and 3 as ‘selected’. 
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Selecting objects with object edit tool 
 

 Select Object Edit Tool to activate object selection. 
 
Note: When the pointer shape is same as this shape  , it means 
that Object Edit Tool is active.  
 
To select objects 
 
You can use the following ways to select objects: 
 

• Click on the object you want to select. 
 

• Note: I-Cliqq provides an intuitive way of selecting, and viewing 
an object. If you select an object in a group of overlapping objects 
I-Cliqq draws the object visibly to the front, to give you  a full view 
of the object shape…This is merely for best visibility if you are 
performing some ‘stitch surgery’  on your creation. You may be 
travelling  by stitches, creating an insert, or performing a stitch 
edit. This ‘view’ is only in effect when the object is selected – 
Once deselected the object  slides back to its position in the 
overlapped sequence of objects as it was – By selecting  the 
object, you have not changed its position in the ‘design 
sequence’. 
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Adding Objects to your selection 
 

• To add more objects to the selection set, hold down the q 
key and click on the objects. 
 
 

 
 

• To select objects with a bounding box, Click on a blank area and 
drag a bounding box around the objects you want to select. When 
you release the mouse button, objects within the bounding box 
will be selected. 
Tip: you can hold down the q key to add / remove objects to 
/ from a  selection set. While holding down these keys you can 
click any object in the set once – this will deselect it, and another 
click will select it again. 
 

       
 

•  
 Tip:  You can click on Select Next Object (Property Toolbar) i 
 
Tip:  Right click Select Next Object (Property Toolbar) to 
travel by color forward. 
 

• To select the previous object in order, press qt key. If 
there is any selected object, it will be deselected first and the 
object prior to the selection will be selected. 
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Travel Backward or Forward by Object 

 
 

Tip:  You can click on Select Previous Object (Travel Toolbar) – 
Travel backward by object with left mouse clicks. 

       The opposite action occurs on the related button. 
 
       Tip:  Right click Select Previous Object (Travel Toolbar)  
                     To travel to the previous color group. 
 
• To select objects within a polygon (lasso object select), hold 

down the  v key and click some points on the design working 
area to define a polygon around the object. Double click to finish 
lasso object select mode. Any object which is located within the 
polygon will be selected. OR – Use the Polygon tool button icon. 
 

 
 
Tip: You can also use the combination of q and v key to 
add / remove objects to / from selection set. 
 

• When an object is selected, 
o Press q h, to select all the objects prior to the 

current one until the first object. 
• Press q u, to select all the objects next to the current one 

until the last object. 
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Lasso Select 
 
Rectangular/Square Lasso 

 

 
Click the Lasso icon, and drag to envelope an object. 
 

 
 
You can also select by clicking on an object using the Object Edit Tool. 
Dragging  around an object to envelope an object in Object Edit mode is the 
same as using the Lasso tool. Even if in Square/Rect Lasso mode, you can just 
hold down v to initiate Polygon Lasso Mode, and just drag or click around 
objects to select them. 
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Polygon Lasso 
 

 
 
Clicking the exact Lasso icon, toggles between Square, and Polygon type 
selection. 

 
 
Click a set of points around an object/s and double click to finalize the 
selection. Press ESC to exit lasso mode. 
 
 
 
 
 
 

I-Cliqq User Manual 130 



 
 
 
 
Dragging with Polygon Tool 
 

 
You can also just hold down the  left mouse button and drag around objects to 
select them. Double click once you enclose the object/s. Like so many other 
simple I-Cliqq operations, you will see the cursor icon change to indicate a 
‘mode’ , for convenience. 
 
 
 
 
 
   View of selected objects 

 
Normally selected objects are specified by displaying sizing handles 
around them, but you can choose to display selected objects highlighted 
on screen. This will help you to recognize selected objects where there are 
many objects close to each other. You can activate viewing objects 
highlighted from the Preferences dialog. To open the Preferences, select 
Tools > Preferences…, Preferences dialog will open, Click on View tab-
page and select Object. 
 
Select Dashed selected objects and select OK. 
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Viewing ‘Stitched’ vs ‘Unstitched objects 
I-Cliqq gives you the instant ability to view the ‘design sequence’ 
instantly. The visual data gives you an immediate impression of the 
sequence in which objects will be stitched on the machine. By pressing 
‘V’ on your  keyboard, you’ll see the interface icon  activate/deactivate. 
 

 
 
This icon is on the General Toolbar. You can dock it vertically or 
horizontally. 
 
A view of ‘unstitched’ objects as you click an object in the design 
sequence. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

I-Cliqq User Manual 132 



Note: Regarding ‘View Unstitched’ Objects’ 
 
You may find yourself constantly switching between  the 2 modes. When 
it is switched off, you will not see any visual change except objects will 
just be selected in their original colors. This is convenient if you do not 
want to see the sequence all the time during the design process, but its an 
essential feature when doing a design check, or wishing to insert objects 
in a stitching sequence, or even within an object. Inserts within objects 
become nested  there as if they were always part of the stitching 
sequence, but this capability allows you unlimited  treatment to your 
design sequence. 
 
Most digitizers prefer to receive constant visual information about design 
sequences, and measurements. ‘View Unstitched’ is another visual 
indicator of design status. 
 
 
Inserted objects can be copied/pasted/deleted/converted the same as any 
other object. A user is required to apply some thought when attempting to 
adjust a sequence, considering that embroidery contains machine 
functions, so when inserts or edits are done, its best to do them as 
seamlessly as possible, so that you do not unduly compromise the 
stitching sequence. 
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Filter selection 
 

Filter selection will let you filter the selected object by object types 
and / or by object colors. This is a convenient feature that avoids 
you manually deselecting each group or stitch type and is a big 
timesaver overall when used correctly during the design process. 
 
To filter selection 

1. Select the objects by the mentioned methods. 
2.  Select Filter Selection (Property Toolbar) or press  v F,  

The Filter Selection dialog will open. 
 
Selected object by type         Select objects listed by color 
  Number of selected objects  Number of selected objects  

of the same type   of the same color 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
To remove any type of objects from the selection, uncheck the mark 
beside object type name. And to remove a color from the selection, 
uncheck the mark beside the needle color. 
 

3. Click OK 
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Object manager 
 

Object manager provides a list of all objects in a design. It offers an 
easy way to select objects, change objects order, locking and hiding 
objects and applying machine functions on objects. 
 
To view object manager 
 

 Select Object Manager, it will be normally viewed and docked 
at the bottom of the design working area. 

 

 
 
 
Note: Click on  Object Manager for the second time, to close 
object manager again. You can also click on Close at bottom right 
side of the object manager window. 
 
Tip: Rest the pointer over each object to view more details about 
that object, like object number, type and stitches. 
 
Object Manager, is an integral part of the design process, and used 
in conjunction with the integrated Color Manager gives you full 
control over objects, object groups, and the entire color groups. 
 
View the video tutorial to familiarize yourself with this feature. 
It features the same drag/drop/swap functionality of Color 
Manager, except it applies to objects. Object manager can be 
docked, resized, moved as you need, but its standard horizontal 
position is ideal. 
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Floating and docking object manager 
 

Object Manager window is only dockable to the bottom of design 
working area but you can also float it on the screen. Once you float it on 
the screen, you can drag and drop it to dock it to the bottom of the 
window again. You can also resize object manager window to view more 
objects at once. 
 
Tip:  Select Reduce image size to reduce the object view size to fit 
more object in object manager at once. 
 
To floating object manager 

1. Click on left side of object manager panel. 
2. Drag it into a location on screen and release the mouse button. 

 
To dock object manager 

1. Click on title bar of the object manager window 
2. Drag it into the bottom on the design working area and release the 

mouse button. 
 
 
To change the object manager window size 
Click on lower edge of the object manager window and resize it like other 
Windows applications. 
 

 
 
Note: Objects will be displayed from left to right on each row. 
 
Note: When object manager is resized and objects are being displayed in 
more than one row, it will show the same rows when it is docked back to 
the bottom of design working area. This will reduce the design working 
viewable area on your display. It is recommended to reduce the size of the 
object manger window to one row display, and then dock it to the design 
working area. If the object manager displays same as bellow and you 
want it display in one row 

• Float the object manager on screen. 
• Resize it so that it displays only one row. 
• Dock it to the bottom of design working area. 
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Working with object manager 
 
Object manager provides a full control over objects. You can also change 
the order of objects as well as hiding and locking objects. You can cut and 
copy objects and paste objects between other objects. 
 
To select objects with object manager 

• Click on each object on object manager to select it. You will see 
that the object will be shown as selected on design working area. 
 

• To select a range of objects,  
a. Select one object 
b. Hold down q key 
c. Rest the pointer over the last object and click 

 
• To select multiple objects, hold down v as you click. 

 
• To select all objects, press v A. 

 
Note: Selected objects will be shown with a highlighted border in the  
object manager window. Floating over objects in ‘highlight’ mode will 
display a different highlight color. 
 

 
Type in an object number to select an object. 
 
 
To show or hide objects with object manager 
 

1. Select the objects you want to hide 
2. Right click on the selected object in object manager window, a 

popup menu will open. 
3. Select Hidden to hide the objects. The Hidden item will be shown 

as checked mark next time you right click on it. 
 
 
Note: When an object is hidden, you will not see it on the design working 
area and you will not be able to select it ordinarily. You will however see 
it in object manager . It will be highlighted in grey. You may select it only 
on the Object Manager. 

I-Cliqq User Manual 137 



 
 
 
 
 

To show or hide objects with object manager 

 
 
Tip:  You can hide or show objects using the icons on General Toolbar. 
 

 Select Hide Object(s) (General Toolbar) to hide selected 
object(s). This Icon will be dimmed if no object is selected. 
 

 Select Show All Hidden Objects (General Toolbar) to show all 
hidden objects. Note that it will show ALL hidden objects, but you 
can show a hidden object individually from object manager. 
 

To lock or unlock objects with object manager 
 

1. Select the objects you want to lock 
2. Right click on the selected object in object manager window, a 

popup menu will open. 
3. Select Locked to lock the objects. The Locked item will be shown 

as checked next time you right click on it. 
 
Note: When an object is locked, you will see it on the  design working 
area but you will not be able to select it using Object Edit. You will only 
be able to select it  on the Object Manager. 
 
Tip: You can lock or unlock objects using the icons on General Toolbar. 
 

 Select Lock Object(s) (General Toolbar) to lock selected 
object(s). This Icon will be dimmed if no object is selected. 
 

 Select Unlock All Locked Objects (General Toolbar) to unlock 
all hidden objects. Note that it will unlock ALL locked objects, but 
you can unlock each object individually from object manager. 
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To change object order with the Object Manager 
 

1. Select objects from the screen or in object manager window 
2. Click on border area of a selected object. 
3. Drag them between other objects where you want them to be 

located and release the mouse button 
4. Note: when you drag the selected objects, a dragging box will be 

shown while you move the pointer. 
 

 
 
 

         To apply machine special functions to objects 
 

1. Select the object you want to apply a machine function to. 
2. Right click as shown on the object manager window. 
3. Select machine special function to apply to  the object. 
 

 
 

Note: Object Manager and Color Manager are related managers . You can 
open or close these at will, and resize the display to allow active or 
passive views. 
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Changing Object Colors 
 

Color changes in object groups  means ‘needle changes’ on the machine. 
Each color block is defined by a  number. 
 
To change object colors 
 

1. Select the object/s you wish to change colors on. 
2. Click Needle Number  list box and select a needle number for the 

selected objects. The popup palette will display on  Color 
manager. 

 

 
 
If you start digitizing, it will be in the current selected color. Exit any 
digitizing by pressing ESC, if you would like to change a color. You can 
also simply complete any object in any color, and change that when the 
object is selected. 
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When an object is selected, or even if you have a group of objects 
selected, you can change colors in a few clicks. Simply select the object, 
open the palette, and click on a color. You’ll see it applied instantly. 
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Moving, resizing, rotating and skewing objects 
 

When you select an object, sizing handles appear around the selected 
object. Object’s properties are also shown in the Property Toolbar . 
 

 
 
 
The coordinate of the center as well as Width and Height of the object 
will be displayed. The workspace center coordinate is showing the 
distance from the center of the object to the zero origin of the design 
working area. Initially the zero origin is located at the center of the 
working area, but you can change it to a custom Zero Point.  
 
 
To use Zero Point/Guides – View>>Toolbars>> RULERS must be ON. 
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Moving selected objects 
 
To move selected objects simply click over the object or on the cross at 
the center on the object (not on sizing handles) and drag it to your desired 
point and release the mouse button. 
 
Note: You can also move the objects by change the center coordinate of 
the objects in Property Toolbar. To do so, click on  or   edit 
boxes and change the horizontal and vertical positions and press e 
to apply the changes to the objects. 
 
 Tip: You can hold down the  v key to move the objects in horizontal 
or vertical directions.  
 
Tip: To move objects by a specific distance, you can use the ‘move icons’ 
on the Travel Toolbar. You can also use shortcut keys which are the 
combination of the v key and one of j l i k keys. You can 
change the moving distance by using the related icons on the Travel 
Toolbar 
 

 
 

The travel toolbar can be docked horizontally. Like many other toolbars, 
it may just be a matter of preference where you’d like the toolbar to be 
situated. You may prefer it at the top, or on the side. Some toolbars dock 
horizontally or vertically. 
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To use shortcuts to move the objects: 
 

• Hold down v key and press l , to move the object right 
 

• Hold down v key and press j , to move the object left 
 

• Hold down v key and press i , to move the object up 
 

• Hold down v key and press k , to move the object down 
 

• Hold down v key and press \ , to decrease moving distance 
1/10 (in inch unit, it will decrease by 1/2). 
 

• Press \ , to increase moving distance 10 times (If you have 
selected the preference of overall ‘ inch units’, it will increase by 
2 times). 

 

 
 
See Tools> Preferences> General 
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To rotate or skew selected objects 
 

1. Click on selected object(s), the sizing handles will change to 
rotation handles. 

 
Rotation handle 

 
  
Skewing handle 
 
   
 
 
Rotation center axis 
 
 
 
 
2. Click on rotation handles and drag to rotate the objects. 

Click on skewing handles and drag to skew the objects. 
 

3. Release the mouse button when finished. 
 
Tip: You can rotate objects by a specific angle from the Property 
Toolbar. Click on  (rotate edit box) and change rotation angle and 
press e to apply it to the objects. 
 

 
You can also see the object ‘absolute rotation angle’ update as you 
rotate objects. 
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To resize selected objects 
 

1. Click on one of the resizing handles and drag to resize the objects 
2. Release the mouse button when finished. 

 

 
 
Tip: While resizing, hold down the  q key to resize from the center 
of object. Using this tip on circles etc will give you equidistant spacing  
from the center with copy/pasted duplicates of that object. 
 

 
 
Tip: While resizing, hold down a key for a non proportional resizing. 
 

 
 
 
Tip: While resizing, hold down q and a together for non 
proportional resizing . 
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Tip: While resizing, hold down v  for resizing by …, ¼  , ½ , 2 , 4 , 
… times. You can also use the combination of a and q keys to 
apply non proportional and center resizing at the same time. 
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To resize objects using property toolbar 
 
You can also resize by changing Property Bar values. 
 
 

 
 

To resize objects by percentage% 
 

1.  Click Size / Scale (%) icon to resize objects by scale. 
 

 
  

2. The icon will change to  when the resizing is set to scale 
(%) and the Width and Height values will be shown by 
percentage on the Property Toolbar. 

 
3.  ,  Change  Object(s) Width or Object(s) Height 

or change the scale value. 
 

4. Press e to apply the changes to the object(s). 
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Flipping objects horizontally and vertically 
 

You can flip objects horizontally and vertically using the tools on 
Property Toolbar. 
 

 ,  Click Flip Horizontal and Flip Vertical (Property Toolbar) to flip 
objects vertically and horizontally. 
 

 
 
 
 

Deleting Objects 
Select the objects you want to delete and select Edit > Delete or press 
m key…or Right Click an object, and click ‘Delete’ in the flyout 
menu. 
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Cut, Copy, and Paste Objects 
 

• Click dropdown menu Edit >>Cut to cut selected objects. Objects will 
be copied into clipboard and will be deleted from the design. 
You can also press v X. 
 

• Click dropdown Edit>>Copy to copy selected objects to clipboard.  
You can also press v C. 
 

• Click dropdown menu Edit>>Paste to paste the objects from the 
clipboard into the design. 
You can also press v V. 
 

Tip: Hold down a key and click on the selected objects and drag a copy 
of them into your desired place and release mouse button. 

 

 
 

Hold down a and click on an object and drag to duplicate it 
 

Tip: press  v D keys to duplicate select objects 
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Insert objects between other objects 
 

 
 
The ‘Insert Mode’ icon  status is always visible on the Standard Toolbar. 

 
Insert mode lets you insert objects between other objects. 
 

The insert icon appears as  , when insert mode is off. When insert 
mode is OFF a copied object is pasted as the LAST object. 
 

The insert icon appears as  , when insert mode is on. When insert 
mode is ON, objects are pasted after the SELECTED object in the 
sequence. 
 
 
To set the insert mode on and off 
 

 /      Click Insert mode to set it on or off.  
 
You can also press f. 
 
I-Cliqq offers you simple, and advanced methods of inserting objects, and 
also the ability to insert within objects. This means you can travel within 
objects and nest digitized sections within them seamlessly in the object 
sequence. This capability is constantly being advanced so you may find 
that some improvements appear without notice, allowing you insert 
capability at different levels of operations. 
 
You can refer to I-Cliqq Online Help , or check the forum for Release 
Notes. 
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Auto-Insert 
 
Auto-Insert is an intelligent feature that simplifies this sometimes daunting set 
of actions. It is similar to ‘branching’. 
In this feature, all you need to do is select the base object, and the object you 
wish to ‘insert’. 
For the best results, make sure the entry/exit points of the object you wish to 
insert are closest to the insertion point. 
 
If you forget to do this, you can always move it once the action is complete, but 
its simplest to follow the logical sequence of performing this function, to try to 
always have the most continuous stitching sequence. 
 
You can perform this simple feature as many times as is necessary, to achieve 
your desired sequence . 
This gives you additional power over other similar automatic features, so apart 
from using the branching feature where applicable, you also have this capable 
feature, to simplify some tasks. 
 
As with all tasks related to sequence , the user is required to spend some time 
thinking out the most practical sequence in relation to the task at hand, 
considering embroidery factors. 
 
I-Cliqq gives you similar related modes of inserting objects with varying levels 
of practicality and power so that you can achieve the best results each time. All 
onscreen activity, it should be remembered, influences the functionality of your 
machinery, so actions that  create jumps/lockstitches/trims etc should always be 
observed. 
 
View the video clip to see some simple possibilities. There are various methods 
of ‘insert’ that can be used within design creations. 

I-Cliqq User Manual 152 



Grouping and ungrouping objects 
 

Group feature gives you the power of keeping you designs organized in 
large designs. It also lets you edit grouped objects together. Ungroup will 
help you whenever you need to edit each object individually. 
When you select a group, all the objects will be selected and you can 
move, rotate, scale them all together. If you change the property of a 
specific stitch type of a group, it will be effected on all the objects of the 
same type inside the group. 

 
To group or ungroup objects 
 

 Select Group (Property Toolbar) to group selected objects. At least 
two objects must be selected otherwise the Group icon will be dimmed.  
 
Note: It is possible to group a grouped object with other objects but if you 
repeat making groups like that, it may slow down the manipulating 
procedure of such objects. It is recommended to use Add Object to 
Previous Group mentioned below and not make groups inside another 
groups, as much as possible. 
 

 Select Ungroup (Property Toolbar) to ungroup selected groups. 
 

 Select Add Object to Previous Group (Property Toolbar) to add a 
selected object to previously created group. 
 
Note: If no previous group was found, a new group will automatically be 
created with the selected and previous object. 
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Traveling by stitches 
 

 
 

 
 

 
To travel by stitches you can also use the following methods 
 

•  Select Next Stitch (Travel Toolbar) to travel forward one 
stitch. You can also use l or k keys as shortcuts. 
 

•  Select Next10  Stitches (Travel Toolbar) to travel forward ten 
stitches. You can also use r key as a shortcut. 
 

•  Select Previous Stitch (Travel Toolbar) to travel backward 
one stitch. You can also use j or i keys as shortcuts . 
 

•  Select Previous 10 Stitches (Travel Toolbar) to travel 
backward ten stitches. You can also use p key as a shortcut. 
 

• Press h to go to the first stitch. 
 

• Press u to go to the last stitch. 
 

• Press a l to travel to next special function. If there is no 
special function on forward, you will hear a beep sound. This will 
travel on special functions within the stitches of an object.  
 

Press a j to travel to previous special function. If there is no special 
function on backward travel, you will hear a system beep .  
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Travel Toolbar 
You can travel on stitches using the stitch travel toolbar. Simply select an 
object, and travel backwards or forward in your design creation. You can 
use stitch travel to move to exact points of insertion. This travel method 
is simple. 
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Stitch Travel by Cursor. 
 
For most, avoiding the keyboard or keypad is considered fast, and effective.  
I-Cliqq  offers intelligent stitch travel, taking you where you need to go, in an 
instant. Each ‘stitch’ in I-Cliqq auto generation, and even on manual stitches is 
a ‘hot point’. Travel to any stitch by hovering your cursor over a hot point, and 
you’ll see the cursor indicator change to a . 
 
 

 
 
 
To see a stitch ‘hot point’ clearly: 
 
Change your view mode to Normal Enhanced View. 
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Hover over a Hotpoint with your cursor.  
When the symbol changes, merely click, and the stitch point indicator will 
travel to the selected stitch. There is not need to actually be in the suggested 
view mode, but its simpler to see the stitch points in this view mode. 
 
You can click any object, at any time,  to initiate stitch travel in any mode 
you’re comfortable with. If you cannot see ‘stitches’ immediately check the 
view mode. Draft Mode only shows outlines. 
 
 
 
Slow redraw 

 
1. Select from the dropdown menu : Stitch > Slow Redraw 
2.  or press Alt+R : Slow Redraw dialog opens. 

 
 
 

Pause after redrawing each object 
 

 
 
 
 Redraw speed           Go / Pause 
 Ignore slow redrawing      Restart redraw 
 the current object         Pause on color change 
 
 

3. Select the options as required. 
 
4. Click  or press e to start or pause slow redraw 

procedure. 
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Notes
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Traveling by objects 
 

 
 

 Click Select Next Object (Travel Toolbar) or press t key to 
travel forward by object. 
 
 

 Click Select Previous Object (Travel Toolbar) or press q t 
key to travel backward by object. 
 

Traveling by colors 
 

 Right click Select Next Object (Travel Toolbar) to travel forward by 
color. 
 

 Right click Select Previous Object (Travel Toolbar) to travel 
backward by color. 
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Object order 
 

An object’s order can be changed visually on screen. You can place 
selected object(s) at the beginning of design, at the end, or in front or 
behind other objects. I-Cliqq  offers you a few ways to change the order 
of the object sequencing. You can use this shown method of changing the 
order, or use the drag and drop capability of the Object Manager. 
 

 
 
While the manual offers you a basic insight into the functions, these 
guides show you a few basics. As you experiment with  
I-Cliqq, you’ll find that tasks can be carried out in numerous ways, 
that are not only restricted to the methods shown in this manual. As 
you discover them , feel free to share it with other users in the  
I-Cliqq User Forum. You will find that interaction with other users , 
and the development/support team will make your experience 
exciting, and rewarding, as well as productive. 
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To change object order 
 

1. Select object 
 
2. Right click on it, a popup menu opens 

 

 
 

3. Select Order to open the  Order sub menu: 
 

a. Select To Front to send the object to the beginning of 
design. 

b. Select To Back to send the object to the end of design 
c. Select Forward One to swap the order of the selected 

with next object 
d. Select Back One to swap the order of the selected with 

previous object 
 
e. Select In Front Of …, to set the order of the object 

visually on screen. An arrow pointer will display. Simply 
point at the object you want the selected object to be ‘In 
Front Of’. 
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i. Move the pointer over objects. Objects will be 
highlighted when the pointer floats over them 

ii. When your desired object is highlighted, click to 
show it 

iii. Selected objects will be placed in front of the 
shown object 

f.    
i. Select Behind : This procedure is the same as 

‘In Front Of’. 
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Arrange objects by needle numbers 
 

You can arrange Objects needle numbers by selecting Arrange > 
Reorder Objects > Arrange Needle Numbers.  
 

Needle # before  Needle # after 
Object 1 Needle #1  Needle #1 
Object 2 Needle #5  Needle #2 
Object 3 Needle #4  Needle #3 
Object 4 Needle #14  Needle #4 
 

 
 

Previous 

 
New Arrangement of Color 
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Arrange objects by selection sequence 
 

You can change objects order by selection sequence by selecting 
Arrange > Reorder Objects > Arrange By Selection Sequence.  
The objects you select are arranged in the order of selection, 
extracted, and repositioned in the sequence as shown below. 
 

 
 

Selected object order :  5/3/2 
 

 
 

New Sequence 
 
 
 
Objects order   Your selection order   Objects order after arranging 
1) Object 1   1) Object 5  1) Object 1 
2) Object 2   2) Object 3  2) Object 4 
3) Object 3   3) Object 2  3) Object 5 
4) Object 4    4) Object 3 
5) Object 5    5) Object 2 
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Reorder objects to needle numbers 
 

You can change objects order according to their needle numbers by 
selecting Arrange > Reorder Objects > Reorder to Needle Numbers. 
When you run this command, selected objects will be sorted by needle 
colors. This will optimize color changes between selected objects. Let’s 
assume we have a design in which, objects needle arrangement is as 
below, and you select all and apply Reorder to Needle Numbers. 
 
In essence, I-Cliqq will optimize the sequence of multiple color 
changes, to the minimum color changes. All objects of one color 
will then just run as one color as shown. 
 

 
 

Objects order before   Objects order after 
1) Object 1, Needle # 1  1) Object 1, Needle # 1 
2) Object 2, Needle # 2  2) Object 3, Needle # 1 
3) Object 3, Needle # 1  3) Object 5, Needle # 1 
4) Object 4, Needle # 2  4) Object 2, Needle # 2 
5) Object 5, Needle # 1  5) Object 4, Needle # 2 
6) Object 6, Needle # 2  6) Object 6, Needle # 2 
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ARRAY 

eating symmetry, and also great if you create monogram styled borders. 
 

ectangular array can repeat selected objects in rows and columns. 
 

 
Array objects by rows and columns 
You can select an object, or a design to ARRAY. This is invaluable in 
cr

 
R

 
 
 
To array objects rectangular 

rray > Rectangular, rectangular array 

nge the selection while rectangular array 

3. Set array parameters and select Apply.  
 

 
1. Select objects you want to array 
2. Select Arrange > A

dialog will open.  
Tip: you can cha
dialog is open. 
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Rectangular Array Dialog 
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Changing the ARRAY direction 
 
 

 
 
 
        Rows (2) 
 
 
 
               Columns (4) 
 
Objects will be repeated from left to right if rows are more than one 
and they will be repeated from bottom to top if columns are more 
than one. You can select  to reverse the array 
direction. 
 

 
If you select Objects (Minimize Color Changes) for objects order, 
where selected objects contain more than one color, objects will be 
repeated color by color to reduce color changes of the design. 
 

 
If you select Selected set for objects order, where selected objects 
contain more than one color, objects will be repeated by selection 
set. This will increase color changes of the design. 
 

     Click Undo to start again or undo a step/s. 
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Array objects – Circular Array 
 

Circular array can repeat selected objects around a center point. 
 

 
 
 

Circular Array 
 

1. Select objects you want to array  
 

2. Select Arrange > Array > Circular. Circular array dialog will 
open. Rotation handles will display around selected objects. 
Tip: You can change your selection while the circular array 
dialog is open. 
Tip: Click on selected objects if you don’t see rotation handles, or 
if using multiple objects , drag around these using the Object Edit 
tool, to select all the objects. 
 

 
Array center (objects rotational axis point) 
 

 
 

3. Change the  rotation axis point to obtain best results. Array center 
will be on the  selected objects rotation axis point. 
 

4. Set array parameters and select Apply 
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Repeat counts         Angle between repeats 
        Total repeat angle 
 

 
 

Array is an invaluable tool if your are an ardent monogramming specialist. It is 
also great if you’re a quilter, as it allows you to create symmetrical setups 
simply, and once you have your base blocks done, you can add in interesting 
embroidery or lettering. I-Cliqq features fascinating lettering and pattern effects 
that you can apply to borders, lettering and stitchtypes  to create the most 
unique designs within short spaces of time, also allowing you to be extremely 
profitable and competitive. Since there is virtually no limit to the combinations 
of effects you can apply or create , I-Cliqq allows you to be an embroiderer of 
note, with clients and competitors in awe of your creative abilities. In I-Cliqq , 
even a novice can produce embroidery with flair within a relatively short 
period. Stunning effects and borders allow you to add pizzazz to even the 
simplest of embroidery objects. Onboard shape tools allow you to create 
borders with minimal effort. Constant software enhancements will provide you 
with additional capabilities, making you a tough beat in any kind of economy. 
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If you select Objects (Minimize Color Changes) for objects order, 
where selected objects contain more than one color, objects will be 
repeated color by color to reduce color changes of the design. 
 

 
If you select Selected set for objects order, where selected objects 
contain more than one color, objects will be repeated by selection 
set. This will increase color changes of the design. 
 

   Click Undo  if you wish to redo the array, or make 
adjustments to the parameters to array again. 
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Align and distribute objects 
 

You can change selected objects alignment and distribution. 
 

 
Align objects 

 

 
Align and distribute objects 

 
 
To align and distribute objects 
 

1. Select objects you want to align and distribute. At least two 
objects should be selected. 
 

2. Select Arrange > Align and Distribute …, align and distribute 
dialog will open.  
 

3. Select align and distribute options and click Apply. 
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Align & Distribute Dialog Box 
 

 
 
 

You can perform a variety of alignment and distribution 
operations. Experiment with a few objects to discover the 
different permutation results. 
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Align and Distribute OPERATIONS 
 

 
Vertical object alignment 
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I-Cliqq allows you different practical operations to align objects. 
 

 
Vertical align + Horizontal distribute 

 
 

 
 

Vertical align + Horizontal align 
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 Additional Information on Inserting 
 
Now that you have acquired a few skill sets , you may feel more 
comfortable to attempt using your combined knowledge to perform an 
insert ‘within’ an object. Many features in I-Cliqq are interactive, and 
rely on performing a few tasks sequentially, and perhaps simultaneously. 
As you grow in confidence, you will find many shortcuts and tricks other 
than the basics shown in the manual. Feel free to share them in the user 
forum as you discover them. 
 

 
Travel to a stitch, using any of the stitch travel methods.  
 

 
 
Before attempting the insert within an object, make sure that ‘Insert 
Mode’ is set to ON. If not, your newly created object will just appear as 
the last created object in the design sequence. 
 
 
 
 Set ‘View Unstitched Objects’ ON. 
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 Also make sure that View Unstitched Objects is ON. This makes your 
visibility of the area you may travel on easy, so that you see the 
‘unstitched’ area of a column or design while inserting digitizing. The 
ON state means the button/icon must be in  the depressed status. You can 
switch this off/on at any time. 
 
 
Once you are sure ‘Insert Mode’ is on , and you have travelled to your 
desired point of insertion, you are ready to digitize that ‘insert’ using any 
stitch type you prefer. You may be digitizing a branch of a tree , and wish 
to insert some runstitch  twigs as additions to a previously digitized satin 
column, or even add in more satin columns. 
 

 
1- Travel to your desired insert point on an object. 
 

 
 
2- When at the desired point, just select the stitchtype you propose to use 
to create the inserted part of the design. ( It may be satin, runstitch, a 
tatami or any other available type)  
 You will see the + flashing, indicating you’re ready to insert digitizing at 
that point. 
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3-In this image, runstitch was selected, so the instant you start digitizing , 
you’ll see the view change to show the ‘unstitched’ area , which really 
means you can add stitching there , and it will later be covered , so that 
you can have seamless shapes. End your digitizing at the insert point, and 
you have successfully created an insert on the satin column. If you travel 
on the objects, you will find the newly created runstitch now nested 
within the satin column, in that machine run sequence. 
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About Inserts in General… 
 
A point to remember when doing such insertions is that you should end at 
the insert point, or you will have an unnecessary jump/trim in your 
design. Inserts are usually performed to really provide run continuity in a 
design. You may find yourself needing to insert some digitizing if you 
have forgotten something in a design, and just want to add that in. It’s 
also excellent to correct or modify machine files. 
  
Depending on the condition of machine files like DST , I-Cliqq can 
convert stitch objects to outline objects, so you may find yourself 
having to modify or re-digitize sections of such files. Like many 
embroiderers, you will have clients bring in files that are bought or 
digitized , and may not be optimum for your productive purpose. 
Modifying such files is made simpler in I-Cliqq. 
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Color Manager, and Object Manager. 
 
As we have dealt with the Object Manager , it is fitting to understand that 
the Color manager and Object Manager are ‘related’ functional entities, 
so it is practical to also position the color manager on the lower part of 
your screen, so that you can see its interactive nature when used with 
Object Manager. Understanding the slight difference will allow you to 
manipulate your color blocks and objects with east. For the sake of 
convenience, COLOR BLOCKS will denote ‘the object elements that 
make up what you deem as a ‘color’ in the color sequence. These are 
basically the objects in a color group, but we’ll just use ‘color blocks’ to 
avoid confusing it with ‘grouping or grouped objects’. 
 
 

 
1- Color Blocks denoted by 1,3,5. 
2- Objects that make up color blocks denoted by 

1,2,3,4,5,6. 
*Note – each object will display the number of the color block it belongs 
to. 
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Selecting a Color Block 
 

 
 
If you click on a Color Block , you will see ALL the objects in that color 
block selected…so, the understanding is that Color Blocks exercise 
control over ALL objects in that block. If you select a Color Block, and 
apply a parameter change, or overall density change, it will apply to ALL  
objects in that color block. 
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Selecting an Object of a Color Block 
 

 
 
If you select an OBJECT by clicking on an object in Object Manager, it 
selects just that object of the Color Block. You may choose to change 
density, underlay or stitchtype on ONLY that object, so just that object is 
selected . Other objects of the color block remain unaffected. 
 
Once you understand the hierarchy of the Color Manager selection taking 
preference over Object Manager selection , then you can confidently go 
ahead and familiarize yourself with the advanced capabilities of drag, 
drop, and swap ..changing colors, selecting objects and colors, 
resequencing  objects , or color blocks , deleting, cutting, copying , 
pasting and other functions that can be initiated and applied just by using 
the Color Manager, and Object Manager. 
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A right click on any selected object opens a flyout menu. Selecting any 
function , applies it to that selected object.  
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Drag n’ Drop 
 

 
 
You  can resize the color block sizes, when you want to resequence  
designs. Apart from that, you may prefer it being smaller to just indicate 
color use. 
 

 
 
Hold down the left mouse button on the shown strip, and simply drag it 
to a new position in the sequence. Release the mouse button when 
positioned over the sequence position you prefer, and it will drop in , 
automatically changing the color sequence. 
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This is the result . The letter C (red color block) will now run last in the 
design sequence. You can perform exactly the same operations on the 
Object Manager, to change the sequence of objects. You can repeat the 
action as many times as you want to, until you are happy with the new 
sequence you are creating.  
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Some additional Functionality of Color Manager 
You may view this segment as forms of travel, or also display. In 
conjunction with the Travel Toolbar and Object Manager, the Color 
Manager is fluent in managing most color needs.  
 

 
Re-order colors in use 

his simply arranges used colors in numeric order, so let’s say you 
 
T
have 1, 11,14 as shown in this image: 
 

 Pressing this icon re-arranges the numeric order. 
 

 
 
his makes working with machine files like DST very simple if you 
ave performed color edits, and just want to see a simple 123 kind of 

 

T
h
color indication. If you have rearranged a color sequence , and just
want an easy way to set up your colors for stitching, Re-ordering the 
colors will simplify your task. 
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Viewing by Color 

or selected  colors  
 
You can view individual 
 

 
 

 
 
These icons control the color view. Using these icons does not delete 
any colors, any icons here will not damage your design in 
ny way. It merely allows you to view colors individually 

 so pressing 
a
 
** Holding down the v key while clicking View Next, will add a 

lor to the view. So, if you hold down while pressing co  , the colors 
visible to you, will be Color 1, and Color 2. 
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 Click once, and Color 1 shows as visible 

 
 

 Click again, and Color 2 shows as visible 
 

 

 Click again, and Color 3 shows as visible 
 

 P  color. No colors are 
del l still see all colors 
hown on the manager. 

 

ressing this icon travels to view previous
eted’ , but just temporarily hidden. You wil‘

s

 To view ALL colors again, just click this icon at any time. You can 
iew/hide color at will. v
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You can also Right Click on an object, or object string to hide objects 
from view. When the flyout menu opens, simply click on ‘Hidden’ . 
 
 

 
 

 you look at the Object Manager, Color Manager and Travel 
o 

 
s 

If
Toolbar, you see the interactivity of I-Cliqq at work. It is difficult t
set one feature in a lone category, so at times, you’ll see similar 
related information repeated at different sections, to refresh your
thoughts on similar issues. You will find numerous embroidery task
that will draw on singular or combined feature sets, but as you get 
familiar, you’ll easily transition between what’s easiest or most 
convenient at the time. 
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Indicators and Highlights 

he integrated Color Manager also gives you some visual indicators 

r 

g 

 
T
that may operate in your peripheral vision, while you work, so you 
may not find yourself looking directly at the color manager, but afte
familiarizing yourself with the indicators, it will just become like 
roadsign visibility…  You begin to know its there, while still keepin
your eye on the road. 
 

 
 

 one or more objects of a color are selected, you will see a blue 
ighlight around a color block. 

If
h
 
 

 
 
If the entire ‘color block’ is selected, you will see a black 

ighlight. h
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 Highlight Object on Mouseover. 

t possible for you to see Object 
formation. It is also an accurate mode of selection. If you have multiple 

r 

 
Highlight object on Mouseover makes i
In
overlapping objects, highlight will detect, and select accurately in one 
click. While highlight is ON, you can use the following selection modes 
with confidence. Switch Highlight on Mouseover  OFF if not in use, o
it will be a visual irritation when your mouse generally floats over the 
workspace. 
 

 Select outlines while in Outline Edit Mode with 100% accuracy. 

 Select Objects Accurately while in Object Edit Mode. 
 

 
 

  Highlight
You can switch this mode on/off at will. 
 

 
When the icon is clicked, the mouse cursor indicator will change. 
 

 
Floating over objects will indicate object information. 
 
Clicking the outline of highlighted objects while in Outli e Edit Mode 

ig  sections 
at have multiple overlaps, all you need to do is zoom in, and click 

 
 

n
nwill select with 100% accuracy each time, even in des

th
as an outline is highlighted. 
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Hold down the q key while click g outlines to add objects to the 
election.  

 

 

in
s

 

 
You can create a set of overlapping objects to test and practice 
selection using the highlight feature. After a relatively short period of 
experimentation, you will master this tool , and find your 
performance in editing objects, and selecting accurately for edit 
purposes will be advanced, yet simple. 
 
 
 
 
 



Chapter 5 

Manipulating stitches 

Manual stitch 
Manual stitch objects are plain stitches that include stitch point data and some 

basic properties. When you export a design in stitch file formats, only the stitches 
will be saved and when you import such files, they will be imported as manual stitch 
objects. Manual stitch objects do not have any path or stitch parameters. You can 
only edit the stitch points but it is also possible to convert them into embroidery 
objects and apply different stitch types to them. 

Digitizing manual stitch 
 

 Manual digitizing lets you digitize individual stitches. I-Cliqq 

 provides easy and advanced methods to digitize or edit manual stitch objects and 
lets you edit the manual stitch even while you are digitizing it. Actually when you 
are digitizing, you are using the  Stitch Edit Tool in insert mode.  This will give you 
the full power of digitizing and editing at the same time. While you are digitizing, 
you can : 

• Snap to grids, guidelines, and the stitches of any object. 
• Snap to the stitches of the current object. 
• Insert stitches between other stitches. 
• Hold down Ctrl for  vertical or horizontal line digitizing. 
• Change any stitch property to normal stitches (default stitch property)  

including jump or sequin stitch.  
• Add locks on sequin stitches. 
• Move or delete stitches. 
• Create a motif or special pattern motif 
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To digitize Manual Stitches 
 

1.  Click Manual Stitch (Edit and Digitizing Toolbar),  
or press M 
 

2. Rest the pointer on design working area and click to digitize stitch 
points. ( Use left mouse clicks) 
 
Note: the stitch information will be displayed on status bar or tooltip if 
switched on. 

 

 
 

3. Continue clicking until manual stitch object is complete. 
 

4. To finish 
o Press Spacebar : digitizing mode will exit and the Object Edit 

Tool will become active and the object will be shown as 
selected. 
 

o Press Esc : digitizing will finish and Stitch Edit Tool will 
become active and the object will be shown as selected. 
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While you are digitizing, a cross will show the current stitch position. Stitch points will 
also be displayed by a small cross. 

 
Note: Manual stitches will not be displayed in Draft View mode. Change the  

view style if you see no stitches while you are digitizing. 

As a digitizer, you should remember that manual stitches have no parameter 
properties , so use with discretion if you intend resizing designs. 

 
 

Stitch edit tool 
 

 Stitch Edit Tool provides a powerful stitch editing tool. You can edit 
manual stitches and also the stitches of all embroidery objects with this tool.  

Important to remember: 
This tool is best used when you perhaps receive problematic .dst ( or other 

machine files that may not convert to outline objects well) Apart from this, as a 
digitizer you should do your best to retain the object nature of all created objects. 

Some imported machine files – eg . those from online design sales stores where 
you may see multiple conversions of the same design in many formats , may look 
good when you purchase , but may be problematic when you try to open these in 
your software. This is because conversions from one specific software native file, 
may not translate machine codes well in conversions. You have without doubt 
experienced such errors like false thread trims , or the machine suddenly stopping , 
or attempting to make multiple tie offs , and many other anomalies that can impact 
your productivity. Batch conversions of multiple file types are usually done for sales 
purposes , but this process does not have the best results in actual designs for 
productivity. 

Once stitches are modified using the Stitch Edit tool, that object is then 
considered a ‘ manual stitch object’ which means you cannot apply overall 
parameter changes to it, without losing the stitch edits, so if it is absolutely 
necessary for you to do that, be sure to save the new file as a different filename to 
preserve your original should you need to refer to that at some point. 
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Automatic stitch generation and stitch edit tool 
 

I-Cliqq will generate stitches automatically while you are digitizing or editing an 

embroidery object. This is called Auto Stitch Generation and an icon ( ) (Stitch 
Property Toolbar) shows the automatic stitch generation status of the selected object.  

When an object’s Auto Stitch Generation is active (the icon will display as it 
means the stitches will be generated automatically when you move, resize it or edit 
its path. And when an object’s Auto Stitch Generation is inactive (the icon will 

display as ) it means the stitches will not change when you edit object’s path. 
Auto Stitch Generation is always inactive for manual stitch objects because they 
include individual stitches and have no path. ( ‘Path’ merely refers to ‘outline’ status 
of an object with regards to nodes/editability) 

 

If you edit the stitches of an object with Stitch Edit Tool,  Auto Stitch Generation 
is automatically ‘disabled’ – You will hear a warning sound, and see the icon 
change. 

 You can reactivate Auto Stitch Generation on an object (by clicking ) but you 
will lose all the edits you have done on object’s stitches. 

I-Cliqq will present a popup dialog indicating a Warning that you are about to 
change the mode, so that you are aware of your action. 
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Selecting an object with the stitch edit tool 
 

 Select Path Edit Tool and rest the pointer on the stitches of an object and click 
to select it. When the object is selected , small crosses will display on stitch points of 
the object. Only one object can be selected each time. If you need to edit the stitches 
of some objects together, you should group those objects first. See ‘grouping 
objects.’ 

Note: The object will not be selected if you click on its outline. 

Note: Once you select an object using the  Stitch Edit Tool, the object will be 
ready to edit. 

Tip: You can travel on objects in stitch edit mode using the arrow keys, or 
standard travel buttons. 

Selecting stitches with stitch edit tool to edit 
A cross will display on first stitch point as the currently selected 

stitch, when you select an object with Stitch Edit Tool. 

 

 
 

To select the stitches for editing, you can use the following methods. 

• It is practical to zoom in to the stitch or group of stitches you wish to 
edit. 

• Set the + to an appropriate viewing size  using the display slider. 
 

• Hold down the ‘SHIFT’ key and press the travel button or arrow keys to 
add to the edit selection. 
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Holding down the SHIFT key, while clicking the Stitch Edit 
tool on eg Stitch 1 and Stitch 100 selects all stitches 
between , inclusive of the two selected stitches. 
 

 

 
 

* The circled image shows you the rectangular select tool. Right Click 
any stitch and a flyout menu appears to show you a list of applicable 
functions. 

 

I-Cliqq User Manual 198 



 
 

 

Selecting stitches within a group using the Polygon Lasso. 
 

• Double click on a stitch point to select all the stitches of 
the object. 
 

 
 
Double click on a stitch point to select all stitches 
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Intelligent stitch select  
 

Normally, trying to select ‘stitches’ within a group can prove difficult. 
I-Cliqq allows Intelligent Stitch Select to help you accomplish this simply. 

 
Image 1 

Normal stitch selection within an object group. ( image 3 objects grouped) 
The stitches of the other objects in the group are selected 

 

 
Image 2 

 
Intelligent stitch selection within a group using the polygon Lasso Tool. 

The stitches have been selected correctly 
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Image 3 

 
• The Lasso Tool icon toggles between a rectangular ‘ 

lasso’ or what you see as the normal ‘ Object Edit’ mode 
of selection, and the Polygon Lasso Tool which allows 
you to make surgical selections. You can either click 
individual points around an object or simply drag around 
the shape, then double click to select that object. These 
tools are flexible, and can be used in normal object 
mode, or stitch edit mode. 

• Image 3 shows you that some embroidery design 
situations can seem complex at times especially when 
working on multiple color layers. I-Cliqq  simplifies your 
selection ability. 

 
 
 
 
 
 
 
 
 
 

 

I-Cliqq User Manual 201 



 

 

 

 

 

 

 

To select stitches using intelligent stitch selection method 
 

 
 

• Switch to Polygon Lasso Mode – then simply click points to surround 
the desired object within the group while in stitch edit mode , and hold 
down the ALT key before double clicking. Only the desired object 
stitches are selected. ( shown in Image 2) 
 

• When selecting stitches within a polygon, Hold down a key before 
double click. 

 

Deselecting stitches  
Press Esc to deselect all the selected stitches. 
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Moving stitches  

Rest the pointer on a desired stitch, the pointer will display as 
, then click and drag it to a desired point and release the mouse 

button. 

 
 

 

 
• Once you have set an increment by using the + or - , 

movements of objects will operate in that increment as you 
use arrow keys or the alternate mode of the stitch travel 
buttons. (Holding down CTRL while pressing the above arrow 
keys will move objects or stitches incrementally) 

 

You can use the keyboard arrows to move stitches: 
 

• While any object or object group  is selected , simply hold down CTRL 
and press the desired arrow keys to move objects horizontally or 
vertically in the predefined increment that is comfortable for your 
purpose. 

 
• (Note) Releasing the CTRL key and pressing the arrow keys allows stitch travel. 

So again, I-Cliqq  gives you simplified flexibility in toggling between different 
useful functionalities. As you continue to use the software, you will find other 
handy shortcuts in operations as the manual makes mention of the most basic 
operations. Different users have slightly differing preferences – some enjoy 
using onscreen icons , some prefer keyboard shortcuts, others prefer a mixture 
for convenience – I-Cliqq  provides for cross user preferences. 
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Editing stitches  
 

When you use Stitch Edit Tool, some tools will be available on the 
Property Toolbar to help you edit the stitches. The I-Cliqq  Property 
Bar updates constantly , showing different parameters and settings 
related to the current tasks. 

 

 
 
 
 
•  Click Add stitch to add a stitch before the selected 

stitch(es) 
 
 

 
 

•  Click Remove Selected Stitch(es)  to delete selected 
stitches. You can also use the ‘DELETE’ or ‘Backspace’ keys. 

• You can simply repeat any procedure as necessary. 
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If you press any desired key repeatedly, stitches will be deleted in a 

forward (Delete key) or backward ( Backspace) sequence. 
 

 
 

 
 
 

• Click Normal Stitch or press 1 to set the current stitch property to 
normal stitch. The stitch pointer will display as  on normal stitches. 
 
Note: Once you set the stitch property to normal stitch, it will remain the 
default stitch property in insert mode, until you change it again. 
 

•   Click Jump or press 2 to set the selected stitch property to a jump 
stitch. The stitch pointer will display as  on jump stitches. 
 
Note: Once you set the stitch property to jump, it will remain the default 
stitch property in insert mode, until you change it again. 
 

• Pressing 3 adds Sequin A (initial sequin layer: If only sequin A is used) on a 
selected stitch. Pressing 4 initiates Sequin B (lower sequin – This becomes 
the first sequin layer if A+B are used) Pressing the key again will turn the 
insert off or on. Pressing 5 will add a Dual Sequin (A+B in one keytap: it is 
the composite function of pressing 3, and 4 in one)  Tapping  the same key 
again, will remove the sequins. 
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 Click Properties (Standard Toolbar) or double click the object 
to open the properties dialog: Select Sequin tab-page. 

 

 
 

 
These parameters will only be effected on the current object. 

 
 

•  Click Size selected stitches to resize select stitches. 
Sizing handles will display around selected stitches, a cross 
sign will show center handle.  

o Click on sizing handles and drag to resize stitches then 
release mouse button.  

o Click on center handle and drag to change the position and 
release mouse button. 
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Sizing Handle   Center Handle 

 
 

Tip: When resizing, you can hold down 

 

o SHIFT - to resize by center ‘x’ outward. 
o ALT - for non proportional resizing 
o CTRL for resizing by …, ¼  , ½ , 2 , 4 , … times 

 
You can use the combination of the keys, as well. 
 

•  Click Rotate selected stitches to rotate or skew stitches. 
Rotating and skewing handles will display around selected 
stitches and a circle will show rotate center. 
 

o Click on rotate or skew handles and drag to resize or skew 
stitches then release mouse button.  
 

o Click on rotate center handle and drag to change the 
rotation center point and release mouse button. 
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Rotation handle                Rotation Center Axis 

 
 

 
•  Click Align selected stitches to align stitches horizontally 

or vertically. 
 

 
 

•  Stitch Point Display Size will change the size of small 
crosses which appear on stitch points. 
 

• Click Insert Stitches to insert stitches after the 
selected one.  
 
Note: When you digitize a manual stitch, you are actually 
using the Stitch Edit Tool in insert mode. If the stitch 
pointer is located on the  last stitch, the digitized points will 
be added to the end of the object. If you move the stitch 
pointer on a stitch along the middle, you can insert stitches 
after the selected one. 
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When you are in insert mode, you can use the following 
methods: 

 
o Hold down v key and move the cursor to vertical or 

horizontal lines to constrain a digitizing stitch to vertical or 
horizontal directions. The cursor will show you increments 
as you move in clockwise or anti-clockwise directions. 
 

 
Hold down v key to constrain the stitch to 0, 90, 180, 

270 degrees. 
o Press v Y Snap to Grids, to snap to grids. Once you 

activate snap to grid, it will be active until you press v 
Y again. 
 

o To snap to the stitches on other objects, press - Snap to 
Objects, and rest the cursor over stitches of an object, 
then click. Press s to cancel.  
 

o To snap to guidelines, press + Snap to Guidelines and 
approach the pointer to a guideline then click. Press s to 
cancel.  
 

o To snap to the stitches of the current manual object, you 
are digitizing, hold down a and rest the pointer on a 

stitch point, the pointer figure changes to  , then click 
 

 
Hold down a and click on a stitch to snap to it 
 

•  Click to select first object. 
•  Click to select last object. 
•  Click to select previous object. 
•  Click to select next object. 
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Cut, copy and paste stitches 
I-Cliqq can cut, copy and paste stitches from one object to the 

same or another object. 

To cut, copy and paste stitches 
 

1.  Select Stitch Edit Tool. 
 

2. Click on object’s stitches to select the object. 
 

3. Select the stitches you want to cut or copy. 
 

4.   Click Cut or Copy (standard Toolbar) to cut or copy the selected 
stitches into the clipboard. 
 

5. Select the stitch where you want to paste the stitches. 
 

6.  Click Paste to paste the stitches from clipboard. The stitches will 
be pasted after the selected stitch and they will be shown as selected. 
You can move, rotate and resize inserted stitches. 
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Manual stitch properties 
A manual stitch is the basic object. You can apply minimum 

jump length, machine special functions, lock stitch, needle number 
and a bitmap for appliqué objects. Any other embroidery object 
which has stitches will include these common parameters.  

To change manual stitch parameters 
 

Click Properties (Standard Toolbar) or press ae to open 
properties dialog box. Select Status on left list box to see status 
page. 

Object’s height            Object’s width 

 
 

Automatic             
Filter             

Option     
     
      Equal Jump division 
 
             
                                                                                                                        Object 
             Processor 
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Automatic stitch generation 

Use object processor when Auto Stitch Generation is off. 

You will find some icons or toolbars for some parameters on this 
page. These are basic parameters and any embroidery object 
which generates or has stitches will include them. 

 Auto Filter will filter small stitches automatically when 
generating stitches on embroidery objects which use a path to 
calculates stitches (like running, satin, tatami, …) 

Auto Jump will split long stitches into jumps. Although you may 
inactive this option on an object, but when you export the design 
as a stitch file, long stitches will split regarding the default export 
parameters. 
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Auto jump with equal and unequal stitch divisions 
 

 Select Locked to lock selected objects. You can also lock 
objects by using  Lock Object(s) (General Toolbar). 

 

 Select Hidden to hide selected objects. You can also hide 
objects by using  Hide Object(s) (General Toolbar). 

 

 Select Auto Stitch Generation to set 
automatic stitch generation option on or off. This option will only 
work on objects which generate stitches from an outline. You can 
never activate this option on a manual stitch object. You can also 
change this parameter by using  Auto Stitch Generation (Stitch 
Property Toolbar). 

 

 When this option is active, I-Cliqq will 
use the Object Processor when resizing selected objects. If Auto 
Stitch Generation becomes active, this option will be dimmed and 
skipped. 

 

Selecting Object Processor will run the object processor on 
selected objects. You can change the density of stitches by percent 
or stitch counts. You also have the option to change tatami pattern 
styles or manual stitches. You can also access the object processor 
dialog by clicking  Auto Stitch Generation (General Toolbar). 
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Select Functions on left list box to see functions page, select 

Main to access main functions. 

Needle number (also available in Stitch Property Toolbar) 

 

 
 

Machine special functions (also available on object manager) 

Special function will be applied to the beginning of object, before 
the first stitch on that object. 

Select Auto Connector to access related parameters. You can 
apply lock stitch on the beginning or end of object. Number of 
locks (tie in/off) and lock stitch length can be defined. 
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Lock Stitch Type (Auto Connector) 
Lock Stitches are also regarded as Tie-Off Stitches or Tie-In Stitches. 
These are imperative when the machine starts stitching columns, or 
ends. I-Cliqq can be set to perform these functions automatically and 
you can always check your creations. 

 

 
 

The following indicators denote the tie-in/tie-off and trim symbols. 
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Select View to select a color or pattern for appliqué objects. View 
parameters will only work on running and manual objects and it 
will display in 3D view style. 

 
Appliqué color enabled 

 

 Deselect pattern 

 

Select a pattern for appliqué    

 

Appliqué solid color  
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Applying Solid and Tinted Color 
 
You can apply some flair to your creations by showing fabric 
backgrounds in the color tints of the solid color chosen, or even a solid 
color. 
 
 
 

 

Appliqué solid color 
 

 
         Using a fabric pattern        Apply a solid color ‘Tint’ 
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Regarding Filtering short stitches 

 
 
Since I-Cliqq’s Auto Filter should be checked in ‘Properties’, you 
should have no real need to perform filtering on your native design 
creations, because this feature takes care of it automatically while 
you work. You should only really need to perform the filter operations 
on external files, such as purchased dst. files, or machine files that a 
client may bring to your shop. These are in many cases, the problem 
files. The related feature ‘ Stitch Highlight’ will show you how to 
instantly identify potential problematic data. These two features are 
related, and in use together provide you with powerful tools to 
eradicate production problems. Jumps, empty jumps, and short 
stitches are usually the main causes of bird-nesting, knots, false 
stops, false trims and other more severe problems like throwing out 
machine timing , and causing bent needles. A bent needle may still 
stitch, but can suddenly cause a problem…so – you eradicate such 
potential problems before they even appear. 
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Filter Short Stitches 
 
 

 Select Filter Short Stitches to remove small stitches from 
design. You can also select Stitch > Filter Short Stitches : Filter 
short stitches dialog will open. Set the minimum stitch length and 
select OK.  A maximum length of 3.5mm is allowed ( 0.13’’) 

If you have check-marked  ‘Remove all jumps’ , these will be 
removed from the selection. 

Minimum short stitch length to filter. 

 

 
 
Apply filter to select objects  Apply filter to all objects 
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Post-Filter Results 

 

 
 
After you have clicked OK , I-Cliqq  automatically removes short stitches 
below the minimum length. 
 
**Note. I-Cliqq intelligent Stitch Filter action, does not remove stitches on 
important design functions, so if after a filter, you still see a few filter 
indicators, look carefully and you will see these are on color change 
functions. 
These remain unaffected by stitch filter. If you absolutely have to remove 
these for a specific reason, you can use the Stitch Edit Tool.  
 
By using this feature especially on machine files, you ensure smoother runs. 
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Stitch Highlight 

 
Stitch highlight is a flexible feature, with multiple uses. Right Click on 
the icon, to open the Stitch Highlight Properties. 
Under ‘Highlight’ , you’ll be able to set up numerous options as your 
tasks demand. 

• The commonest use is setting the maximum length of short 
stitch display. 

• A secondary feature, is the ability to display maximum length. 
If you’d like to see an overview of eg. What % of long stitches 
do I have in my design?? I’d like to see how many are 8mm 
long, because this can slow down my runtime. Simply key in a 
value of 8mm in the Preferences dialog, and click OK. 

 
By default, all stitch types are highlighted, but you can uncheck 
types, to see only the types of choice. 
 
You can switch the highlight feature off/on in a click. 
 
 

I-Cliqq User Manual 221 



 
 

Image showing 3mm satin stitch lengths highlighted. 
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About HIGHLIGHT Preferences. 
 

 

Highlight Strength:  
Set the slider to a view width that you are comfortable with. 
 
Stitch Type: 
Clicking ‘Normal Stitch’  refers to general coverstitching  or 
topstitching as opposed to ‘underlay’. 

Objects to Highlight: 
Checked types are included in the stitch types to highlight. Simply 
uncheck a type/s to exclude. 
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Change jump length 
To change jump length select the object and select Stitch > 

Change Jump Length, a dialog will open and you can set the jump 
length on selected or all objects. This will change the default 
jump value as well. 
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Stitch type conversion 
Each stitch point can be a normal, jump or a sequin stitch.  

I-CLIQQ provides stitch conversion ability. This function will be 
applied on all the stitches on the selected objects. To convert some 
stitches (not all), use Stitch Edit Tool. 

To convert stitches 
Select the objects to which you want to apply stitch conversion 
then: 

• Select Stitch > Stitch Conversion > Remove Jumps to 
remove jump stitches. 
 

• Select Stitch > Stitch Conversion > Convert Jumps to 
Stitches to convert any jump stitch into normal stitch. 
 

• Select Stitch > Stitch Conversion > Convert Jumps to 
Sequins to convert any jump stitch into sequin stitch. 
 

• Select Stitch > Stitch Conversion > Convert Sequins to 
Jumps to convert any sequin stitch into jump stitch. 
 

• Select Stitch > Stitch Conversion > Convert Sequins to 
Stitches to convert any sequin stitch into normal stitch. 
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Changing sequin parameters 
I-Cliqq  provides an easy method to change sequin parameters, 

like sequin diameters, sequin lock style and sequin run length on 
any embroidery object which has sequins. I-Cliqq also supports 
Dual sequin capability referenced by Sequin A and Sequin B. 

 
 

Original Sequin Design (Sequin 3mm with sequin lock) 
 
 
 
 
 
 

    Sequin 5mm with lock              Sequin 3mm with new                sequin 4mm with new 
             run length and no lock  lock style 
 

 
Sequins feature independent lock styles for the start  and end sequins. 
You can also  disable these in the sequin properties to effect  automatic 
connector functions, but you need to exercise judgement  when using 
different types of sequins. You can convert runstitches to sequins and 
even convert vector outlines to sequin runs. If you have selected a text 
style from a graphics program, you can convert the outlines to sequins 
giving you instant sequin lettering. You may need to edit some nodes 
depending on the font style you selected, but you can basically convert 
any TTF outline (converted to curves) , to sequin letters. 
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Sequin Properties 
If you have created a sequin run: 
Double click the object, and click on the ‘Sequin’tab page. 
 

 
 

• Sequins are a variant of runstitch, so if you created a runstitch, 
you can select Sequin A, or A+B  if utilizing the dual sequin 
attachment. 

• Diameter and Color 
• Sequin Lock Overlap 
• Sequin Run Effects 
• Style – Lockstyles 
• Feed Direction 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can create various sequin run effects in a really unlimited fashion. 
Good sequin designs depend on good curves so when you create  
sequin designs you need to be aware of the sequin diameters . 
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If you select the ‘Sequin Diameter and Color’ option, you can change the 
size, and color of the onscreen sequins. 
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Changing parameters on a selected sequin run will give you varying 
effects on your sequin creations. These should be applied with caution, 
and take into consideration the type of sequin design you are creating, 
along with all the other elements related to sequin designs. In general,  
I-Cliqq provides you with all the sequin tools and ease of applying 
parameters . 
 
View video to see basic sequin parameter changes. 
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Chapter 6 
 
Underlay 
Underlay Stitching, together with the use of stabilizers, helps you to 
stabilize your columns, and also add a lustrous rich look to embroidery. 
 

 
 
You can add underlay from the Properties Bar without having the 
Underlay Toolbar open. 
 

 
You can also modify the types, by adjusting the parameters. 
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If you select eg ‘Running’ , but suddenly would prefer to use Running 
+ Zigzag in a design, simple tick each in the checkbox, and on the 
lowest part of the Properties Box, you can save it to the Default 
Template OR, if you have set up other templates, you can save the 
underlay settings. 
 
Generally, you may find yourself modifying underlays numerous 
times, whether enabling, disabling, or totally changing parameters. 

 
 
The underlay Toolbar, is situated on the Stitch Properties Toolbar. If 
you have preset your underlay types, simply pressing this icon while 
an object is selected will enable/disable underlay. 

 
 
Like other icons that have expandable toolbars, the underlay toolbar 
can also be expanded, and docked anywhere by clicking the small 
triangles. There is no need to undock the toolbars unless you want to, 
you can also just select , and it will hide again after applying any 
necessary changes. If you have undocked, and moved it to a new 
position, then closing it from that point, will revert it to its initial 
‘cabinet’ on the Stitch Property Bar. 
 

 

I-Cliqq User Manual 231 



 
 
 Let’s say you had it expanded and docked in this vertical position: 
 

 
 
 

 
 

Original ‘Underlay’icon position. 
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Digitizing 
 

I-Cliqq allows automatic generation of stitches while digitizing. ‘Always 
Refresh’ is the default mode of operation and very fast allowing you to 
see realtime stitch generation. I-Cliqq features a variety of tools, and 
digitizing modes to allow the novice, to professional to enhance their 
digitizing skills and speeds at their own convenience. The different 
digitizing modes offer seamless operation between modes, making your 
preference of a digitizing style a matter of choice. 
 
 This feature is called Auto Stitch Generation and an icon (  ) (Stitch 
Property Toolbar) shows if this option is active on the selected object. 
The stitches will not be modified if this option is set to ‘off’ on an object, 
unless you set it’ on’ again. Click Auto Stitch Generation to enable it (  
) or disable it (  ) on the selected object. 
 
In I-Cliqq , as found in different brands of software , you may find some 
terminology slightly different, but basically referring to the same , or very 
similar embroidery terms. Wherever you may see a reference to ‘Path’ , 
merely means ‘OUTLINE’ – so object path, satin path, etc simply refers 
to vectors or outlines. Runstitch, may be called ‘walk’ , tatami may be 
called ‘fill’ and numerous stitch types may go by various names in the 
industry, but basically refer to the same types. 
 
The basis of an outline is the line you see, and the nodes that create its 
shape. I-Cliqq is a vector based program, so many of the outline 
capabilities are similar to popular graphics programs, with the relevant 
modifications necessary for  embroidery related tasks. 
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Main Properties Dialog Box 
 
The I-Cliqq Main Properties Box is intuitive, and can be docked to the 
left or right, undocked and floated, and will roll up/down as defined in the 
settings. It can also slide out of sight, and be brought into view again by a 
simple click on the control bar. If hidden or closed, double clicking any 
object will bring the properties box into view. You can also click . 
 
Clicking on any object or stitchtype will update the visual information. 
Initially, you will see basic parameter information. Clicking tabbed page 
buttons will show extended related information. 
 
See Video Clip for general positioning and capability of Properties Box. 
The Properties Box is an integral part of Digitizing, as it is your constant 
reference to parameter change. If you do use dual monitors, you can 
really float it there permanently, although one widescreen monitor is 
really sufficient. I-Cliqq does provide you with good space-savings 
capability to allow maximum workspace. 
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Digitizing Modes 
I-Cliqq provides 4 different digitizing modes. (Bezier, Arc and Spline, 
and Arc-Spline) and you can decide which method to use for digitizing 
projects. 
 

 

 
 
These 4 methods interchange seamlessly, and as you advance 
you will be able to identify which mode may suit a particular task 
best. Now that the use of embroidery programs generally means 
that you are also working with a graphics program, I-Cliqq 
simulates the popular styles. 
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The digitizing tools for stitch types are located on the Editing & 
Digitizing toolbar. 
 

 
 
As you click a stitchtype, eg Satin you will see the Digitizing 
Styles highlight. 
 

 
 
 You may prefer a particular digitizing style, and only stick to one 
method if that suits your preference, but you will need to learn how 
to edit different node types, as vector art  you may copy into I-Cliqq 
from a graphics program, or imported vector file, will appear in 
Bezier Mode. As you experiment, you will find that you can force 
different nodes to react differently by changing the drawing style as 
nodes are selected.  
 
Experimentation, is always the best teacher, and only constant 
practice and experiments will allow you to learn all the node 
possibilities and permutations  of the different reactions, in different 
design circumstances. 
The simplest mode used by most traditional digitizers is Arc- Spline 
Mode. It’s a fusion of Arc and Spline mode which are very similar 
styles. Bezier is a more advanced mode, and may be preferred by 
users with graphics software experience. 
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Stitch Types and the Digitizing Toolbar 
Expand the stitch type toolbars by clicking the small triangle 
on the lower right corner of the icons. You can then drag, and 
dock these in any position you find convenient. There is also 
no need to expand them, because you can select a type as 
they flyout. The flyout toolbars close after you select a type. 
 

 
 
 

The digitizing tools are sorted into three main groups (single curve objects, dual 
curve objects and closed curve objects) and each group contains tools to create 
embroidery objects. When you want to digitize a specific embroidery object, 
you only need to click on the object icon and start digitizing.  
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Single curve objects  
 
All the embroidery objects in this group will need a single outline created 
to generate stitches. The outline can be an open or a closed curve. There 
are some objects which can have sub paths (branches). 
 

 
 
 
 
 
Dual curve objects 

 
All the embroidery objects in this group will need two outlines to 
generate stitches. The outlines of these objects can not be closed 
automatically. There are some objects which can have internal ‘outlines’ 
(carve lines). 

 
Dual Path Objects 
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Closed curve objects 
 

All the embroidery objects in this group will need one single path to 
generate stitches. The paths of these objects are closed curves by default. 
Most objects in this group can have sub paths (branches) as holes inside 
the main surrounding path. 
 

 
 

Closed path object with or without sub paths 
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Outline  Drawing/ Object Creation 
 

The outline  drawing style is set to Bezier by default but you can change it 
from the menu, Path > Digitizing Style. 
 

 
 

 
Note: Once you select a drawing style, that will be the default each time 
I-Cliqq starts up 
 

.  
The same icons appear each time you select a stitchtype. You can 
select/interchange between modes at any time. Bezier mode is usually 
preferred by graphic artists, while a novice or traditional digitizer will 
find arc-spline mode simplest. 
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Arc- Spline Mode 
 

 

 
 
Left and right clicks create shapes simply. Click the ‘Swap Mouse Buttons’icon 
to select the most comfortable mouse action. You will see it highlight in Spline, 
and Arc-Spline mode. 
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Bezier drawing style 
 

 
You will see the above node manipulation tools on the Property 
Toolbar allowing you a familiarity with popular graphics programs. 

 
Make sure that path drawing style is set to Bezier. To Select Path > 
Digitizing Style > Bezier or press v &. 
 

To start digitizing, select a digitizing tool, for example Running ( ) 
(you can also press R as shortcut key), then rest the pointer on the design 
working area on a desired point and click to digitize lines. Bezier mode 
uses only the left mouse button. 
 

 
Digitizing lines with Bezier 

 
To finish digitizing, you can : 
 

• Press s 
• Press x 
• Click on another tool 
• You can also just tap ‘R’again or  a shortcut to another 

stitchtype. Eg. ‘s’- satin. 
• Clicking on any other stitchtype automatically terminates one 

mode, and starts another so essentially, you have no physical 
‘command’ to initiate, to end digitizing an object. 

 
Note: If you perform an action that causes the current digitized object to terminate, all the 
outlines you have drawn will be intact. This is excellent when you get that sudden phone 
call, or have to stop for any reason. In I-Cliqq, you can finish an unfinished object without 
digitizing  it all over again, just because you had to stop. You can also extend an object 
you have ‘completed’ at any time, and even swap sides if digitizing one end of a satin 
column, without missing a beat…How about editing your nodes while in mid-digitizing if 
you placed any incorrectly?  I-Cliqq makes it conveniently possible to do that, and just 
continue digitizing. 
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Bezier Mode Creation Technique Basics 

 
To draw a curve with Bezier style, just click and drag. When you 
click, you define the start or end node of the outline and when you 
drag, you define the curvature by a control point. 

 

 
Digitizing a Bezier curve 

 
To digitize a corner, you can click without dragging. 
 

 
 
Or while you are dragging the control point, press 1 to make a 
corner. 
 

 
 
There are some tools available on the Property toolbar to help you 
in outline drawing. See Node Edit Tool for more details. 
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• To close the curve, click  from Property Toolbar.  
 

• You can just press ‘A’ on the keyboard. 
 

 
• You can also just click on the initial node, and the curve will 

close automatically. As that curve is still active in case you wish 
to continue making a few more nodes, you need to press ESC or 
tap SPACEBAR to end, and depending on the stitch type, you 
may be required to position an exit point.  

•  
• You can also just tap SPACEBAR twice to end. This bypasses 

having to position the end point, and it defaults to the last stitch. 
 

 

 
Closing a  curve using Auto Close 

 
Tip: Bezier mode produces the smoothest curves, when nodes are not created 
too close to each other. 
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Arc drawing style 
 
Make sure that path drawing style is set to Arc. Select Path > Drawing 
Style > Arc or press v *. 
 
To start digitizing, select a digitizing object tool, for example Running 

 (you can press R as shortcut key), then rest the pointer on design 
working area on a desired point and click to digitize lines. 
 

 
Digitizing lines with Arc 

 
To digitize curves and corners, you can use left and right clicks. 

 

 
 

To close the curve, click  from Property Toolbar. The 
procedure is the same as autoclose in Bezier mode. 
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Spline drawing style 

 
Make sure that path drawing style is set to Spline. Select Path > Drawing 
Style > Spline . 
 
To start digitizing, select a digitizing object tool, for example Running 

 (you can press R as shortcut key), then rest the pointer on design 
working area on a desired point and right click to digitize lines. 
 

 
Digitizing lines with Spline 

 
To digitize curves and corners, you can use left and right clicks. 
 

 
 

To close the curve, click  from Property Toolbar. 
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Advanced path drawing with Bezier 

 
While you are drawing a path you can use the following options: 
 

• Press n to delete the last created node. 
 

• Hold down v, to constrain the node positioning to vertical or 
horizontal directions. It will take effect when you incrementally 
move the pointer to vertical or horizontal positions. 
 

 
 

Hold down v key to constrain to vertical or horizontal line 
 

• Press 1 while you are dragging a control point to change the 
node type to a cusp. Cusp means the controls points of former and 
current curve can be edited independently. This will let you create 
a sharp corner. 

 
Converting a node to cusp while digitizing 

 

You can also click   Cusp (Property Toolbar) to change the 
selected node’s property to a cusp. Click on Cusp and try 
changing the control point of the selected node. 
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• Press 2 while you are dragging a control point to change the 
node type to a Smooth node. Smooth means the controls points of 
former and current curve will be in same direction but they can 
have different lengths. This will help you make a curve when one 
control point must be longer than the other, but you want the 
curve to be smooth, as well. 

 

 
 

Press 2 while mouse button is down,  
to convert the node to a smooth node  

and continue dragging the handle 
 

You can also click  Smooth (Property Toolbar) to change the 
selected node’s property to a smooth. Click on Smooth and try 
changing the control point of the selected node. 
 
Tip: After changing the node property to smooth (after pressing 
2) hold down a while dragging the control point to move the 
handle at the same direction. 
 

 
 

Press 2 while mouse button is down to  
covert the node to smooth Hold down a  
to drag the handle at the same direction 

 
• Press 3 while you are dragging a control point to change the 

node type to a Symmetrical node. Symmetrical means the 
controls points of former and current curve will be in same 

I-Cliqq User Manual 249 



direction with same lengths. This is the default node type. 
 

You can also click   Symmetrical (Property Toolbar) to 
change the selected node’s property to a symmetrical. Click on 
Symmetrical and try changing the control point of the selected 
node. 
 

• Press 4 or click  after you have released the mouse button, 
to remove the front handle of the curve. 

 
 

Press 4 to remove front handle 
 

• Press 5 or click  after you have released the mouse button, 
to remove the former handle of the curve. 

 
Press 5 to remove former handle 
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• Press q 1 or click  to convert the curve to line. 
 

 
•  

• Press q 2 or click  to convert the line to curve. The 
control points will be placed on a line and you can move the 
handles to create your desired curve. 
 

                             
 

• Press - (Tools > Snap to Objects) to snap to the nodes of other 
objects or snap to the stitches of Manual Stitch objects. 
 

• Press + (Tools > Snap to Guidelines) to snap to guidelines. 
 

• Press vY (Tools > Snap to Grids) to snap to grids. 
 

• Hold down a to snap the node of the current path you are 
drawing. 
 

• You can click on the other nodes of the path and edit them while 
digitizing. 
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Digitizing Single path/outline objects 

 
Objects which use a single outline to generate stitches are sorted in this 
category. All objects in this group are almost digitized in the same way. 
Some of them may need a few more steps to define stitch properties 
visually on screen, but the digitizing method for all of them are the same.  
 
To digitize single path objects 
 
‘Digitizing single path objects’ is actually  the same as Outline 
Drawing  with types applied. 
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Digitizing running stitch and sequin run 

 

 Running can place a single row of run stitches along a digitized line. 
It can also repeat each stitch (Bean) or repeat stitches (Running) three, 
five (or more) times for a thicker line. You can apply a displacement 
value to create additional effects on your runstitch creations. 
 

 I-Cliqq provides a very powerful and easy sequin digitizing method. 
I-Cliqq will automatically prevent hitting sequins by needles. You can set 
the sequin diameter from 3 to 9 millimeter and you can have different 
sequin diameters in a design. There are 28 different sequin lock stitches 
available. 
 

 
 
 
 
 

 
To digitize run stitch and sequin run 
 

1. Click on Running Tool (Edit & Digitizing Toolbar) or press 
R, to digitize a run stitching. You can then just select the created 
runstitch, and convert it to SEQUINS. 
 

 Click on Running (Sequin) Tool (Edit & Digitizing Toolbar) 
or press Q, to digitize a sequin run. 
 

2. Draw a path on design working area. 
 

3. To finish digitizing, you can: 
• Press s or 
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• Start a new command or 
• Press x. 

 
Tip: You can define the runstitch length from Stitch Property Toolbar or 
you can access all parameters from the Properties Dialog Box  on the 
‘Running’ page. 

 
To change Runstitch parameters (Running) 

 
Click Properties (Standard Toolbar) to view the Properties Box or 

press ae to open properties dialog box. Select Running on left  
to see running parameters. Change the parameters and click Apply or OK 
to apply the changes.  
 
Tip: you can double click on the object with Object Edit Tool to open the 
properties dialog.  
 

 
 

 
 

 
 

 
 
To change sequin run parameters 
 

 Click Properties (Standard Toolbar) or press ae to open 
properties dialog box. Select Running on left list box to see running 
parameters. Change the parameters and click Apply or OK to apply the 
changes. 
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Tip: you can double click on the object with Object Edit Tool to open the 
properties dialog. 
 
Note: Sequin run is actually a running stitch, but it is also available as a 
separate tool for your convenience. 
 
Note: To know the number of sequins used in a design, open Design 
information. For more information, see ‘Design information and 
database’ . 

 

 
Run stitch length and sequin lock style 

 
 

 
Sequins will not be hit by stitches 

 
 

 
Sequin run on closed curves 
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Drawing Vectors/Outlines. 

 

 Vector/Outlines is used to create lineart vectors. The outlines created 
by this tool have no stitches and are used for drawing purposes but it is 
possible to convert them directly into embroidery objects. This object 
supports branching and you can add branches of outlines to the main path. 
 

 
To draw Vector Outlines 
 
 

1.  Click Vector/Outlines  (Edit & Digitizing Toolbar) or press 
q P, to digitize a vector outline. 
 

2. Draw an outline  on the design working area. 
 

3. Press e to draw a sub path. Repeat this step for drawing 
more sub paths. 
 

4. To finish drawing a segment, you can: 
 

• Press s or 
• Start a new command or 
• Press x. 
• Press e 

 
 Click Properties (Standard Toolbar) or press ae to open 

properties dialog box and change the color of the outline. If you created 
closed curves, you can also assign solid color fills to outlines, and color 
each independently. 
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Change the fill style. Filling By Hatch, is merely for visually purposes if 
creating transparent vector guides. If you create a vector with a solid fill, 
and an outline color eg blue outline and yellow solid fill : If you select this 
for conversion to eg Tatami, I-Cliqq  will convert the fill to tatami, and the 
outline to runstitch by default. You can then select any object and perform 
further conversions. 
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Vectors are objects that have fully editable outlines. 
 

 Object Edit mode will show you the vector selection as a dashed 
line. Clicking on a vector in this mode allows you to resize, rotate, 
skew as you would with any object. 
 

 

 Outline Edit Mode shows you the editable nodes, so clicking on 
vector outlines in this mode allows you to edit the outline shapes. 
 
These 2 modes will be used by you in every aspect of the software , 
allowing you to perform exactly the same tasks on any created object 
or stitchtype. Even when you need to manipulate some aspects of 
keyboard lettering , these same buttons/icons are used. The same 
logic flows throughout the software regarding these operations. 
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Digitizing E stitch 

 

 E stitch is used to digitize a run stitch with a fixed E width. E-Stitch 
is also commonly known as a ‘blanket stitch’ 

 To open the main Properties Box if you need to change parameters. 
 
To digitize E stitch 
 

1.  Click E Stitch (Edit & Digitizing Toolbar) or press E, to 
digitize E stitch. You can also end an E-stitch segment by tapping 
E 
 

2. Draw an outline on the design working area. 
 

3. To finish digitizing, you can: 
• Press s or 
• Start a new command. 

Or 
you can press x to set the width visually on screen. To 
do so: 
• Press x 
• Move the pointer to define the width 
• Click to apply the width 

 
If you press s while you are moving the pointer, the action 
will be cancelled. 
 

 

 
E stitch 
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Tip: To change the E width visually on screen, press * whenever you 
want.  

 

 
 

 
Center line positioning 

 

 
Stitch repeat effect and stitch point displacement 

 
 

 
Variable E length at corners 

 

 
Variable run length 
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Digitizing single path satin 
This stitchtype is commonly known as centerline or midline satin. 
Different software brands may define it by other names as well. 

 

 Single path satin is used to digitize satin with fixed width. You can 
also apply different effects on this object. 
 
To digitize single path 
 

1.  Click Single Path Satin (Edit & Digitizing Toolbar) or press 
q S, to digitize single path stitch. 
 

2. Draw an outline on the  design working area. 
 

3. To finish digitizing, you can: 
• Press s or 
• Start a new command. 

Or 
You can press x to set the width of the satin visually on 
screen. To do so: 
• Press x 
• Move the pointer to define the width 
• Click to apply the width 

If you press s while you are moving the pointer, the action 
will be canceled. 

 
Single path satin 

 
Tip: You can define some basic parameters of these objects from Stitch 
Property Toolbar ( Width  , Center line positioning  , Density 

 ) or you can access all parameters from Properties Dialog Box on 
Single Path Satin Page. 

 
Tip: Press * to change the width parameters visually on screen. Press 
s or x to exit the visual edit command. 
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To change single path satin parameters 
 

 Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Single Path Satin on list box to see single 
path satin parameters. Change the parameters and click Apply or OK to 
apply the changes. 
 
Basic parameters 

 
 
        Density 

 
 
 

   Width              Center line positioning (50%) 
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Corner parameters 
 

 
 
 
 

 
Auto cornering 

 
 
 

 
Maximum angle to apply auto cornering 
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Apply cap when the corner angle is small               Remove or force to fill cap 
 

 
Effect parameters 
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While a single path satin column is selected , you can enable Effects. 
Take some time to experiment with parameter changes. 
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                              Braid Style 

 
 
 

  Thread Style 

 
 

 
Braid Style 

 
Width  

 

 
Slant count 

 

 
Move count 

 

 
Spacing effect 

 

 
Close ends on open paths 
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Overlapping on closed curve 

 

 
Displacement to prevent thread breakage 

 
Thread Style 

 

 
Forward and Backward count 

 

 
Underlay stitches at ends 

 
Overlapping on a closed path 
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Pattern parameters 
To open Select Satin Pattern dialog, click on pattern image on Pattern 
page of Single Path Satin properties. Selected pattern will be shown in a 
blue background.  
 
 
To select a pattern, click on a pattern icon on Select Satin Pattern dialog. 
Press s to close the dialog if you have not selected a pattern. 
 

 
Pattern angle 

 

 
Pattern length 

 

 
Pattern height 

 

 
Row displacement 

 
Patterned Edge Parameters ( EDGES) 
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Click on the pattern icon to open Select Satin Edge  dialog. The selected 
pattern will be shown in a blue background.  
 

 
 

Click to select a pattern or press s to close the dialog without 
selecting any pattern. 
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                                      Length 
 
 
 
               Height 
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Digitizing Pattern stitch ( Motifs) 

 
 Pattern stitch is used to digitize patterns on a single line. 

 
 

To digitize a pattern stitch 
 

1.  Click Pattern Stitch (Edit & Digitizing Toolbar) or press P, 
to digitize a pattern stitch. 
  

2. Draw a path on design working area. While you are drawing the 
outline, pattern stitch will generate a simple run stitch because 
you have not selected any pattern yet. You can create a template 
with a default pattern for Pattern Stitch. See Design Templates . 
 

3. Press x 
 

4. Rest the pointer over a pattern and click to select it, the pattern 
dialog will close after you select a pattern 
 

5. Click OK or Apply on properties dialog to apply the changes. If 
Auto Apply is ON, the pattern will change immediately. 

 
 

 
Digitize the shape, and press Spacebar to end. 
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Tip: You can define some basic parameters of these objects from the 
Stitch Property Toolbar (Center line positioning ) or you can access 
all parameters from Properties Dialog Box on Pattern Stitch Page. 

 
To change pattern stitch parameters 
 

 Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Pattern Stitch on left list box to see pattern 
stitch parameters. Change the parameters and click Apply or OK to apply 
the changes. 
 
Pattern Size parameters 
 

 
 

       Width 
 
 
              Height 
 
 
 

    Pattern Displacement (Repeat Every) 
 

Tip: Press * to change the size parameters visually on screen. Press 
s or x to exit the visual edit command. 

 

 
 

 
Repeat Type 
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Effect parameters 
 

 
Center line positioning 

 
 

 
 

Connecting patterns where Pattern Displacement is set to a large value 
Change the run stitch length from Running page on Properties dialog 

 
Multi Color parameters 
 

 
Multi color patterns 

 
 

 
Stitches can be generated for all colors 
or individually on multi color patterns 

 
 

 
 

Needle colors of a multi color pattern, First color is defined  
by object’s needle color from Stitch Property Toolbar 

 

 
Click Create Separate Objects to create individual objects for every color, this 
helps you reduce the color numbers in a design by reordering objects by color. 
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Digitizing contour stitch 
 

Contour Stitch is used to digitize running with even stitch repeats (2, 
, 6, … times). It will run on a single line and return to the start point. 

This
4

 object supports branching and you can add branched of paths to the 
main path. 
 

 
 

To digitize contour stitch 
 

 Click Contour Stitch (Edit & Digitizing Toolbar) or press C, 
to digitize a contour stitch. 

tline. Press e to end, or continue 
reating Contour Stitch segments. 

re digitizing a sub path, the 
 

1. 

 
2. Press e to draw an ou

c
Note: The outlines/paths will always be connected to each other 
from the nearest point. While you a
connection positions may change according to their distance from
other paths. 
Tip: You can add or remove branches whenever you want.  

o Click  (Property Toolbar) to enable addi
paths to the object, after adding the first sub path, pr

ng sub 
ess 

e or click  again to start adding more sub 
paths.  
 

o To remove a 
se

sub path, double click on a sub path’s node (to 
lect all the nodes of the path) and press m. 

s or 
 

. 

 
3. To finish drawing, you can 

• Press 
• Start a new command or
• Press x
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ontour stitch length from Stitch Property 

Toolbar
Tip: You can define the c

  
 
To chan e g contour stitch parameters 

 
 
Click Properties  (Standard Toolbar) or press a e to open 

roperties dialog box. Select Contour Stitch  tab page to see contour stitch p
parameters. Change the parameters and click Apply or OK to apply the 
changes. Contour Stitch supports entry/exit.   

 Although similar to running stitch, entry/exit points are handled 
together in contour stitch, so you see just one symbol in Outline Edit 
Mod

 

   Contour run length 

e.  
 

 

 
Contour stitch 

 

 
 

 
 

Stitch repeat effect with displacement 
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Digitizing single path contour 
 

 Single path contour is used to digitize Tatami on a single line with a 
fixed width. 
 

 
 
To digitize single path contour 
 

1.  Click Single Path Contour (Edit & Digitizing Toolbar) or 
press q C, to digitize single path stitch. 
 

2. Draw an outline/path on design working area. 
 

3. To finish digitizing, you can: 
• Press s or 
• Start a new command. 

 
Or 
 
You can press x to set the width of the object visually 
on screen. To do so: 
• Press x 
• Move the pointer to define the width 
• Click to apply the width 

If you press s while you are moving the pointer, the action 
will be cancelled. 
 

 

 
Single path contour 
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To change single path contour parameters 
 

 
 

 
Single path contour parameters 

 

 
Center line displacement 

 
Tip: Press * to change the width parameters visually on screen. Press 
s or x to exit the visual edit command. 
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Digitizing cross stitch 
 

 Cross Stitch is used to digitize cross stitch on a single line. This 
object supports branching and you can add branches of outlines to the 
main outline. 
 

 
 
To digitize cross stitch 
 

1.  Click Cross Stitch (Edit & Digitizing Toolbar), to digitize a 
cross stitch. 
 

2. Draw an outline on design working area. 
3. Press e to draw a sub path/outline. Repeat this step for 

more sub paths. 
4.  

Note a): the crosses will not overlap and repeat when the outlines 
intersect each other.  
b) If the distance of a sub path from other paths, is more than a 
cross size, no cross will be generated on that path. Experiment 
with general creation to explore basic Cross Stitch. 

 
5. Tip: You can add or remove sub paths whenever you want.  

o Click  (Property Toolbar) to enable adding  
sub paths to the object, after adding the first sub path, press 

e or click  again to start adding more sub 
paths.  
o To remove a sub path/outline, double click on a sub 

path’s node (to select all the nodes of the outline) and 
press m. 
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Tip: If you draw a line and convert it to curve (click  or press 
q 2), a cross run will be generated. 
 

               
 

6. Press * or x, to define entry exit points. Two symbols 
will display on screen as entry and exit points. 

 
 

 

 Outline Edit mode will display the nodes, and entry/exit point. 
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 Contour Stitch : The combined entry/exit will show as above if 
you edit this stitch type. This is because I-Cliqq handles entry/exit 
simultaneously, and these cannot be separated on this type. 
 
To change entry / exit points 
 

o Rest the mouse cursor on an entry or exit symbol. 
o Click and drag the symbol to desired point. 
o Release mouse button. 
o Press x or s to finish. 
 

 

 Once you click on an object with the Outline Edit 
Tool, you’ll see the entry/exit as above if supported. 

 
Floating your mouse cursor over an entry or exit point icon will 

change the cursor indicator, indicating you are ready to drag 
that point to a new position. Hold down with the left mouse 
button when the indicator changes ,and you have selected that 
point . Now merely drag it to the desired new position. 

 

 
 

 
Note: If you place the entry or exit point out of the stitch area, the start or end 
point will be located on the nearest point to the entry and exit symbols. 
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You have repositioned the point, so soon as you select another 

stitchtype, or begin digitizing again, you will see the flashing + in the 
new position. 

 
Tip:  If you discontinue digitizing by pressing s or by using 
another command, the entry/exit points default to the first/last 
stitch. You can change entry and exit point  positions by pressing 
* whenever you want. 

 
To change cross stitch parameters 

 

 
 

Cross stitch size 
 

 
 

Cross stitch type 
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Main Properties and Stitch Properties Toolbar 
 

 
 

 
To maximize the workspace at all times, I-Cliqq also includes the Stitch 
Properties Toolbar. If you have the Stitch Properties  Bar docked, there is 
no real need to have the Main Properties Box open at all times. The 
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Stitch Properties bar includes the basic, most changed parameters, and 
shows the default parameters as you initiate any stitchtype. You can also 
change these parameters to effect on current digitizing. The two 
properties boxes can remain open, or closed..it is a simple matter of 
preference. Essentially, you can always have just the basic parameters on 
hand, or see all parameters. Some prefer to have the main properties 
always open.  
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Maximizing My Workspace 
If you work on the go, constantly using your laptop, you will find F9 , 
and the Ctrl + F9 keys invaluable in creating the maximum working 
screenspace. 
 
Try Pressing F9. Press F9 again to return to normal screen mode. 
 
Try Pressing Ctrl + F9 .  Press Ctrl + F9 again to return to normal screen 
mode. 
 
Between The Main Properties Box, Stitch Property Toolbar, and using 
these keys anytime, you should always have comfortable workspace. 



Digitizing Dual path objects 
 
The objects which need a pair of paths to generate stitches are sorted in 
dual path objects category and are  digitized in almost the same way.  
This is commonly known as side-to-side input. Some are slightly different 
and require additional steps, but the method is the same. 

 

 
 
Tip: when drawing a dual curve 

• Hold down v to constrain nodes incrementally. You can use 
this to constrain to horizontal, vertical, or some incremental 
angles. 
 
 

• If the paths intersect each other, the node position will be 
swapped automatically. 

 

 
Automatic node swapping is on 
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Use Preferences to set automatic swapping to off. Select Tools > 
Preferences, preferences dialog will open 
 

 
 
Click Swap nodes if paths intersect to remove the check mark 
sign and select OK. 
 

 
Automatic node swapping set to off 
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Digitizing satin 
 

 Satin can create columns of varying width and stitch angle. It has 
different stitch effects (double divided, multi divided, jagged, break lines, 
E style, with patterns and random fill). To digitize different satin stitch 
effects easily, different tools are available for different satin styles. 
 

 
 
To digitize satin 
 

1.  Click on Satin (Edit & Digitizing Toolbar) or press S, to 
digitize a satin. 
 

2. Draw paths on design working area. 
 

3. To finish digitizing, 
 
• Press x or s or start a new command. 
•  

Entry/Exit points default to first/last stitch. 

 
 

• Press * to define entry/ exit points visually on screen. 
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To change entry / exit points 
a. Rest the pointer on entry or exit symbol. 
b. Click and drag the symbol to desired point. 
c. Release mouse button. 
d. Press x or s to finish. 

 
Note: If you place the entry or exit point out of stitch area, the 
start or end point will be located on the stitch which is nearest one 
to the entry and exit symbols. 
 
Tip:  you can change entry and exit points by pressing * 
whenever you want. 

 
To change satin parameters 
 

 
 

 
      Satin and zigzag stitch generation methods Satin stitch repeat effect when set 
       to a value higher than 1 
 
    Density 
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Satin styles 

 
 
You can apply different styles to a satin object. Different tools are 
available (on Edit and Digitizing Toolbar) for every style, for your 
convenience. You can click on these tools and start digitizing your 
desired satin style directly. It is also possible to digitize one style and 
change it to other styles from Properties Dialog box. Some tools may 
provide one or two more steps to finish digitizing. 
 

 
•  Satin (Normal), this is normal satin without any specific style. 

After you finished digitizing, press * to define entry / exit 
points visually on screen. 

 
•  Satin (double divided), it is digitized the same as normal satin 

but the stitches will be split. You can define the split position 
from Properties Dialog. 

 

 
Satin (double divided) 
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•  Satin (multi divided), it is digitized same as normal satin but 
the stitches will be split more than twice. You can define the split 
counts from Properties Dialog. 

 

 
 
 
 
 

 
 

•  Satin (jagged), it is digitized same as normal satin but the 
stitches will be jagged. You can define the split counts from 
Properties Dialog. 

 

 
 
 

 

 
Satin jagged 
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The jagged stitch lengths depend on object’s width and jagged 
percentages set. 
 
Random Seed affects jagged parameters. You can change this 
value to obtain different forms of jagged effects on an object. 
 

 
 

•   Satin (Carve lines) : Digitized same as normal satin. When 
you finish creating a satin shape, press e . You can 
immediately add ‘carve lines’ to your satin shape. These are not 
static, and can be edited, and changes reflect instantly. 

 

 
 

To add or remove sub paths (carve lines or inner 
‘outlines) 
 

o Click  (Property Toolbar) to enable adding 
sub paths to the object, after adding the first sub path, 

press e or click  - add carve lines. 
 

o To remove a sub path, double click on a sub path’s node 
(to select all the nodes of the path) and press m. 
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•  Satin (E style), it is digitized same as normal satin but the 
stitches will generated as E stitch. 
 

 
 
 

 

 
 

•  Satin (with patterns), is digitized the same as satin, but a 
pattern effect can be applied to the center of the satin and also 
two different patterns can be applied to each edge of satin. 
After you finished digitizing the paths, press x , Pattern 
Select dialog will open and you can select patterns, after selecting 
the pattern, click OK or Apply. 

 

 
 

Satin pattern parameters 
 

 
 

 
 
Select Satin Pattern dialog 

 
If you click on the pattern icon on Properties dialog: Select Satin 
Pattern will open, Click on a pattern to select it or press s to 
close it without any selection. 
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Satin edge pattern parameters 
 

 
 

 
 

 
•  Satin (random fill), it is digitized same as normal satin but the 

stitches will be split randomly according to a minimum and 
maximum stitch length. You can change the stitch length from 
Properties Dialog. 
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Digitizing non- parallel tatami 

 
 Non parallel tatami can create a tatami with varying width and stitch 

angles. The Digitizing method is the same as traditional satin stitch 
creation. 

 
 
To digitize non parallel tatami 
 

1.  Click on Non Parallel Tatami (Edit & Digitizing Toolbar) or 
press q T. 

 
2. Draw outlines on design working area. 

 
3. To finish digitizing, 

• Press s or start a new command. 
In this case the first stitch will located on first node of the 
first path, and last stitch will locate on last node of the second 
path/outline. 

 
 

• Press x  to end or press * to define entry exit 
points visually on screen. 
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To change entry / exit points 

a. Rest the pointer on entry or exit symbol. 
b. Click and drag the symbol to desired point. 
c. Release mouse button. 
d. Press x or s to finish. 

 
Note: If you place the entry or exit point out of stitch area, the 
start or end point will be located on the stitch which is the nearest 
one to the entry and exit symbols. 
 
Tip:  you can change entry and exit points by pressing * 
whenever you want. 

            Exit point 
 
 
                 Entry point 
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To change non parallel tatami parameters 
 
Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Tatami on left list box to see tatami 
parameters. Change the parameters and click Apply or OK to apply the 
changes. 
 
Note: Non-Parallel Tatami  does not support ALL parameter changes. 
 
Specifications/ Parameters 
 

 
 
    Density 

 
 

 
Back Stitch effect 

 
Minimum Stitch Length is used to filter pattern stitches.
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Pattern parameters 
 

 
 

 
Click on pattern icon, Select Tatami Pattern will open. Click on a pattern 
to select it or press s to close the dialog without any selection. 
 
If you choose a pattern, Combination Split parameters page, and related 
parameters will display on Properties dialog. 
 

 
 

              Length   Offset 

 
 

Offset value in Pattern page only works when you are not using any 
pattern. If you use a pattern, an extra offset value will be available in 
Combination Split page, which is  effected if you activate the combination 
split option. 
 

 
Tip: You can press *, to define pattern size and positions visually on 
screen and press x or s to finish. 
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You can experiment with effects, parameter changes, and options to 
create optimum stitch counts , or custom pattern effects as many times as 
you like, changing any of the settings. The variations are endless, so you 
have the power to create unique effects. 
 
* 
You can press F8 while any object is selected. If you do not see entry/exit  
indicators, that means the object does not support entry/exit points eg. 
Contour Stitch. 
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Basic parameters are in full view with any created object. You can switch 
to the related tab pages to effect other parameter changes like 
Combination Split, Jagged effects or Random Fill. 
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Pattern angle 
 

 
Variable pattern length on non parallel tatami 

 
 

 
Combination split 

 
 

 
 

Combination split stitch and offset parameters 
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An example of Combination split Tatami/Satin 
 
You can change the ‘Type’of split to see which applies best to the 
various patterns. Different patterns have different possibilities, so not all 
effects will apply in all cases.
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Digitizing contour tatami 
 

 Contour tatami can create a tatami with varying width and direction 
angles. Digitizing method is the same as satin. 
 

 
 
To digitize contour tatami 
 

1.  Click on Contour  Tatami (Edit & Digitizing Toolbar) or 
press O 
 

2. Draw outlines/paths on the design working area. 
 

3. To finish digitizing, press s or start a new command. 
 
To change contour tatami parameters 
 
Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Contour Tatami on to see contour tatami 
parameters. Change the parameters and click Apply or OK to apply the 
changes. If Auto Apply is set to ON , some parameters will apply 
automatically. 
 

 
 
     Length  Offset 
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Density will be applied considering  object’s width 
 
 

 
Set Parameter to generate specific rows of contour tatami 
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Digitizing tatami 
 

 Tatami is used to digitize filled shapes with fixed stitch angles. 
Digitizing method is same as a single path object, but the path is closed 
by default. Boundaries in tatami objects should not overlap or intersect 
each other. A boundary should not overlap itself and should not have a 
second boundary inside (a hole inside a hole), but holes can overlap or 
intersect each other. 

 
An example of I-Cliqq Stitch Split FX 

 

 
 
This Stitch Split FX allows you a great degree of flexibility in its 
application. It has multiple uses because of its capability to split stitches 
at predefined lengths. Apart from creating less stitches, you are also able 
to apply this technique in numerous practical situations. One good 
example is large text when you might have patterns, or tatami . Many do 
large monograms on pillowcases or large format text. You can now have 
tatami  splitting into satin, with the added capability that it maintains the 
split range even when resized. We’ll explore that more later. 
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Tatami stitches are generated instantly as you are digitizing a shape. 
 

 
 
To digitize tatami 
 

1.  Click Tatami (Edit & Digitizing Toolbar) or press T 
 

2. Draw the main boundary outline on the design working area. 
 

3. Press e to draw sub paths (holes). Repeat this step for more 
sub paths. 
 
Tip: You can add or remove sub paths whenever you want.  

o Click  (Property Toolbar) to enable adding 
sub paths to the object, after adding the first sub path, 

press e or click  again to start adding 
more sub paths.  

o To remove a sub path, double click on a sub path’s node 
(to select all the nodes of the path) and press m. 
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4. Press x or *, to define entry / exit points and fill angle 
 

 
 
You can also click on the ‘Outline Edit’ icon. 

 

  
      
To select an object , click on the ‘Object Edit’ icon. 
The Outline Edit and Object Edit icons will be your most used icons, 
with regard to  objects. If you have clicked these 2 icons, tapping 
Spacebar will toggle between the 2 modes. Almost every act of 
editing an object requires you to be in one of the 2 modes as you will 
either select an object to rotate/skew/resize or find it necessary to edit 
the outlines by manipulating the nodes. 
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To change entry / exit points 
 

o Rest the point on entry or exit symbol. 
o Click and drag the symbol to desired point. 
o Release mouse button. 

 
Note: If you place the entry or exit point out of stitch 
area, the start or end point will be located on the nearest 
point to the entry and exit symbols. 
 
Note: Entry and exit points will be only calculated on the 
main boundary path. 
 
To change fill angle 

o Rest the point on rotate symbol. 
o Click and drag to define fill angle 

 
o Press x or s to finished. 

 
Tip: You can also define the fill angle from Property 
Toolbar (  ) or Properties Dialog (  ) 

 
Note: If you place the entry or exit point out of stitch area, the 
start or end point will be located on the nearest point to the entry 
and exit symbols. 
 
Tip:  If you discontinue digitizing tatami by pressing s  the 
entry/exit points  will automatically position on the initial point. 
You can change entry and exit point/tatami angle by pressing *  
at any time while the object is selected. 
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To change tatami parameters 
 
Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Tatami in the dialog see tatami parameters. 
Change the parameters and click Apply or OK to apply the changes. 
 
Specifications parameters 

 
For easy and fast digitizing, three more tatami tools are available for 
different tatami styles. If you click these tools, you can directly digitize 
tatami with specific styles. If you change the property from Tatami to 
Single Curved Filled or Dual Curved Filled, you have to add a path as 

Stitch Filling Path by clicking . Or if you change the property 
from Single Curved Filled or Dual Curved Filled to Tatami, you will have 
to remove Stitch Filling Path, to do so, double click on a node of the 
Stitch Filling Path to select all the nodes and press y. 
 

 
Back Stitch effect 

 
            Density 
 

 

 
Sections Overlap 

 
Min Stitch Length is used to filter pattern stitches. 
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Pattern parameters 
 

 
 
 

Click on pattern icon, Select Tatami Pattern . Click on a pattern to select 
it or press s to close the dialog without any selection. 
 
If you choose a pattern, Combination Split parameters page will display 
on Properties dialog. 
 

 
 

              Length   Offset 

 
 

Offset value in Pattern page only works when you are not using any 
pattern. If you use a pattern, an extra offset value will be available in 
Combination Split page, which effects if you activate combination split 
option. 
 

 
Tip: You can press *, to define pattern size and positions visually on 
screen. 
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Tip: If you reshape the tatami object, the pattern location may change, 
because they are generated according to design origin. You can change 
the pattern location, to do so, hold down v and click on the cross sign 
on the pattern and drag it to your desired location. 
 

 
 

Click on the cross at the center of pattern shape, and drag it while holding 
down v, to change pattern location. 

 
 

 
 

Pattern angle 
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Combination split 
 

 

 
 

Combination split stitch parameters 
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Digitizing parallel satin fill 
 

 Parallel satin fill is used to digitize complex shapes with satin stitches. 
This object is actually a tatami object but the Back Stitch parameter is set 
to Satin Stitch. Digitizing method and parameters are same as tatami. This 
style is practical to digitize unidirectional shapes. 
 

 
 
To digitize parallel satin fill 
 

1.  Click Parallel Satin Fill (Edit & Digitizing Toolbar) 
 

2. Draw main boundary path on design working area. 
 

3. Press e to draw sub paths (holes). Repeat this step for 
digitizing more sub paths. 
 

4. Press x or * to define entry / exit point and fill angle 
and press x or s to finish. 

 
To change parallel satin parameters 
Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Tatami  to see tatami parameters. Change the 
parameters and click Apply or OK to apply the changes. 
 
Note: Parallel satin fill is actually a tatami object but the Back Stitch 
parameter is set to Satin Stitch.  Pattern parameters will affect this object, 
but you may change other parameters like Density, Sections Overlap. 
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Digitizing single curved tatami fill 
 

 Single curved tatami fill is used to digitize filled shapes with nonlinear 
stitch filling. Digitizing method and parameters are same as tatami. 
 

 
 

ote: In this method, you need to define a stitch flow by creating a guide 

To digitize single curved tatami fill 

1. 

N
set of nodes (see the wavy line). This defines the curve of the tatami fill. 
 

 
 Click Single Curved Tatami Fill (Edit & Digitizing Toolbar) 

raw main boundary path on design working area. 

nce you press Enter or  Spacebar, a default curve will appear. 
 

ote: Tatami angle will not work on this object because the stitch 

 
2. D

 
3. O
4. You can edit that in Outline Edit  mode and press ESC when you

are done modifying the shape. 
 
N
filling path defines the stitch directions. 

 

 

I-Cliqq User Manual 314 



 
 
 
Note: Stitch Filling Path must intersect or be located inside the main 
boundary path, or the stitches will not be generated. 
 

 
   Incorrect    Correct 

 
To change single curved tatami fill parameters 
 
Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Tatami  tab page  to see tatami parameters. 
Change the parameters and click Apply or OK to apply the changes. 
 
Note: Single curved tatami fill is actually a tatami object but the Single 
curved Filled option is selected.  Pattern parameters will not affect this 
object, but you may change other parameters like Density and Stitch 
Length. 
 
Note: Single curved tatami fill object will run from the edges to fill the 
area. 
 
Tip: If the Stitch Filling Path is a line, then the stitches method will be 
similar to normal tatami, but travel run will be from the edges. 
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Digitizing dual curved tatami fill 
 

 Dual curved tatami fill is used to digitize filled shapes with varying 
stitch filling paths. Digitizing method and parameters are same as tatami. 
 

 
 
Note: Unlike tatami, in dual curved tatami fill, the stitches are not 
generated while you are digitizing the main boundary path. You have to 
draw two paths (which are not closed ones) as stitch flow paths, then the 
stitches will be generated. You can not apply patterns to this type of 
object.  
 
To digitize dual curved tatami fill 
 

1.  Click Dual Curved Tatami Fill (Edit & Digitizing Toolbar) 
 

2. Draw main boundary path on design working area. 
 

3. Pressx   and 2 curves  will automatically be generated. 
You can edit these in Outline Edit Mode. 

 
 
 
Note: Tatami angle will not work on this object because the stitch 
filling path defines the stitch directions. 
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                                  First stitch flow path     Second stitch flow path 
 
Note: Stitch Flow Paths must be located outside the main boundary path, 
or the stitches may not be generated correctly. 
 

 
Correct          Incorrect        Incorrect 

 
 
Note: Dual curved tatami fill object will run from the edges to fill the 
area. 
 
 
Note: Dual curved tatami fill is actually a tatami object but the Dual 
Curved Filled option is selected.  Pattern parameters will not affect this 
object, but you may change other parameters like Density and Stitch 
Length. 
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Digitizing motifs 
 

 Motif is used to digitize filled shapes with motif patterns. Digitizing 
method is the same as a single path object, but the path is closed by 
default. Boundaries in motif objects should not overlap or intersect each 
other. A boundary should not overlap itself and should not have a second 
boundary inside (a hole inside a hole), but holes can overlap or intersect 
each other. 
 

 
 
The motif stitches are generated instantly as you are digitizing a shape 
and stitch generation result may vary before you finish because the path is 
automatically closed and boundaries may intersect unintentionally. The 
best result will be obtained after you finish the main boundary outline. 
When you digitize a motif, it will have a default pattern which can be 
used for Chenille embroidery.  
 
I-Cliqq  provides three different motif fill styles. The combinations of 
effects you can create are really endless, and you can experiment by 
playing with parameters changes to see just how many variations are 
possible. Motifs are usually excellent to provide high cover, and low 
stitch count types of filling areas. You can astonish clients with your 
range, and even create your own motifs.  
 
Remember to always back up the system folders containing any 
custom creations, whether these are created fonts, motifs, 
templates or user profiles. In the event of a hard disk failure or 
computer failure, you can always copy your saved files back to 
the system folders. 
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• Symmetrical motif fill, this style is a new motif fill which fills an 
area symmetrically. 

 

 
 

• Running motif fill, this style is a new motif fill which fills an area 
with a special run stitch formula. 
 

 
 

• Normal motif fill, this style uses a pattern to fill an area. 
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To create onscreen motifs 
 

1.  Click Motif (Edit & Digitizing Toolbar) or press q M 
 

2. Draw main boundary path on design working area. 
 

3. Press e to draw sub paths (holes). Repeat this step for more 
sub paths. 
 
Tip: You can add or remove sub paths whenever you want.  

o Click  (Property Toolbar) to enable adding 
sub paths to the object, after adding the first sub path, 

press e or click  again to start adding 
more sub paths.  

o To remove a sub path, double click on a sub path’s node 
(to select all the nodes of the path) and press m. 
 

4. Press x or *, to define entry / exit points and fill angle 
and press x or s to finish. 
 
 
     Entry / Exit points 
 
                                    Fill angle 
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To change entry / exit points 
 

o Rest the point on entry or exit symbol. 
o Click and drag the symbol to desired point. 
o Release mouse button. 

 
Note: If you place the entry or exit point out of stitch 
area, the start or end point will be located on the nearest 
point to the entry and exit symbols. 
 
Note: Entry and exit points will be only calculated on the 
main boundary path. 
 

To change fill angle 
 
o Rest the point on rotate symbol. 
o Click and drag to define fill angle 

 
Tip: You can also define the fill angle from Property 
Toolbar (  ) or Properties Dialog (  ) 
 

o Press x or s to finished 
 

 
Note: If you place the entry or exit point out of stitch area, the 
start or end point will be located on the nearest point to the entry 
and exit symbols. 
 
Tip:  If you discontinue digitizing a motif by pressing s or by 
running another command, the entry and exit points will be 
placed on the beginning of the main path and fill angle will set to 
horizontal direction. You can change entry and exit point by 
pressing * whenever you want. 
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To change motif parameters 
 

 Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Motif  to see motif parameters. Change the 
parameters and click Apply or OK to apply the changes. 
 

Size parameters 
 

 
Click on pattern icon, Select Motif Pattern will open. Click on a pattern to 
select it or press s to close the dialog without any selection. 
 
Note: some parameters may be disabled according to the pattern type 
(symmetrical, running, and normal pattern). Pattern type name is written 
bellow each pattern. 
 
Note: when you choose a pattern, you will see the parameters of other 
objects may display on Properties dialog. This means the pattern includes 
those objects and you can control the parameters of them as well. For 
example if the pattern includes a satin, Satin parameters page would be 
available and you can change the satin parameters inside the pattern. 
 

 
 
 

 
 
Tip: you can press * to change Pattern Size, Pattern Displacement and 
Row Displacement values, visually on screen. You can also change fill 
angle and entry / exit point at the same time. 
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Press * to change pattern size,  
pattern displacement, fill angle 

and entry / exit points on screen 
 

Effect parameters 
 
 

 
This option can be used when there are long gaps between patterns 

 
 

 
 

Tip: Press * to edit globe effect visually on screen. 
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Click on any globe edit points and drag it to a desired point 
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Multi Color parameters 
 

 
 
 

 
You can force the software to generate the stitches for all colors or  

every individual color on multi color patterns 
 

 
 

Click Create Separate Objects to create individual objects for every color, this 
helps you reduce the color numbers in a design by reordering objects by color. 
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Digitizing sequin fill using motif tool 
 

I-Cliqq can create sequin fill using motif. It can apply different sequin 
diameters and locks to sequins. You can create fascinating effects, but 
note that not all motifs effects suit sequin fills. You can experiment with 
settings, to create practical sequin fill effects. 

 

 
 

To digitize sequin fill 
• Digitize a motif . 
• Select  Properties to open motif properties dialog.  
• Select Motif on the Main Properties sidebar to see motif 

parameters 
• Select Pattern to open Motif Pattern dialog and select ‘Sequin’ 

pattern 
 

 
 
• Select Sequin tab-page to set Pattern displacement parameters 

correctly.  
 
Note: These values should be set according to sequin diameters 
and your desired vertical and horizontal distances. the default 
sequin diameter is 5mm, so it is better to set the horizontal and 
vertical pattern displacement values to a value higher than 
2.5mm, if you use default sequin diameter. If these values are set 
to a lower value, then the program will assume the minimum 
valid values. 
 

• Press Apply to see the result. 
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To change sequin parameters 
 

Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Motif on left list box to see motif 
parameters. Select Sequin tab-page and change the parameters and click 
Apply or OK to apply the changes. 
 

 
If you change the sequin diameter, you should change pattern horizontal 
and vertical displacement values on Size tab-page, as well. If horizontal 
and vertical displacement values are not set correctly, then I-Cliqq will 
calculate the first possible valid values for the selected sequin diameter. 
 
Exercise some caution when applying sequin parameter changes.The 
results are guides by the size/shape of sequins. 
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You can also apply Warp effect to sequins on a motif. To do so, select 
Effect tab-page and select Warp in or Warp Out effect. 
 

 
Warp out effect 

 

 
Warp in effect 

 
Note: Sequins will never be hit by other stitches or sequins where 
they become dense if you have created a practical sequin pattern. 
Some degree of design planning is necessary in creating sequin 
designs ,and  resizing sequin designs may need to be done with 
some consideration, depending on the content. 
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Digitizing spiral fill 
 

 Spiral fill is used to digitize filled shapes spiral running stitch. 
Digitizing method is same as a single path object, but the path is closed 
by default. The boundary of a spiral fill object should not overlap or 
intersect itself. 

 
 
The spiral stitches are generated instantly as you are digitizing a shape 
and stitch generation result may vary before you finish because the path is 
automatically closed and boundary may intersect itself unintentionally. 
The best result will be obtained after you finish the boundary path. 
 
Note: Spiral fill may not generate your desired result if the boundary path 
is complicated. In this case try simplifying the path. 
 
To digitize spiral fill 
 

1.  Click Spiral Fill (Edit & Digitizing Toolbar) 
 

2. Draw an outline  boundary path on the design working area. 
 
 

To change tatami parameters 
 

Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Spiral Fill on left list box to see spiral fill 
parameters. Change the parameters and click Apply or OK to apply the 
changes. 
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Density 

 

 
      Start   Finish         Start 
 
          Running Length 

 
       Running Repeats (Bean)   Running Repeats (Running) 
 
 

 
Stitch point displacement (0.4mm) (repeats = 5) 
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Digitizing satin fill 
 

 Satin Fill is used to digitize filled shapes with varying satin stitch 
angles. Digitizing method is same as a single path object, but the path is 
closed by default. Boundary in satin fill object should not overlap or 
intersect itself. The parameters of satin fill are the same as dual path satin 
and you can apply all the stitch effects (double divided, multi divided, 
jagged, break lines, E style, with patterns and random fill) to this object.  
 
Satin fill stitches are generated instantly as you are digitizing a shape and 
stitch generation result may vary before you finish because the path is 
automatically closed and boundaries may intersect unintentionally. The 
best result will be obtained after you finish the main boundary path. 
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To digitize satin fill 
 

1.  Click Satin Fill (Edit & Digitizing Toolbar)  
 

2. Draw boundary path on design working area. 
 

    
 

3. Press x to define stitch angles.  
 

4. Click to define stitch angles.  
 
Note: One click is enough for one stitch angle. A line with a hot 
point at one end will be placed wherever you click. This line 
defines the stitch angle. Former stitch angle will be modified as 
you click to create a new stitch angle. 
 

 
You should consider the following points when defining the stitch 
angles: 

• The first stitch angle should be placed out of boundary 
path where you want to start 

• The medial stitch angles should be inside the boundary 
path 
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• The last stitch angle should be outside the boundary, or 
slightly  inside at a point where you prefer a stitch ‘cut 
off’ . Digitizers make such allowances when creating 
objects to be outlined. 

 
Note: Click on hot points at the end and middle of stitch angle 
lines and drag them to change the fill angle and line. 
 
      Hot points   Stitch line 
 

 
 
Note: You can edit stitch angles and lines whenever you want. 
Select the object and press *. 
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To edit stitch angles and line 
• Rest the point on a hot point, the pointer shape will 

changes to  
• Click and drag it to your desired point 
• Release the mouse button. 

 
Tip: Press y or n to remove the last stitch angles. 
You can also right click on a hot point of stitch line, and remove 
or add insert a new hot point. 
     New stitch angle added here 
 

 
 

5. Press x or s, to finish 
 
Entry/Exit points default to the first/last stitch. 
 
To change entry / exit points 

• Rest the pointer on entry or exit symbol. 
• Click and drag the symbol to desired point. 
• Release mouse button. 
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To change satin fill parameters 
 

Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Satin on left list box to see Satin parameters. 
Change the parameters and click Apply or OK to apply the changes. 
 
The parameters of satin fill are same as satin.  
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Digitizing star (circular), star (rectangular) 
 

 ,  Star is used to digitize circular and rectangular stars.  
 

 
    Star (circular)        Star (rectangular) 
 
 
To digitize star 
 

1.   Click Star (Circular) or Star (Rectangular) (Edit & 
Digitizing Toolbar)  
 

2. Rest the pointer on desired point in design working area. 
 

3. Click and drag a box and release mouse button. 
 

    
Tip: You can repeat this step to create more stars , or  you can edit 
the created star. 
 
Tip: Hold down a while dragging (before releasing mouse 
button) for proportional resizing. 
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4. Tip: Hold down q while dragging (before releasing mouse 
button) to resize the dragging box by its center 
 

       
 
you can also use the combination of q and a. 
 

5. Press x or s to finish. 
 

To change star parameters 
 

Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select Star Stitch on left list box to see star stitch 
parameters. Change the parameters and click Apply or OK to apply the 
changes. 

 
 

 
 

 
Star type effect 

 
 
 
 

 
                Circular and Rectangular                Corner effect 
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Star Repeats 

 
 

 
Repeat Pitch 

 
 

 
Return Back only works on Forward/Backward type 

 
 

 
Start Angle 
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Using shapes when digitizing 
 

 You can use shapes when digitizing a path. There are 
some tools to let you draw vector outlines but you can also create your 
own shapes and use them when digitizing. 

 
 

To use shape tools, you should select a digitizing tool first (like Running, 
Satin Tatami, …) then you can use shapes. You can use shapes with every 
digitizing tool (single, dual and closed paths). If you select shape tools 
before selecting a digitizing tool, it will activate the last digitizing tool 
you used.  
 
You can also use shapes to add sub paths to objects. In this case, you 

should select the object, then click  and select a shape tool. 
 
 

Rectangle, ellipse and triangle shapes tools 
 

 
 

1. Select a digitizing tool 
 

2. , ,  Select one of Rectangle, Ellipse or Triangle tools (Edit & 
Digitizing Toolbar). 
 

3. Rest the pointer on a desired point on design working area. 
 

4. Click and drag a box and release mouse button. Press x or 
s to finish. 
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Tip: Shape tool will remain active and you can repeat this step to create 
more objects; meanwhile you can edit the created object. 

 
Tip: Hold down a while dragging (before releasing mouse button) for 
proportional resizing. 
 

        
 
Tip: Hold down q while dragging (before releasing mouse button) to 
resize the dragging box by its center 
 

        
 
You can also use the combination of q and a. 
 
Tip: If you have selected a dual path object like Satin, then you can create 
a ring, by holding down v, before clicking the first point, after 
clicking, you can release v key.  

 
Creating rings by holding down v key 
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You can also control the width of a ring and rotation angle of shapes. 
When you use shapes, the following tools will be available on Property 
Toolbar. 
 

• To change the width, click on track bar and scroll it. 
• To change the rotation angle, Click on rotate edit box and enter 

new angle and press e, then try to draw a new shape. The 
new rotation angle will be applied to new shapes. 
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Rounded rectangle shape tool 
 

 
 

1. Select a digitizing tool. 
 

2.  Select Rounded Rect tool. 
 

3. Rest the pointer on a desired point in the  design working area. 
 

4. Click and drag a box and release mouse button. 
 

5. Move the pointer and click to define the radius. 
 

 
 

Note: You can use all the tips and methods mentioned for Rectangle 
shape. 
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Star shape tool 
 

 
 
 
 

1. Select a digitizing tool. 
 

2.  Select Star tool. 
 

3. Rest the pointer on a desired point in design working area. 
 

4. Click and drag a box , then release the mouse button. Star shape tool 
will remain active and you can repeat this step to create more objects; 
meanwhile you can edit the created object. 

5.  

 
 

6. Press x or s to finish. 
 

Note: You can use all the tips and methods mentioned for Rectangle 
shape. If you select a dual path object (like satin), the start will be created 
in ring form and holding down v will have no effect. 
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You can also control the width of a ring and rotation angle of shapes. 
When you use shapes, the following tools will be available on Property 
Toolbar. 

• To change the width, click on track bar and scroll it. 
• To change the rotation angle, star corners and sharpness, Click on 

their edit boxes and enter new value and press e, then try to 
draw a new star. New values will be applied to new shapes. 
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User defined shape tool 
 

 You can use predefined shapes or you can create your own shapes and 
use them when digitizing. 

 

 
 
Creating objects using shapes 
 

1. Select a digitizing tool. 
 

2.  Select User Shape tool. 
If you open the shape panel and select the User Shape tool, then Select 
shape dialog will open. Move the pointer over a shape and click to 
select it. 
 

 
 
Once you select a shape, the shape tool will change to , if you click 
on this icon, the last selected user shape will be used. The view dialog 
box is resizeable, so you can see a minimum or more shapes. You can 
use the slidebar, or resize the dialog box. 
 

 
3. Rest the pointer on a desired point in design working area. 
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4. Click and drag a box and release mouse button. User shape tool will 
remain active and you can repeat this step to create more objects;  
 

5. Press x or s to finish. 
 

 
 

Note: You can use all the tips and methods mentioned for Rectangle 
shape. 
 

Adding sub paths ( internal outlines) using shapes 
 

You can use shapes to add sub paths to objects. Adding sub paths to 
shapes is same as creating embroidery objects using shapes, but this time 
it will add sub paths(outlines) to the selected object. 
 
You can use this method  

• While you are digitizing an object and you want to digitize a sub 
path: 

• You have selected an object and you want to digitize a sub path, 

in this case, select the object and click  then try 
adding shapes as sub paths. 
 

 

I-Cliqq User Manual 346 



Create a new user shape 
 

Create custom shapes or borders for use anytime. 
 
To create a shape 
 

1. Digitize an object. It can be a single, dual or a closed path object. 
 

 
 

2. Select the object by Object edit Tool. You can only select one 
object every time you want to create a shape. 
 

3. Right click over the object to open a flyout menu, and select Set 
As…> Shape 
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4. Enter a name for the shape and click Save 
 

 
 
 

Now you can use this shape to create different objects. If you create a 
shape from a single or closed path object, you will see (Single Path) title 
in front of the shape name. And if you create a shape from a dual path 
object, you will see the title (Dual Path). 
 

 
 
  

Shapes provide you with a quick and easy means to creating objects 
using a variety of stitchtypes. You can use the simple features of 
copy/paste and duplicate to create copies,and change the stitchtypes 
to quickly make up a shaped design. Eg, you may use a shield shape.  
Convert that to tatami. Then duplicate it with 0/0 x/y settings, and 
convert it to an outline satin..and in a few clicks you have a filled 
shield + satin border.
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Creating appliqué  
 
I-Cliqq provides an automatic appliqué creation method and creates 
all the stitches you need for appliqué embroidery. All you need to do is to 
digitize the appliqué outline. You can add a texture bitmap for appliqué 
object to have a realistic 3d View. 
 
To create appliqué  
 

1. Digitize the outline with a running object. Use Auto Close to 
close the outline automatically. Digitize the bounding object from 
the outer edge. You can also tap ‘a’ on your keyboard to 
autoclose. 

 
2. Draw holes inside the main outline, with separate running objects. 

Use Auto Close to close the holes as well. Digitize holes from the 
inner edge. 

 
3. Select all running objects you have digitized, with Object Edit 

Tool. 
 

4. Select Tools > Create Appliqué Objects, Appliqué dialog will 
open. 
 

5. Set the parameters and special functions for before and after 
holding appliqué and select Apply. 
 
Note: Select Undo if you wish to recreate objects.  
 
Tip: You can modify your selection while the Appliqué dialog 
is open. 
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Special functions before holding the appliqué  
    Special functions after holding the appliqué  
 

 
Appliqué dialog 

 
  

To change appliqué parameters 
 
Tip: To edit the paths of appliqué objects using Node Edit Tool. Hold 
down q key, for intelligent node edit. This will modify all the nodes 
of the other appliqué objects or, these can be edited individually. 
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Frame Out: 
 
If you wish you apply a frame out factor you can enter a value in the 
Frame Out factor regarding the X or Y offset. 
 
Most machines now do this automatically. 

Tip: You can apply a texture to the base appliqué running objects.  
 

 
 

Texture mapping on appliqué objects 
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Object’s entry / exit points 
 

Properties dialog box contains a page captioned Entry-Exit. This page will 
display when the object supports entry and exit points. Normally when 
you digitize an object, the first stitch is located on first node and last stitch 
is located  on last node. You can change enty and exit points by pressing 
* .The entry and exit symbols will appear on the object and you can 
change their location. Parameters on Entry-Exit page of Properties dialog 
lets you set the location of these points on original place or you can place  
the exit point on the entry point, it means object will finish where it has 
been started. 
 

 
Press *            Change entry-exit points on screen 

 
To change entry exit point parameters  

Click Properties (Standard Toolbar) or press a e to open 
properties dialog box. Select related pages to see the objects parameters. 
Change the parameters and click Apply or OK to apply the changes. 
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Changing Entry-Exit parameters 

 
 

Underlay 
 
Click Underlay  to activate default underlay on selected objects. The 
icon will remain in down state as long as it is active and underlay will be 
applied to new digitized objects unless you click on it again to deactivate 
it and set it to normal up state. Underlay will be applied by default values. 
You can change the underlay parameters from Properties dialog. 
 

 
In its default status, clicking the tick off/on will apply the default underlay 
you have set up. If you think you need to constantly be changing these, 
you can expand and dock the Underlay Toolbar. 
 

 
You can now drag and dock the underlay toolbar anywhere you feel is 
convenient. Right Clicking any of the underlay types will open those 
properties for you to adjust instantly. The underlay toolbar can dock 
vertically or horizontally. 
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To change underlay settings of the selected object 
 

Click Properties (Standard Toolbar)  - This shows you the composite 
parameters of any underlay type. Simply Right Click any icon on the 
Underlay toolbar, and its related properties display in the Properties 
Dialog. 
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Note: you can apply a combination of underlay types at once. 
 
 
Change Underlay Zigzag Repeats to repeat satin underlay stitches up to 
four times. 
 
 
Change Underlay Run Repeats to repeat running underlay stitches up to 
four times. 
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Underlay satin width effect 

 
 

 

 
 
 

If you create a tatami object, the underlay styles relating to that will highlight.
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Effects 
 

Effects page of the Properties dialog box provides some parameters 
allowing more control of stitch generation methods on different objects. 
You can control offset fraction on dual curve objects, pull compensation, 
automatic shortening stitches on corners and graduated density. The 
tabbed pages allow speedy checking of any object parameters. As soon as 
you select an object, its parameters will highlight in the sidebar 
properties. Where there are more associated properties, you may have to 
click the associated tabs. 
 

 
 
 

 
 

Offset fraction controls the density at corners 
 

 
 

Pull compensation 
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Shortening stitch count at corners 

 

 
Shortening depth  

 
 

 
 

            Max density 
 

        Min density 
Graduated density 

 
Note: Graduated density will effect on satin, non-parallel tatami, single curved 
and dual curved tatami fill, tatami and trapunto. This is also active on Lettering 
depending on specific effects you might like to create. 
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Graduated density on single curved tatami fill 

 

 
Graduated density on dual curved tatami fill 

 
Tip: You can use this effect to create color blending effects. 
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Graduated Density active on a Normal Tatami Object. 
 

Although this effect is possible on a few types, it is best used, where no under 
running stitches are showing. To create good blends, you need to generally have 
‘uninterrupted’ stitch areas. 
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Trapunto Effect 
This style is exactly the same as normal tatami, and digitizing the shapes is 
exactly the same. Trapunto style comes from an age-old quilting effect that 
leaves ‘uninterrupted’ embroidery area, with travel runs restricted to the edges. 
Trapunto in I-Cliqq supports pattern effects, so if you require light density fill 
areas, with some pattern effects, and no under runs, Trapunto is for you. 
 
Trapunto is also a ‘stitch type’ so you can select it from the toolbar, and you are 
instantly in Trapunto stitch mode. 
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Trapunto effect with a hole added.  

Random Fills and SPLIT FX 
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In the general tab – you’ll see the I-Cliqq Stitch FX capability, that 
allows you to automatically determine at which length an effect will 
‘kick in’. So, eg lets say you created a satin or fill shape of varying 
widths, but you only want the desired effect active when the column 
is wider…all you do is specify that factor. 
By default, Stitch FX is set at 3mm, so if you make a tatami shape 
like below, and enable Stitch FX, you will see the tapered parts in 
satin, in that tatami.  
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Here, you see Stitch FX active at 3mm, so areas below 3mm will be 

satin, and wider than that will be the chosen stitchtype. In this 
example, its satin. You can match the tatami stitch length, and the 

Stitch FX length to create a seamless transition effect. 
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 Under the FX tab page, you will find ‘Graduated Density’. This is 
an example of Graduated Density + Tatami+ Stitch FX ‘on’at 3mm . 

 

 
 

These are examples of exactly the same shape creation, with 
different combinations of effects applied.  

 
 
 
 
 
 

When an object is selected, you see the basic parameters in the 
Properties Box, and also other tab pages containing effects and 
parameters that can be applied. Since the variations are numerous , 
the only way to really explore is by creating a shape, selecting it, 
then practicing how you can create multiple effects. Your 
permutations of possible effects are really numerous, meaning that 
you can engineer in minutes, what competitors may take hours to 
create only by creating various object segments. This is helpful when 
creating fur effects, special types of blends , and seamless 
transitioning between differing but similar stitch types. 
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These are examples of Split FX on different satin objects. 

 
Split FX may be deemed as another aspect of ‘USER SPLIT’, because 
it automatically splits stitching, so when USER SPLIT is applied , Split 
FX will not apply on those objects. 

 

 
 

Varying the Minimum and Maximum  lengths will give you different 
‘random’effects. 
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Random Seed is generally for use when you have jagged effects 
applied, but will also effect on a normal object. You can select an 
object with Random Fill, and change the Random Seed value. It can 
also be referred to as ‘ceed’ , and sometimes you may even see 
Tatami referred to as ‘Fill’ or ‘Ceeding’stitches.  Terminology that 
describes stitchtypes can vary. 
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Just a note* 
There is NO specific underlay RULE for applying underlay on fabrics. 
Exactly the same fabric type may require no underlay/some 
strategically placed underlay / a combination of underlay or overall 
underlay on specific stitchtypes . This is all relative to ‘EACH DESIGN’ 
. Simple things like the thread type/stabilizer type /stitch direction 
and even the actual fabric weft/wove in relation to stitch direction 
determine what may be necessary, so when you see any software 
claim to ‘automatically determine what is ‘correct’ for different 
fabrics, this is an overall ‘misconception’. 
Yes, it is possible to give a ‘guide’ to what may be practical, but this 
should never be read as ‘the rule’. 
I-Cliqq allows you to create and name ‘Design Templates’ tailored to 
your own specifications. Another aspect determining what may be 
necessary is the type of machine  ( commercial or industrial) , and 
also the age/wear on machinery. Even ‘refurbished’ machinery can 
never stitch like a new machine would. Add to this hooping 
mannerisms, and machine speeds. These also affect the outcome of 
designs, and influence underlay. For the most part, stabilizers today 
are very ‘scientific’ in their creation. Your mission, should always be 
to produce the most effective running design, with the absolute 
minimum of stitches, after all ‘Time is money’ , and you really don’t 
want to be stitching thousands of extra stitches, for no practical 
reason. 
Even the home based business, should strive for optimum running 
designs. 
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Inserting Objects 
 
Inserting objects is quite simple in I-Cliqq. You can perform such tasks in various 
ways. 
 

 
 
If Insert Mode is OFF, any pasted objects will just be added to the 
end of a design. 
 

 
 
If Insert Mode is ON , you can just travel to any point in the design, 
and pasted objects will be inserted between objects. 
 
 
 
 
 
 
Some prefer to avoid ‘branching’ as they like to keep all objects 
uncompromised for different reasons. Personally , designs do require 
‘planning’ for future edits that may be performed. You can also create 
designs in ways that allow you to edit very fast later. Since branching 
is a way of sequencing too, its good to touch on that. I-Cliqq provides 
some ways to achieve this with relative simplicity. Inserts allow you 
the capability to restructure your design sequences in optimum ways, 
leaving you with the ability to select and modify objects. This means 
you can treat all objects individually, or as groups as if you had 
created them in that exact sequence. If you don’t like a way a certain 
set of objects run, you can modify that. All you need to be aware of, 
is where the start/end of objects are, so that you don’t get 
unnecessary jumps. If you do get such jumps, you can always modify 
the entry/exit points of objects to achieve your aims. 
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By using the method below, you have the appearance of branching, 
your created objects are inserted, but you can handle them as 
separate objects. You can also just delete any from the sequence. 
 
Insert Individual Selected to First Object 
 

 
Just to demonstrate , I used different colors to denote the 3 created 
objects. This operation is performed on single color objects of the 
same color to provide a continuous ‘sequence’. 
 
1-We are going to ‘insert’ objects 2, and 3  in object 1. As you can 
see, the additional objects have jumps, so before initiating this 
feature, you just need to make sure the entry/exit points on the 
objects to be inserted, are closest to the base object (1) . 
 
2-The first object you select, is designated as the base/target 
object, and additional objects are ‘the objects to be inserted’. 
 
3-Select Object #1, then hold down SHIFT , and add Object #2 and 
#3 to the selection by clicking each object. 
 

4-    
Once you select the objects, all you need to do is click the icon , or 
press SHIFT+I. 
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Move the entry /exit points close to the target object. 

 
 
Select Objects ( remember that the first object selected is the target 
object) 
The order that you select other objects in, after object #1 is 
unimportant. 
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Once  you have selected the objects, press the icon, to insert the 
selected objects to #1. 

 
Your task is complete. If you travel on the creation, you will find the 
objects now inserted, or nested in object #1. 
 

 
 
The procedure for inserting a single or multiple objects to the base 
object is the same. 
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An example of multiple inserts. All you need to do is select the target 
object, and objects to be inserted, and press ‘I’ .  
 
Ordinarily, you can really just change sequences by using the color 
manager, or object manager, but these prescribed procedures can be 
implemented if you need to do more advanced edits. 
 
 
 
 
 
 
 
 
 
Inserting at a specific stitch point: 
 
 
 

 
Lets say you decided to add the above selected creation into your 
sequence : 
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Lets say the above point is where you would like to insert that object. 
( Practically, you should make sure the object to be inserted starts, 
and ends closest to the target object. 

 
Select the objects, and simply press ‘I’ . 
 

 
The object is inserted seamlessly in the sequence, and if you travel in 
that sequence to check it, the new object set is now nested . 
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Chapter 7 
 
Manipulating outlines/paths 

 
In this chapter you will learn various ways to select and modify the 
outlines of objects in an embroidery design. The Outline Edit Tool will 
help you easily edit object outlines. You can join two objects to make one 
object. You can split the path of an object and make two separate objects. 
It is possible to cut, copy outlines from one objects and paste them into 
another object. You can resize or rotate a part of a path. 
 
I-Cliqq provides simple and efficient outline editing capabilities. 
 

Stitch Refresh Modes 
 

The default refresh mode is ‘Always Refresh’ – ON. 
 

 
 
Stitch > Always refresh or press v e.  
When I-Cliqq restarts, the last used mode will be active. 
You can switch these modes at any time. Always refresh- OFF, means 
that stitches will not display instantly, and if you create an object the 
stitches will generate once the object is complete. This mode may suit 
digitizers who enjoy seeing just the outline creation first. 
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Outline edit tool 
 

 Click Outline Edit Tool (Edit & Digitizing Toolbar) or  
press v 1. 
 
Outline Edit Tool will let you edit the outlines or  nodes. You can also 
add sub paths to objects or remove a sub path when this tool is active. 
When the pointer shape is same as this shape  , it means that Outline 
Edit Tool is active. 
 
 

Selecting an object with the Outline Edit tool 
 

 Select Outline Edit Tool and rest the pointer on the outline of an 
object and click to select it. When the object is selected the nodes will 
display. Depending on the outline mode , you may see circles, squares or 
triangles.

 
 
Tip: You can travel on objects:  forward by pressing t and  
backward by pressing q t.  
 

Selecting nodes of a path 
 

You can edit a path by editing the nodes and their control points. To 
select a node: (select an object with path edit tool first) 
 
• Rest the pointer over a node (the pointer’s shape will change to ) 

 
• Double click on a node to select all the nodes on an outline. 
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Click on a blank area and draw a window and release the mouse 
button. 
The nodes inside the window will be selected. 
 
Tip: If you hold down q, the nodes will be added to the 
previous node selection set. And if a node is already selected, it will 
be deselected. 

 

 
 

• Hold down v and click on a blank area to start lasso node 
select.  
 

o Hold down v  
o Click on a blank area (you can release v after the first 

click) 
o Click to define the selecting boundary 
o Double click to finish 

 
Tip: You can hold down q before double click to add or 
remove selected nodes  
 

 
 

• Press s to deselect all selected nodes. 

I-Cliqq User Manual 377 



 
 
 
 
 
 
Moving nodes 

 
1.  Click on the Outline Edit Tool 
2. Rest the pointer on the outline of the object and click to select it 
3. Select the nodes you want to move 
4. Click on the selected node and drag it to the desired location and 

release mouse button. 
 

 
Double click on a node to select all nodes on that outline then you can move it 
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Editing nodes 
 

When Outline Edit Tool is selected, some icons will be available on the 
Property Toolbar to help you in editing nodes. These pertain to Bezier 
Mode. 
 

 
 

•  Click Add node to curve to add a node before the selected node. 
 

 
 
Tip: you can add nodes by double clicking on an outline section 
where there is no node. Rest the pointer on the section where you 
want to add a node, and the  pointer shape will change to  - then 
double click. A node will be created at that location on the outline. If 
the object is a dual path, a node will be also be added to the other side 
automatically. 

 
 

•  Click Remove selected node(s) to remove selected nodes. You can 
press y or n as a shortcut. 
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•  Click Convert curve to line to convert selected curves to line. You 
can press q 1 as a shortcut. 

 

 
•  Click Make node a cusp to change the node property to cusp. You 

can press 1 as a shortcut. 
 
A cusp node means the handles can have different directions, so the 
node can create a sharp corner. After making a node cusp, you can 
click on the node’s handle and drag it to create your desired path and 
release the mouse button. 
 

 
•  Click Make node smooth to change the property of the node to 

smooth. You can press 2 as a shortcut. 
A smooth node means the handles are in the same direction, but they can 
have different lengths, this is useful where a small curve is supposed to 
follow a large curve. 
 

 
 
Tip: You can press 2 while you are dragging the handle, this helps 
you to speed up digitizing, but clicking on , requires releasing the 
mouse button and this means interrupting the drawing procedure. We 
suggest you use the shortcut method. 
 
Tip: You can hold down a while dragging the handle, this helps 
you to keep the direction of handle constant, so the former curve will 
not change. 
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•  Click Make node symmetrical to change the property of the node 

to symmetrical. You can press 3 as a shortcut. 
 
Symmetrical means the controls points of former and current curve 
will be in same direction with same lengths. This is the default node 
type when you are digitizing a path. 

    
Converting a node into symmetrical 

 
•  Click Remove Right Handle to set the length of the right handle to 

zero. 

 
 

• Click Remove Left Handle to set the length of the left handle to zero. 
 

    
 

•  Click Size Selected Nodes to resize a part of the path. At least two 
nodes should be selected. 
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Sizing handles will display around the selected nodes. Click on sizing 
handles and drag them to resize selected nodes. 

 

 
 

 
 

Tip: When resizing, you can hold down 
o q to resize by center 
o a for non proportional resizing 
o v for resizing by …, ¼  , ½ , 2 , 4 , … times 
You can use the combination of the keys, as well. 
 
 

•  Click Rotate selected nodes to rotate or skew a part of the path. At 
least two nodes should be selected. 
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Click on rotate center handle and drag it to your desired point and 
release mouse button. Click on rotating handles and drag them to 
rotate or skew nodes. 

 
 

•  Click Align selected nodes, Node Align dialog will open and you 
can align selected nodes horizontally and vertically. At least two 
nodes should be selected. 

 
 
•  Click Offset Selected Path to offset the path. Move the pointer to 

the desired location and click. 
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You can offset the path by value. Offset distance will be available on 
the Property Toolbar when you use this tool: 

 

       
 
To offset the path by value, Click on Displacement edit box and enter 
you desired value and press e. A negative (-) value will offset 
the path in the opposite direction. 
 
If the path is a single (running, …) or a closed curve (tatami, motif, 
…), the program will try to offset the best result for you by changing 
the node count. You can force the program to calculate the offset with 
same node count. 
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     Node count changes                             Node count does not change 
 

•  Click Auto close  to close an outline automatically. This 
option will only work on single path objects (running, …). 

 

   
 

 

•   Click Extend to continue digitizing an embroidery object. If 
an object was left unfinished or you need to continue digitizing it, you 
can use Extend. 

 

•  Click Add Outline to add a sub path to an embroidery 
object. This icon will be dimmed if the selected object cannot have a 
sub path. 

 
•  Click Select First Object, the first object will be selected. 

 
•  Click Select Last Object, the last object will be selected. 

 
•  You can make a left or right click on this icon for different 

purposes. 
o Left click on this icon, to select the previous object in order 

(press qt keys as shortcut). If there is any 
selected object, it will be deselected first and the object 
prior to the selection will be selected. And if there is no 
selected object, the last object will be selected. 

o Right click on this icon, to travel backward by color. 
 

•  You can make a left or right click on this icon for different 
purposes. 

o Left click on this icon, to select next object in order (press 
t key as shortcut). If there is any selected object, it 
will be deselected first and the object next to the selection 
will be selected. And if there is no selected object then the 
first object will be selected. 

 
o Right click on this icon, to travel forward by color 
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Editing the curvature of a path 
 

You can edit the curvature of a path visually on screen. To change the 
curve 
 

1. Rest the pointer over a curve, the pointer ( ) will change to  
 

2. Click on the curve and drag to change the curvature. 
3. Release mouse button when finished. 
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Cut, copy and paste outlines (paths) 
 
I-Cliqq can cut, copy and paste outlines from one object to another object.  
 
To cut, copy and paste paths from one object to other objects 
 

1.  Select the Outline Edit Tool 
 

2. Click on object’s outline to select it. 
 

3. If the object has more than one outline, double clicking a node on 
that outline will select all nodes of that outline. 

 
4. Click Cut or Copy (standard Toolbar) to cut or copy the selected 

outlines to the clipboard. 
 

 
5. Select the target object with Outline Edit Tool. The selected target 

object must support ‘sub paths’ or ‘internal outlines’ or paste will 
be disallowed. 

 
6. Click Paste: The selected outline is pasted. 

 
 

         Note: You can paste multiple copies of the outline/path from clipboard. 
 
 
 
Motif 
 
 
 
Tatami 
 
 
 
 
 
 
 

 
Pasting outlines  from one object into another 
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  Contour stitch 
 
 
 
Satin (break lines) 
 
 
 
 
 
 

Pasting paths of one object into another one as sub paths 
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Paste Options 
 

 
 

Tools>>Preferences>>General: 
 
Choose one of the 4 ‘Paste’ options. You may only have one preference  in 
general, but can change this setting at any time. 
 
‘Drag After Paste’ : Checking this option snaps the ‘paste’ to your cursor, 
allowing you to first float it, and position it where you prefer. This will basically 
override other options, but if you have this checked, pressing ESC when the 
object is snapped, will revert the paste to one of the 4 selected options. 

 
1 Initial Position : This pastes the object exactly in its original point of ‘copy’. 
2 Center at Current Stitch : This centers the object over the current stitch 
position. 
3- Start at Current Stitch : Paste initiates at the current stitch point. 
4- Shift Pasted Object : Changing the 2 values will offset the ‘paste’ respectively. 
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Extend Symmetrical 
 

You can extend outlines symmetrically in horizontal or vertical 
directions. You can use this method even while you are digitizing a path. 
 
To extend an outline symmetrically 
 

o Select Edit > Extend Symmetrical > Horizontal or press  
v - to extend the outline horizontally. 

 
o Select Edit > Extend Symmetrical > Vertical or press  

v + to extend the outline vertically 
 

 
 

o See video Clips for examples.
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Joining Outlines or Objects 
 

You can join the outlines of objects and make one object. You should use 
Object Edit Tool to select objects to be joined. A minimum of 2 objects 
needs to be selected. 
 
To join outlines or objects. 
 

1.  Click Object Edit Tool (Edit & Digitizing Toolbar) 
2. Select the initial objects you want to join 
3.  Click Join Selected Objects (General Toolbar), or press J 

 

 
 
 

 

I-Cliqq User Manual 391 



Split Outlines/Paths 
 

You can split an object’s outline from a node position.  
 

 
 

To split an outline 
 

1.  Select Outline Edit Tool. 
2. Click on object’s outline to select it. 
3. Select the node from which you want to split the object. 
4. Right click on the node, a popup menu will open 
5. Select Split From This Node. The object will be split into two objects. You 

can perform multiple splits by repeating the process. 
 
Note: closed outline/path objects eg. tatami cannot be split. 
 
Tip: If you want to split the object from a point where there is no node, you can 
add a node on your desired point and then split the path from that node. Double 
click any point on the outline while in Outline Edit mode. 
 

 
Cutting an object is a related feature. 
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Changing the start node on a closed outline/path. 
 

The first stitch  is always located on the first node by default. You can change the 
start node of a closed outline/path eg on a tatami object. 

 
To change the starting node 
 

1.  Select Outline Edit Tool 
 

2. Click on object’s outline  to select it. 
 

3. Select the node you want to set as start point. 
 

4. Right click, a popup menu will open 
5. Select Start From This Node. This option will be dimmed if the 

selected node is the first node. 
 

 
Change the start node 
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Reverse outline / path 
 

You can reverse the outline direction of an object . This swaps the 
first/last node position. You will find this useful when handling vectors, 
or just generally with satin columns, or runstitch sections. 
 
To reverse an outline/path . 
 

1.  or  Select Outline Edit Tool or Object Edit Tool 
 

2. Click to select the object. 
 

3.  Click Reverse Object(s) to reverse the outline. 
 

 
Reversing an outline while digitizing 

 
You can also reverse Vector Outline directions. 
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Swap Outlines 
 

The outlines of a dual path object eg satin can be swapped. 
 

 
 
 
 

 
 
 
The image above shows you the exact same object, with the outlines swapped. 
Select the object , and press ALT+F12. 
Swapping outlines automatically repositions the start /end points.  
 
Since you can drag entry/exit points at will ( Press F8 to edit entry/exit 
points) , you may have no real reason to use this feature, but it can be 
effected at any time necessary.

I-Cliqq User Manual 395 



To swap outlines/paths. 
 

1.  or  Select Outline Edit Tool or Object Edit Tool 
 

2. Click to select the object. 
 

3. Select Path > Swap Paths or press a +. 
 

The outline edit and object edit tools form the basis of outline/object selection 
throughout the software use. These same tools are found in popular graphics 
software, so have a universal similarity. 
 
Offset copy 
 

Offset copy will copy the object and lets you offset the path. The result 
will be creating another object outline,  parallel to the first one. 
 

 
Offset copy 

 
 
 
To create an ‘offset copy’ object 
 

1.  or  Select Outline Edit Tool or Object Edit Tool 
2. Click to select the source object. 
3. Select Edit > Offset Copy. 
4. Move the pointer to desired location and click. 

 

 
 

Note: If the selected object is a dual path object, both outlines will be 
offset. If you double clicked a node on one side of the object, while in 
Outline Edit mode, only that outline will be offset. 
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 Offset the outline by ‘value’. 
 
Offset distance will be available on the Property Toolbar when you use 
this tool: 
 

 
 

To offset the path by value, Click on the Displacement edit box and enter 
your desired value and press e. A negative(-) value will offset the 
outline in the opposite direction. 
 
If the outline  is a single (running, …) or a closed curve (tatami, motif, 
…), the program will try to offset the best outline  for you by changing 
the node count. You can force the program to calculate the offset with 
same node count. 
 

 
 

   
        Node count changes                  Node count does not change 
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‘Offset Selected Path’ Using the CTRL key.  
 
Select an object using the Outline Edit Tool. 
 

 
 

Offset Selected Path, and Offset Copy are similar , but slightly different 
features. Experiment with the effects on simple objects to notice the 
similarities. Once you have selected an object using outline edit, you’ll 
see the icon highlighted for use. 

 

 
 

Holding down the Ctrl key, while performing an offset, gives you a vector 
outline offset, when you click. You can perform multiple offsets by holding 
down Ctrl, and clicking different offset positions. Press ESC to end offsetting 
outlines. 
 This is useful, if just creating guides, or if creating a text baseline. I-Cliqq 
allows you to convert any vector to a text baseline. Experimenting with results 
will allow you to find numerous uses. 
 
 
 
 

I-Cliqq User Manual 398 



 
 
An example: If you click the shown icon on the Text Toolbar, while you have 
an offset vector selected, it creates a text baseline.  
 
Additional information about Offset Copy, and Vectors. 
 
If you are using tatami shapes, you can also create multiple offsets by holding 
down the Ctrl key while in Offset Copy mode, or while you have click the 
‘Offset Selected Path’ icon. ‘Path’ throughout the software, and manual, 
merely refers to ‘outlines’. 
 

offsets 
 
Creating Multiple Offsets while holding down the Ctrl key. 
There is a difference when the key is held down. 
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Holding down Ctrl while using Offset Copy:  
This creates offset VECTOR OUTLINES. Once you have created these offset 
vectors, you can then convert any selected vector to a practical stitch type. 
 

         
 
 
 
 
 
 
A bit about Vectors 
 

 
 
As a slight aside, while on the subject of offset vectors, and vectors in 
general: 
 
If you select any vector outline, you’ll see its related  parameters in the Properties 
sidebar. In this example, the Properties are docked on the right. The same is true, of any 
selected object in I-Cliqq that has properties, or  parameters that can be modified. Many 
of the features in I-Cliqq have an interactive nature, and can also be applied in varying 
situations, so it is difficult to set features in simple box categories. The I-Cliqq user 
forum will contain additional video clips and information, so you will always find 
updated video clips and information. Other users will also share their tips and tricks that 
they discover in I-Cliqq. 
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Using the Offset Copy feature without holding down Ctrl :  
 
This creates an offset/s of the actual selected OBJECT. Effectively, this creates a new 
object each time. The image below shows you 4 offset objects after the initial object 
creation. 
 

 
offset ‘objects’ 

 
base object. 
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An example of the use of Offset Copy on Objects. 
 

 
 
You may have created 3 objects to apply different densities and colors on to 
create an attractive 3 color blend. Offset Copy can create the objects with a 
degree of symmetry before you apply the various possible stitch effects. 
 
You can also create offset vector objects as temporary guides for other parts of 
your creative processes. There is no set ‘rule’ as to where or how you may 
apply this feature, because embroidery design  naturally requires fluency and 
flexibility of capability. 
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Graphics Software 
 
You can also perform similar functions in graphics software, so if you are 
fluent in Coreldraw, Xara or other graphics packages, you can also create 
object offsets there, and simply paste directly into I-Cliqq  for conversion. The 
nature of the embroidery industry means that businesses are invariably linked 
to other business operations besides just embroidery, so I-Cliqq allows a bridge 
between the graphics, and embroidery aspect. I-Cliqq does have simpler 
outline creation methods for those not fully conversant with graphics software. 
I-Cliqq imports the Windows standard EMF (Enhanced Metafile) . Using a 
standard file type actually leaves you with less frustration about the constant 
variation to file formats that usually leaves people irritated, and looking for 
level conversions. There is a great degree of hype surrounding Vector Files, 
which only serves to confuse many novices, when technically you just want to 
get on with your work. Simply copying any vector into I-Cliqq from any 
graphics software that is supported by the Windows Clipboard really makes 
unnecessary saving, and importing necessary. Its fast..its efficient..Copy/Paste! 
 
Commonly used image editors are Photoshop, or Photopaint. 
 

 
 

Assign an image editor 
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Chapter 8 
 
Manipulating images 

 
I-Cliqq can import or scan images into your design for use as digitizing 
backdrop. You can cut or copy bitmaps from other applications to  the 
Windows Clipboard and paste them directly into your design. You can 
trace shapes and lines over the imported images or directly digitize 
embroidery objects over the images. You can use Auto Trace to digitize 
objects automatically. Images can be used to create Photo Stitch.  
 
Supported bitmap image formats are bmp, wmf, pcx, jpg, tga, psd, eps, tif 
,mac, png and gif. 

 
 

 
 

I-Cliqq imports Raster and Vector files. You may keep the filetypes separate , 
so I-Cliqq allows you to import separately. Clicking ‘Import’ will allow you to 
access your Raster files like jpg,bmp.   
‘Import Vector File’ allows you to import your saved WMF/EMF files. 
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Importing images 

 
Select Image > Import… to import an image. 
 
Note: Imported images will be saved within your design. 
 
To import an image 

1) Select Image > Import…, Open dialog opens. 
 

 
 

2) Select a folder from Look In list. 
3) Select an image:  image information will display in preview 

window. 
4) Click Open 

 
 
Note: Imported images will always be inserted at the beginning of a 
design as the first objects in the object order.  
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Scanning images 
 

You can use scanner to scan images with a TWAIN compatible scanner 
into I-Cliqq, using scanning function. The image quality will depend on 
scanning resolution. Image resolution determines the number of dots per 
inch (dpi). Smaller resolution means less image size and details and 
higher resolution means large image size and more details. A 200 dpi 
would be suitable for most artworks. 
 
If you are using more than one scanner or more than one scanner driver 
on your system, you will have to select  ‘acquire source’  first. 
 
To select acquire source 
 

1. Select Image > Select Acquire Source…, select source dialog will 
open. 

 

 
 

2. Select source 
3. Click Select 

 
To scan an image 

1. Select Image > Acquire…, your scanner program will open 
2. Set the scanning parameters on your scanner program 
3. Scan the artwork. 
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Move, resize and rotate images 
 
Select the image using the  Object Edit Tool to move, resize or rotate it.  
 
Note: Raster images can not be skewed. You can manipulate Vector 
images in any way possible in I-Cliqq , or external graphics software. 
 

 
Rotating images 

 
 
 

Lock and unlock images 
 
                                   Image Locked 
                           Show/Hide Image 
Select Lock/Unlock Background Image or press v f to lock or 
unlock all images.  When images are in locked status, the icon will 
display and images can not be selected.  

 
 

Show and hide images 
Select Background Image on/off or press a @ to show or hide all 
images. When images are in off status, the icon will display and the 
images will be invisible. 
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Editing images 
 
 

You can edit images using any image editor on your system. To edit an 
image, simply select it using the  Object Edit Tool and press * , and the 
image will open in your default image editor. Edit the image, save it and 
close the editor. You will then automatically see the modified image in  
I-Cliqq. Comonly used image editors are Photoshop or Photopaint. 
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Changing image properties 
 

You can control the image brightness and contrast parameters. 
 
To change image properties 
 

1. Select the image using the  Object Edit Tool. 
 

2.  Click Properties (Standard Toolbar) or press a e to 
open properties dialog box. Select Image pages on left list box to 
see the image parameters. Change the parameters and click Apply.  

3.  
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Photo stitch 
 

I-Cliqq can create a photo stitch effect 
from any imported image. 
 

 
 
To create photo stitch 
 

1. Select the image using the  
Object Edit Tool. 

2. Click Properties (Standard 
Toolbar) or press a e 
to open properties dialog box. 
Select Image pages  to see the image parameters.  

 
3. Select Photo Stitch tab page 

 
4. Set the parameters and select Apply to see the stitches. 

 
Tip: You can change image contrast and brightness after creating photo 
stitch. These parameters will affect on photo stitch quality. Change 
contrast and brightness to obtain the best result. Hide the image to see the 
stitches more clearly. You can change contrast and brightness while the 
image is hidden. Photo Stitch effects rely on good areas of light/dark to 
translate to a good embroidery effect. To have optimum effects, these 
cannot be very small images. You can also paste the Stitch Vectors from 
I-Cliqq, into a graphics program like CorelDraw, and create Photo FX 
Prints, with a stitchlike effect. 
 

 
 

Note: Photo stitch will initially use default parameters. You can change the 
parameters to obtain your desired result. 
 
Note: If you resize or rotate the image, photo stitches will be generated 
automatically according to the new image size and angle. 
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Change contrast and brightness for different photo stitch result 

 
 
 

Auto trace 
 

 Auto trace will help you to create embroidery objects automatically by 
tracing bitmap images. Image quality and the number of image colors will 
affect trace result. If you have well defined high resolution bitmaps, you 
can have instant good results. Now that most embroiderers use Vector 
Images, you may have better results by performing a vector trace of a 
bitmap image, and then converting those outlines to stitches. You can 
incorporate your manual digitizing with trace to complete tasks faster. 
Vectors give you much better results but this is a good assistance in the 
design process. Not all detections work, but it can be useful in many 
instances. 
 
When you select the auto trace tool, some icons will display on the 
Property Toolbar to help you create a better auto trace result. You can 
change these parameters while you are tracing objects. 
 

 
 
  Trace sub paths     Node reduction     Image color tolerance 
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Node reduction: a lesser value will create more nodes 

 

 
Color reduction 

 
Note: Before selecting auto trace tool, you should select a digitizing tool 
eg runstitch or tatami tool or the last used digitizing tool will be used 
automatically. 
 
 
 
To trace outlines:  running, E stitch, single path satin, pattern 
stitch and single path contour 
 

1.  Select one of these digitizing tools. Not 
all may be practical. 

2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance if necessary. 
4. Move the pointer over the image. A bounding box will display 

around the selected image. 
5. Rest the pointer over the color you want to trace. 
6. Click to trace. You can continue clicking to trace more objects. 
7. Press x or s to finish. 
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Tracing a running object 

 
If you have a well defined, high resolution image, you can have very 
accurate bitmap trace results. Vectorizing  and importing the vector files 
invariably give you much more accurate results. Graphics programs like 
CorelDraw or Xara  feature good bitmap tracing utilities, and with 
minimal cleanup, you can have high quality vector artwork.
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To trace contour stitch and cross stitch 
 

1.   Select one of these digitizing tools. 
2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance. 
4. Move the pointer over the image. A bounding box will display 

around selected image. 
5. Rest the pointer over the color you want to trace. 
6. Click to trace. You can continue clicking to trace more individual 

objects. 
7. To trace a sub path 

a.   Select Add outline(Properties Toolbar). 
b. Rest the pointer over the color you want to trace as a sub path. 
c. Click to trace. 

8. Press x or s to finish. 
 
 

 
Tracing cross stitch, after clicking Add Path, click on other area to trace sub 

paths 
 
 

To trace dual path objects 
 

1.    Select one of the dual path digitizing tools. 
2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance if necessary. 
4. Move the pointer over the image. A bounding box will display 

around selected image. 
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5. Rest the pointer over the color you want to trace. 
6. Click to trace satin.  
7. Move the pointer outside the satin boundary and click to define first 

stitch angle. 
8. Click more stitch angles inside the satin boundary. 
9. Click the  last stitch angle outside the satin boundary. 

Note: You can edit stitch angles and lines at the same time. Simply 
click on hot points of stitch angles and lines and drag them to define 
a new angle. 
Note: Stitch angle directions will be corrected automatically while 
you click for a new stitch angle. 

10. Press x to finish. 
Auto trace tool will remain active and you can start tracing a new 
dual path object. 
Or press s to finish the  tracing process. 

 
Note: You can cancel the process by pressing s at any time. 
 

 
 
 

To trace tatami, parallel satin fill and motif 
 

1.    Select one of these digitizing tools. 
2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance if necessary. 
4. Move the pointer over the image. A bounding box will display 

around selected image. 
5. Rest the pointer over the color you want to trace. 
6. Click to trace. You can continue clicking to trace more individual 

objects. Auto Trace will not detect holes. Go to the next step to 
trace holes. 

7. To trace a sub path 

a.   Select Add outline (Properties Toolbar). 
b. Rest the pointer over the color you want to trace as a sub path. 
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c. Click to trace. 
d. Repeat clicking to trace mode holes. 
 

8. Press x or s to finish. 
 
Note: To define entry-exit points and fill angle press *. 
 
 
 
 
 
Note: Auto Trace will only trace main boundary or holes. You can also 
use   single and dual curved tatami fill for tracing, but you will have 
to terminate the  tracing procedure after tracing the main boundary and 
use Add Outline to digitize filling stitch curves. 
 
 
 
 

 
 
 

Tracing Tatami 
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To trace spiral fill 
 

1.  Select Spiral Fill digitizing tool. 
2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance if necessary. 
4. Move the pointer over the image. A bounding box will display 

around selected image. 
5. Rest the pointer over the color you want to trace. 
6. Click to trace. You can continue clicking to trace more individual 

objects.  
7. Press x or s to finish. 

 
 
 
 
 
 
 
 
 
 
 
To trace satin fill 
 

1.  Select Spiral Fill digitizing tool. 
2.  Select Auto Trace or press v T. 
3. Adjust Node Reduction and Color Tolerance if necessary. 
4. Move the pointer over the image. A bounding box will display 

around selected image. 
5. Rest the pointer over the color you want to trace. 
6. Click to trace.  
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7. Press * to define stitch angles.  
8. Press x or s to finish. 
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Import DXF / EMF vector format 
 
Some popular graphic applications like CorelDraw can export designs as 
DXF vector file format. I-Cliqq can import DXF format as Vector 
Outlines and you can edit imported DXF/EMF format using the Outline 
Edit Tool. You can use these kinds of graphics as digitizing backdrops or  
convert them directly into embroidery objects. 
 
To import DXF vector format 

1) Select Image > ImportVector File>> (.dxf, emf)…, open dialog 
opens. 
 

 
 

2) Select a folder from Look In list. 
3) Select a DXF or EMF file, the design will display in preview 

window. 
Click Open. 
 

 
Importing DXF/EMF files and converting into embroidery objects 
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Creating bitmap images from objects 
 

I-Cliqq can create images from embroidery objects. You can create high 
resolution bitmaps, or simply use the vector outlines. You can use this 
image to trace new objects. This is very useful when you want to digitize 
a new object around a combination of some other objects. Normally you 
will have to digitize a new object which can be time consuming, but you 
can  now make an image from the objects and use Auto Trace to digitize a 
new outline automatically. You can also copy the created image and paste 
it into other graphical applications. 
 
Note: The image will only be created from dual or closed path objects. 
Manual will be skipped. If you want to create an image from manual 
objects, you should convert them into embroidery objects first then try 
making an image. 
 

 
Create image from objects 

 

 
Creating image and tracing single path satin around objects 

 
Note: The image can be created as a multi color or single color bitmap. 
You can use this technique to trace individual areas or a combination of 
source objects. 
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Creating multi color images from objects and digitizing individual objects 

 

 
Creating single color image from objects and digitizing the boundary outline 

 

 
Creating image and tracing it as hole in a closed path object 
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To create a bitmap  image from objects 
 

1. Select the object from which you want to create an image 
2. Select Image > Create From Object(s)…, Create Bitmap dialog 

will open. 
3. Select if you want a monochrome or multi color image and also 

set the image quality. 
4. Select OK 

 
Monochrome or Multi color image 
       Monochrome image color 
 

 
 
  Bitmap quality 
 

 
  Less image quality         High image quality 
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Using the Vector Outlines of Embroidery Objects. 
 
I-Cliqq allows you to paste Embroidery Objects directly into graphics 
applications like CorelDraw. Since I-Cliqq is a vector based program, the 
outlines are useful to create vector graphics from any embroidery object. 
You may provide services that require the use of vectors, apart from just 
your embroidery creations. 
 

 
 
Select any embroidery object in I-Cliqq that has ‘outline properties’ 
Edit> Copy Special > Stitches. 
This copies the ‘stitches’to the windows clipboard, and you can paste 
directly into a graphics program like CorelDraw. 
Eg. In CorelDraw go to : 
Edit> Paste Special ( select Enhanced MetaFile) and click OK. 
 
Perform the same procedure to copy Outlines, or Outlines and Stitches. 
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Chapter 9 
 
 
Special Techniques 
 
I-Cliqq provides special techniques which help you to digitize and edit your 
designs. You can use branching, connection optimization, the cutter tool, object conversion and related 
features  to create and handle design creation productively. I-Cliqq also features Vector Outline 
conversion, and branching capabilities. Vector lineart can be converted to various stitchtypes in I-Cliqq. 
It is the domain of the digitizer or embroidery designer to be fluent in aspects of graphic creation, which 
in most cases may involve the use of external graphics applications such as Illustrator™, or 
Coreldraw™. 
 
 
Branching 
 

 Branching can create a group from selected stitchtypes and arrange the object priority 
according to entry and exit points, and also optimize connections automatically. You can create 
the set of objects in any sequence, and I-Cliqq Branching will take care of  optimizing that 
sequence. This is useful and can be applied at multiple points in a design. Since I-Cliqq  
capability allows you to ‘Edit WITHIN Groups’, there is almost  no need to ungroup to perform 
operations such as resizing, or rotating objects. 
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To apply branching 
 
Select satin objects you have already digitized. 

Select Group(Branching), the objects will be connected automatically. Entry/exit points will be on 
the first and last objects. 
Note: The branching icon will be dimmed if the selection contains less than 2 objects. 

 
 
Press * to define entry-exit points visually onscreen. 
 

 
 
After applying branching, press * to change the entry-exit points 
 
 
*Branching is a special technique to assist you within your design creations.  You will need to take care to some extent in 
how you apply functions to groups. By exercising some degree of design planning, which is essential, you can employ this 
capability very effectively to create good embroidery, while also saving you time. 
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       In the event that you included objects that do not support branching in your selection, the 
above system message will appear. If you choose YES, only the supported objects will be 
branched. If you choose NO, a 2nd dialog will open allowing you to select the unsupported 
objects. You can then modify these, to try to create objects that support branching, or exclude 
them from the branching operation. 
          
 
 
Optimizing objects for connection  
 

 
 
 
 
You will not need to digitize objects from the specific entry, or exit points of other objects, 
because I-Cliqq can create  a group and optimize connections of different objects automatically 
for you and keeps it optimized when you edit or resize them.  
 
Note: Objects will be optimized using the first object as the base object in the selection.  
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To optimize connections 
 
1. Select the first object to which other objects will connect and then add other objects to the 
selection set. 

2.  Select Group to group select objects. 
3.   Select Properties to open properties dialog box. 
4. Select Group on the properties dialog box . 
5. Select Optimize for Nearest Connection Point. 
6. Select Apply to apply optimization. 
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Grouping objects and optimizing connections 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Insert Selected to First 
 

 This option allows you to insert (I) , and adjust the entry/exit points  
to change the running sequence of objects. It performs a similar action to branching, but gives 
you more flexible control. This may suit a designer that prefers a semi-automatic action, while 
retaining the ‘manually digitized’ pathing  
effect of objects. 
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1-Select the objects. It may be another object from a totally different part of a design, that you 
moved to a point of insertion. These should be the same color. 
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2-Once you have selected the base object (first in selection) , and the object to be inserted ( 
second in  selection), press . 
 

 
3-You can move the exit point on the 2nd object, to the entry point on the same object, to move 
it closest to the insert point. 
 

 
 
4-If you now check the run sequence of the objects, the 2nd has been inserted . 
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Insert Individual Selected to First Object 
 

 This function, is also a semi-auto assistance, and allows you to add selected objects, to an 
initial base object. You can modify entry/exit points before, or after applying this feature. You 
may find different uses, at different times, but it is an additional feature for your convenience. 

 
1- Create a few random objects. 
 

 
 
2-  Select the objects in the order of 1..2..3. The first object you select, is the base object, to 

which objects 2, and 3 will be ‘inserted. You can select by using the Object Edit Tool  and 
holding down q to add the other objects to the selection. 

 
 
3- Once you select the objects , click the icon ( It will highlight once the objects are selected. 
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4- Once that’s done, select Outline Edit Tool  
 

 
 
Reposition the exit points on the entry points of each insert , closest to the insert points on the 
base object. 
 

 
 
5- If you now travel by stitches , you will find that the objects run in their inserted positions in 
the stitching sequence. This example merely shows you a guide, but you can position your 
inserts seamlessly in the sequence. 
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Cutter tool 
 

  The Cutter Tool , simply cuts objects to simplify any related task. You may be splitting a design 
into sections, or simply wish to cut an object. 
 

 

 
You can use the Cutter Tool if handling machine files in their ‘Stitch Mode’.  

 
 

 
The Cutter Tool cuts objects like a blade 
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To cut objects 
 
1.  Select Cutter tool (Edit & Digitizing Toolbar)  
or press v3. 
2. Rest the pointer on an initial cutting point on design working area then  
       Click and Drag to define the cutting line.  
3. Release mouse button. 
Cutter tool will be active and you can cut object again. 
4. Press s or x to finish. 
5.  
 
Note: Cutting line should cross both paths of a dual path object or it will not cut it. Single or closed path objects 
can be crossed once or more. While the Cutter tool gives you advanced flexibility, you should remember that 
cutting affects machine functions like trims and jumps, so use the tool with discretion. 
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Object conversion 
  
I-Cliqq  can convert objects into other embroidery objects. The table below shows some conversion 
possibilities. I-Cliqq conversion capabilities are subject to change without notice, however please refer 
to forum or site updates as the different types are enhanced. 
 
Note: 

   Parallel satin, Single curved tatami ,  dual curved tatami, and Trapunto  
are Tatami objects with different stitch parameters. To convert objects to one of these objects, you can 
convert them into tatami and change the parameters. 

 
 To convert objects to any kind of satin styles  , convert them into satin and change the 

parameters. 
 
 Different kinds of satin styles will be treated the same as normal satin. 

 
 

 
You will recognize some of these types from the Dual Curve Toolbar. 

 
 

 When you convert objects into  pattern stitch, you should select a pattern for the 
converted objects from propertied dialog box. 

 When you convert objects into  satin fill, press * to define stitch angles, or you will 
not see any stitches on the converted objects. 
 
 
 
 
 
 
 
 
 

 435



Source object type Conversion Capability 

 

 
Manual Stitch 

 

 Vector/Outline Objects and  Manual stitch blocks will be converted into 
running, satin and tatami, based the stitchtype of objects. 
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To convert objects 

 objects you want to convert. 

, object conversion dialog will open. 

1. Select the
2. Right click, a popup menu will open. 
3. Select Convert Object(s) to…
 

 
 

atin/Tatami  Recognition Step is used when converting manual objects to outline. Wh  you have manual stitch S en
objects selected ( eg. A stitch block of satin in a machine file like DST. ) you can adjust this factor if necessary. 
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4. Rest the pointer over a new type and click to select. 
5. Select Convert 
 

Note: You can also select  Convert Object(s) (General Toolbar) to convert  an object. Object 
conversion panel will open and you can select new object type. 
 

 
 
 
 

 
 
 

 
Note: A message dialog will inform you of the result if any of the selected objects could not be 
converted into a new type. The selection box can be reformatted by dragging , so you can have a few 
variations of that box appearance depending on what suits your view best, and whether you have 
docked the toolbar horizontally or vertically. 
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Creating patterns 
 
You can create your own patterns to use as custom pattern stitch, motif, tatami, satin patterns and satin 
edge patterns. 
 
 
Creating patterns for pattern stitch 
 
You can create single or multi color patterns and use them when digitizing pattern stitches. 
 
To create single color pattern 
 
1. Digitize your desired pattern using any object type. The pattern can be digitized using 
more than one object type, for example you can digitize a pattern using  running and satin tools. You 
can use the grids, or guidelines to create accurate shapes. 

 
A simple pattern digitized with running and satin. 

 
 

2. Select the digitized objects with Object Edit Tool.  
 
3. Right click, a popup menu will open. Select Set As > Stitch/Motif Pattern. Pattern save 
dialog will open. 
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4. Enter a name for your creation in the  File name field of the dialog box that opens,  and 
select Save. 
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Note: The angle of a pattern’s start and end points will be the pattern’s base angle and the pattern will 
be repeated designated by this angle. To avoid getting confused, digitize the pattern from left to right 
side and make sure both start and end points lay on a horizontal line. 

 
 
Now if you try digitizing a pattern stitch, when you want to select a pattern, you will see your pattern 
appears in pattern select dialog box. A dashed line will connect the start point to end to show  the 
pattern’s base angle. 
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Clicking on ‘Pattern’ once you have selected the Pattern Stitch digitizing tool, will open 
the  Pattern Dialog. 
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A Pattern stitch sample 
 
 
 
 
 
 

 
A pattern digitized with running and satin 
 
 
 
 
 
 

 
A pattern digitized with running, manual and sequin 
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To create multi color patterns 
 
A pattern can contain up to four colors and they are digitized same as single color patterns. The angle 
between the first stitch of first color and last stitch of the last color will be the pattern’s base angle and 
pattern will be repeated according to this angle. 
 
 

 
 
 

 
 

An Example of  Multicolor Motifs
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Creating patterns for motif 
 
The single and multi color patterns you have created for pattern stitch, can be used as motif patterns as 
well. When you want to select a pattern for a motif, you will see the patterns you created display in the 
Motifs dialog. 
 

 
 

Using patterns of pattern-stitch as motifs. 
 
 

 
In motif fill, patterns will repeat in rows and a line of patterns may start from the  left or right side to 
cover the motif fill area. 
 

 
 

Pattern rows may start from left or right 
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The pattern’s stitches will be reversed when the pattern repeat direction is opposite to the pattern 
base angle. 
 
 
 
 
 

 
 

Patterns stitches are reversed when the repeat direction is reversed 
 
 
 
 
As you see in the above picture, when the pattern is reversed, if there are some stitches that are covered 
by a satin, they will appear at the top because the stitch sequence has been reversed. I-Cliqq lets you 
correct this problem. For these kinds of patterns, you will have to make two patterns. The first one 
should be digitized from left to right, and the second one should be digitized from right to left with its 
start  located on the end point of the first pattern and its end should be located at the start of the first 
pattern. 
 
 
 Start point           End Point           End Point      Start point 
 

 
    First pattern             Second pattern 
 
You should save the first pattern as a normal pattern, but the second should be saved as motif return 
pattern.  
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To create a pattern as a ‘motif return pattern’ 
 
1. Select the digitized pattern with Object Edit Tool. 
2. Right click, a popup menu will open. Select Set As > Stitch/Motif Pattern. 
3. The Pattern Save Dialog will open. 
4. Select Save as type (*.mrp) 

 
 

 
 
           Enter the same name you have chosen for the first pattern or I-Cliqq will not be able to     
recognize and use it…so, if you called the first Test.psd , the return pattern name should be Test.mrp. 
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Creating a pattern for use  within Tatami 
 
1. Digitize the pattern shape using any digitizing tool. Eg. runstitch. 
 

2. Select the object(s) by using Object Edit Tool.  
 
 
3. Right click the object, and a popup menu will open. Select Set As > Tatami Pattern. Tatami 
pattern save dialog will open. 
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4. Enter a name in File name field and select Save. 
 
 
Digitize a tatami fill , and now, if you wish to apply your pattern, you will see it in the tatami pattern 
dialog. 
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A User defined tatami pattern 
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Creating a satin pattern 
 
1. Digitize the pattern using any digitizing tool. 
2. Select the object(s)  using Object Edit Tool. 
3. Right click, a popup menu will open. Select Set As > Satin Pattern. Satin pattern save dialog 
will open. 

 

 
 

 
 

4. Enter a name in File name field and select Save. 
 
Now if you try digitizing a satin (with a pattern), when you want to select a pattern, you will see your 
pattern appear in the satin pattern selection dialog box. 
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A User defined satin pattern 
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Creating satin edge patterns 
 
1. Digitize the pattern using any digitizing tool. 
2. Select the object(s) by Object Edit Tool. 
3. Right click, a popup menu will open. Select Set As > Satin Edge Pattern. Satin edge pattern 
save dialog will open. 

 

 
 

 
 

4. Enter a name in File name field and select Save. 
 
Now if you try digitizing a satin (with pattern), when you want to select a pattern, you will see your 
pattern appear in the satin pattern select dialog box. 
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User defined satin edge pattern 
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Rename or remove a pattern 
 
When a pattern has been created by mistake, it can be removed from pattern select dialog box. 
You can also rename patterns. But you should be careful not to remove or rename the  
program’s original patterns. 
 
To rename or remove a pattern 
 
1-Open any pattern dialog select dialog box, 
2-Right click on the pattern you want to rename or remove. A popup menu will open. 
3-Select to remove or rename the pattern. 
 
 

 
The selected pattern will show in a blue highlight 
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Select Rename to rename the pattern, the  Rename dialog will open. Enter a new name and select OK. 
 

 
 

Select Remove to remove the pattern. Remove confirmation dialog will open, confirm deleting by 
selecting OK. 

 
 

View Toolbar  
 

 
 

Besides just showing you the different stitch views, the View Toolbar contains the icons to 
center your designs. There are a few different conditions that relate to positioning start /end 
points on designs, but the most used is Design Start/End set at Center.
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Design start and end point 
 
When you digitize a design, you may need to set the design start and end points. Normally design start 
point locates on the first stitch of first object and end point locates on the last stitch of last object. You 
can change the start and end point on your desired points. 
 
To change design start and end points 

 
View- Start/End Center 

 
 
Select File > Design Properties : design properties dialog will open then select Start-End tab page. 
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Click on Start Point & End Point dropdown list box to set the start & end. 
 

 
To change design start and end point visually 
 

1.  Select On Screen Positioning. Start and end point symbols will appear 
on design working area. 
 
2. Click on start or end point symbol and drag it to your desired location and release mouse 
button. 
 
Tip: Press - to snap to objects while you are dragging the start or end point symbol. 
 
3. Press x to finish. Or press s to cancel the command without any changes. 
4.  

 
 
 
 
 

 
Design with Start/End Centered 
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Changing design start and end points 
 
Setting is as simple as clicking each icon as shown, and selecting the desired point. You will see it initiated 
onscreen after you select it. 
 

 
 

Actual Software Display Colors 
 

 
Green = Start Point 
Red    = End Point 
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 Click to set a start point 
 

 Click to set an end point. 
 
Select a practical start/end point combination and you will see that applied onscreen. 
 

 View Design Start /End. 
 
Clicking this icon displays the onscreen indicators current positions.
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Creating continuous designs 
  
Continuous designs are usually digitized according to embroidery machine needle to needle 
distance. I-Cliqq  can display a repeat background image and stitches to help you digitize 
continuous designs easily. 
 

 
A continuous design 

 
 Select Show Repeats (View Toolbar) to see repeats of background image and stitches. Eight 

repeated images and stitches will display around objects with a lighter color, according to needle to 
needle spacing define in program. You can change repeat spacing. 
 

 
View of a  repeated background image and stitches 
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To change repeat settings 
 

 Select Schiffli Parameters to open repeat settings. Right Click the icon. 
The Design Properties dialog will open. 
Set needle space and repeat view settings and select Apply. 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 

 462 



 
 
 
 
Design templates 
 
Templates allow you to customize your parameter setup. 
We all use varying settings for different fabrics. There is no set RULE in embroidery as to what the 
various fabric settings may be. As an embroiderer, you are aware of constantly changing conditions, 
even when its absolutely the same fabric. No two designs may run exactly the same. You can however 
create a guide set of parameters, or you may have something absolutely specific you use for a specific 
client . 
 
To create a design template 

 
1. Select Tools > Design Templates…, design templates will open. 

 

 

2.     Select Add to create a template.  
’New Template1’ will be created and will display on templates list. You can simply rename that. 
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Adding a new design template 

 
 
3. Type your designed template name instead of the default name. Do not press enter when you 
entered a new name or design template dialog will close, in this case, you will have to open it again. 
 

4. Select Design Properties to open design properties. You can change any 
parameters in design properties. Design working area size, background and needle colors, design 
default start-end positions, output defaults. Finally close design properties dialog by selecting OK. 
 
 

5. Select Properties to open the properties dialog box. You can change any 
default parameters of objects. To change the parameters, click the items on left list box to see related 
parameters and change them. Once you are done with setting up your preferred parameters, click Apply, 
and Close. 
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Properties dialog opened by design template:  Main Properties Box 
 

6.    Click Select to select the template. 

7.    Select Cancel to close design templates dialog. 
 
To remove a design template 

  Select Remove to remove selected template (to select a template, click on it). You 
will be asked to confirm deleting. 
 
To use the I-Cliqq Default Template 
 

  Select Use Default to use program default values . 
 
If you have set up Templates, Each time you start a new design , I-Cliqq will show you the template dialog. You 
may have Parameters set up for Wool, Piques, Cottons or even designate Templates, as Client Names for special 
parameter setups. You may have a client with old machines that work on specific settings, with special pull 
compensation etc. I-Cliqq lets you keep your eye on the ball. 
 
** Note : ALL Customized  settings should ALWAYS be backed up. Select the relevant folders from C:\I-Cliqq2009 to back 
up to external drives, or CD/DVD. If you have created special templates, fonts,  motifs make sure you back these up 
constantly. In the event of a system crash, you can reload these. Warning! Do not neglect this aspect of your business. 
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 Digitizing Templates 
This is an essential to your design day. Instead of keying in your most used settings each time, simply 
set them up, and they’re on hand anytime. 
Set up all your most used parameters on stitchtypes, even if it includes a specific   
underlay. You can perform this setup once, and adjust at any time. 
 

 
 

 
 

Simply select your preset values, and get on with work! 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 466 



To create a Digitizing template: 
 
1. Digitize an object in the stitchtype of choice. 
2. Change the object properties as you need. 
3. Right click on object, a popup menu will open. 
 

 
 
 
 
Select Set As >Digitizing Template : The digitizing template ‘save’ dialog will 
open. 
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4. Enter a name in File name field. 
5. Select Save. 
 
 
To use a Digitizing Template. 
 
1. Select a digitizing tool (like satin) 
2. Select a preset parameter from the Digitizing Template dropdown list  on the Stitch 
Properties Toolbar. 
 
The first item in the list is the default punching template which uses program defaults or settings 
defined in the Digitizing Template 
 
3. Start digitizing. You will now be digitizing in your favorite preset parameter, whether 
it’s a triple bean, a contour stitch with displacement, a satin column with zigzag underlay. You are all 
set to digitize without interruption, or constantly keying in values. 
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Tip: you can use shortcut keys to select punching templates.  
Press a 1 to select the first Item in the list (default punching template). To select the second item 
press a 2, for the third item press a 3, …, for the ninth item press a 9 and for the tenth 
item press a 0. If the digitizing templates are more than ten, you will have to select them from  the 
Digitizing Template dropdown list. 
 
 
I-Cliqq will use the last applied parameter from Digitizing Template, as the default setting for a 
digitizing tool whenever you start digitizing, unless you select a new parameter. Changing a parameter 
is just a click away. 
 

 
Digitized within a few minutes, from preset parameters.
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Printing designs 
 
Use print  the command to print your design. You can preview each design before printing or you can 
use worksheet printing which contains a design preview as well as essential production information, 
including design size, color sequence and any special information. 
 
To print design 

Use Print (Standard Toolbar) to print design. Print dialog box will open, change the print setting 
and select Print. 
You can also print to PDF if you have a driver installed. 
 
Print General page 
 

 
 

 
 
          
 
 
 
 
 
 
 
 
 
 
 

 470 



Print Worksheet 
File>>Print ..and select WORKSHEET: 
 

 
Print General page 

 
Enlarge or decrease the 
design size to fit to page  Fit the design in print area if  design size 
is larger than page, deselecting this option will provide a tile printing 
  Design position on paper    
         Maintain print aspect ratio 
          

 
 
Print scale     Tile printing       print overlaps by value or percent in tile printing 
 
Print Visual page 
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  Print mode    Black and white printing 
    Show start point and trims on print 
 

 
 
Print title        Select a bitmap logo for printing 
(enter your desired title here)     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Print Preview 
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Select  File >>Preview to preview design before printing. 
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 Select the design just as you would select using Object Edit, to reposition the   view. 
 

 Left or Right mouse click to zoom in our out of the preview. 
 

              Open Properties Dialog 
 

 Print 
 

  Zoom Factor Window 
 

  Close Preview Window 
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To print a production worksheet 
 
Select File > Print > Worksheet…, worksheet print dialog will open. Set the worksheet print parameters 
and select Print. 
 
Worksheet print sample 
 

 
 
Worksheets can be printed in Landscape or Portrait. 
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Hoops 
You may have seen reference to this at other points in the manual. I-Cliqq provides you with 
the power to use or create accurate Hoops, and additional guides you may decide to create, in a 
few simple steps. 
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The Hoop Toolbar 
Hooping and Embroidery go hand in hand, and since your onscreen work has a lot to do with what you 
do on your machinery, I-Cliqq’s  Integrated Hoop Feature provides you with some essentials. 
 
Besides the standard hoop sizes in the software, you can actually create your own. You can also share 
your creations with other users. You may not need to have the toolbar open or docked, but its always 
available in View>>Toolbars, the same as other toolbars. If you inadvertently close some, and can’t 
find them..this is where they can be found easily. 
 
 
 
How to Create a Custom Hoop 
 All you need to do in I-Cliqq, is create the inner circumference of the actual inline of your 
hoop. 
Generally, a hoop has an inner allowance of just under ½ inch or 10-12mm. 
Once you create the inline of the embroidery hoop, I-Cliqq will take care of the rest. If you wish to 
create additional guides, just create secondary outlines.If you wish to create the ‘embroidery field area’ 
for commercial type machines that require at least 10mm internal hoop allowance, you need to create a 
secondary guide , 10mm inside the initial shape creation. 
You can scan in your hoop at 100% , trace it, and recreate it accurately in I-Cliqq. You only need to do 
this once. Use the grid and guides to set up your initial shape accurately. 
 

 

 
 

1- Select the Vector/Outline Tool. Create one closed curve tracing of the 
actual ‘embroidery field shape’. A closed curve : End the shape with the last node on the first 
node, and press ESC. This example vector is created using Arc-Spline Mode. 
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You see these icons display each time you select a digitizing tool. 

 
 
 
 

 
 
2- Select the completed shape, R/Click and select Set As> Hoop. 
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3-The ‘Hoop Name’ Dialog will open. Give your creation a name eg.  
My Hoop, and click SAVE.       Your work is done. 
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Now, if you just go to the Hoop Toolbar, and ‘IMPORT HOOP’ , you will find your newly 
created filename there. 
 

 
 

4-The red inner circle just indicates the part you created. As you can see,  
I-Cliqq has created the filename, and outer shape for you. 
Your hoop shape is ready for use. 
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If you created additional guides on your shape, and saved it exactly the same way, your 
shape would look like the hoop view below. 
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An example of a ‘shape’ with guides. Remember that I-Cliqq creates a 5mm wide Hoop Frame 
(you see that crosshatched).If you want your guides to extend outside the ‘ hoop’ you have to 
consider that in the creation. 
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Adding an Image to identify your  ‘Hoop’ 
 

 
 

Click on the Hoop Import   icon, to open the Hoop Shapes dialog. 
Right Click on an a desired image. 
 
 
Click on Add/Replace Image. A dialog will open. Select any folder where you may have an 
image to associate with your hoop. You are not restricted to just hoops. You can actually 
prepare ANY practical guide for yourself. It can be cap outlines, the back arcs of specific cap 
brands, head to head needle spacing guides, or absolutely anything that you might require, that 
needs a set guide shape for constant use.. 
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All you need to do is select an image from anywhere on your hard drive ( It can be a jpeg. or 
bmp) , preferably small image files, click on OPEN, and your image is assigned to the ‘hoop’ 
or shape. You can assign any image that suits your fancy…as long as its good for recognizing 
your creations. 
 
The operations to remove, and rename , found in exactly the same flyout menu, are simple. 
Remember  to try not to delete the system hoops. You can share your creations with other 
users, or even get back missing .HOP files from other I-Cliqq users.  
These can be copied to the C: \ Program Files\ I-Cliqq2009\ Hoops folder. Depending on your 
operating system, you may need to allow folder access. An easy way, is pasting the file, into 
the Hoops folder, while accessing it from within I-Cliqq. 
 
Hoop files have the (.hop) extension. 
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Hoop Toolbar Basics 
Toolbar operations are simple.  
 
1-  Click this icon to import a hoop into your screenspace. 
 

2-   Click this icon to change the color of the hoop.  

 
3-  Click this icon to remove the hoop from the workspace. This does not ‘delete’ any 
hoop file, it merely removes the current hoop view from the workspace. 
 
      4-   Click this icon to reposition the hoop onscreen.  
The hoop will snap to your mouse cursor. 
Click in the new position. 
 
5-  Click to rotate the hoop in 90  degree increments. 
 
6-   Click to show or hide the hoop. 
** Note: If you hide the hoop, but have set the design to the hoop 
Center, remember that this is still the active ‘center’ , so when  
Working with HOOPS, remember this. 
 
 
 7-  Click to make the design Start/End at the Hoop Center. 
               If you have selected this icon, you’ll see the normal design 
                Start/End Points  on the View Toolbar dimmed.  
(This icon is on the view toolbar but in effect when you are using hoops) 
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View Design Start/End  will still be active. 
You can still switch this view off /on. 
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User Profiles 
 
User Profiles are convenient, and save the program desktop layout. If you have 2-3 digitizers over 2 
shifts, or even if you have more than one person using the same computer , you no doubt experience 
time loss with both having different preferences. Its real..people do things differently, and set up 
screens differently. One’s way of working can be irritating to another just because of the screen layout 
and settings. Enter I-Cliqq User Profiles. 
 
I-Cliqq provides a quick and easy way to switch between different users, in a few clicks. No 
program restart is required, simply switch. 
 

 
Go to the dropdown menu Tools > Manage User Profile. 
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Enter your name. You can also designate user profiles as special setups for fabrics, or assign it 
with a customer name, if perhaps you do some specific setups for a particular client, with 
specialized parameters. 
 

 
Click OK. 
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A confirm dialog will open, regarding the default Profile – Click No. 
A second confirm dialog will then open regarding the new profile creation. 
 

 
 
Click Yes , in the final dialog, and the profile is created.  
Restart the program after the first time you create a profile,  
to register the settings. 
 
** Note: User Profile saves what you see in Tools>>Preferences, and Custom layout of 
toolbars.  
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You can create different desktop layouts of the toolbars. When you wish to select yours, just go 
to Tools>>Manage User Profile, and select your name, or the desired profile. 
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 Switching is instantaneous. You will just see the screen dip for a second, as the profile loads. 
No program restart is required, and you can switch between profiles as often as you like, and 
update them as you wish. You can also simply remove, import or export user profiles. 
Users can share the same profiles. If you have operations in different places, and would like 
another office to share the same settings, or if 2 users would like to see exactly the same 
desktop layout, simply export the profile. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Import/Export User Profiles. 
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Import or export user profiles to any folder destination. The designated file is a .UPF file, so 
you will see eg. Wendy.UPF  in the folder that you decided to export to , or import from.  
 
This should be done, when you create a profile. The user profile created file can be stored on a 
flash memory stick, or external drive, in a folder where you keep backups of all your important 
settings eg. Templates, Fonts etc. 
 
Export, will export the current profile as shown in the dialog. 
Import, will allow you to access any folder or device you may have your data backed up on. 
 
If you lose your files, you can create new ones with no problem, but storing your important 
files can save you frustrations, especially if you have created works like custom fonts. Profiles 
do not take as long to create, but fonts can take hours of work. Backing up of folders like 
Fonts, Thread Charts and Templates, and especially all your DESIGNS , should be 
considered a HIGH PRIORITY. While I-Cliqq assists in creating the backup files, you 
should have a mirrored or cloned set of folders on another hard drive. In the event of 
computer damage, or hard drive failure, observing these rules will ensure you are up and 
running again with all your saved data intact. 
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Chapter 10 
 
 
Lettering 

I-Cliqq provides you with many lettering essentials. This software aspect, 
enjoys continual enhancements due to the ongoing demand for powerful 
lettering effects. I-Cliqq provides you with a fascinating array of powerful 
lettering capabilities, to leave competitors stranded. What is possible for 
you in the way of applied stitch effects, enveloping power, customizing 
baselines, and even creating baselines from stitch objects will leave even 
your strongest competitors struggling to emulate you…after all, I-CLIQQ 
is about setting you apart from the competition. 

 
Creating lettering 
 

 

Set it 
onscreen 

Add 
desired 

text to the 
baseline.

Select a 
text 
baseline. 
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Main information pages highlight , with related pages. 
 
 

 
 

You will also see the Stitch Properties change to indicate the general text 
status. This ‘jack of all trades’ toolbar gives you basic used information, 
in any stitchtype  mode, and allows you to apply basically used 
parameters fast. In the case of text, you will need to enter the desired text 
in the Main Properties Toolbar, but you will see the Stitch Properties 
information change as you select created text. 
 

 
A view you will see when text is selected. Float over the parameter 
input boxes to see hints related to operations you can perform, eg. 
Changing dimensions. 
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 Use Text tool to add lettering to your design. 
 
 
To create lettering 
 

1.  Select Text (Edit and Digitizing Toolbar),  
or press X. 

2. Rest the pointer on design working area 
• Click once onscreen to set a default baseline. 

                             Click and drag to create dual curves. 
 
 

The Properties dialog will open after clicking 
 

3. Select a font and enter text in text edit box area on properties 
dialog. 
 
Note: Change the language if you are using a non-English font 
like Thai. There is no need to change the language if you are 
using English. The view you see may vary with OS ( XP,Vista) 
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4. Press ENTER, or click ‘APPLY’ . The text you typed in will 

appear onscreen. 
 
Note: Text tool remains active and you can create more lettering 
by clicking on the work area. Press s or e to finish. 
You can create multiple baselines, and then just select each to add 
the desired text. 
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Creating a custom arc. 
 
If you select any of the baselines and just click onscreen once, a 

default arc will be applied.  
 

To  
 

To create a custom arc..select a curve type baseline. 
 

 
Once you have clicked onscreen for point 2, the cursor will then show the 

arc in elastic mode, until you click a point to define the arc. (Point 3) 
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Clicking point 4, will define an onscreen height. If you Right 
Click at point 3,  the baseline creation will end, and you will not 
be required to click point 4 for onscreen height. 

 
 
 
 

 
 
Note: Press * to see/change only entry/exit points on a lettering string, 
or if you have selected a single letter. Press s to exit this mode. 
 
The above 4 steps are the basis of any basic text creation, on any created 
baseline. Beyond these 4 basic steps, lies a world of manipulation, and 
effects that may perhaps be too vast to fully describe, since the effects 
you may find yourself able to create are almost endless, and many of 
these will springboard off prior parameters features discussed. You can 
change lettering ‘on the fly’ , adjust the baselines, change fonts ‘on the 
fly’, create new fonts, apply connectors, change entry/exit, modify the 
sequence of stitching, change colors, envelope, change stitchtypes on 
individual letters, apply density, change properties, create baselines from 
vector outlines, and more. I-Cliqq V1.0 provides you with the basic 
lettering platform that will be constantly enhanced to provide you with 
stunning lettering capability. 
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The Text Toolbar 
 

 
 
Once you undock the text toolbar, you can float and dock  it vertically 
or horizontally. You can also just select a baseline type by clicking on 
a type, and the toolbar will slide back into its ‘cabinet’ position. The 
icons where you see the small triangles can be considered as the 
‘cabinets’ , because these contain toolbars you can expand. 
 

 
 
 

  
 
These images show you examples of possible docked positions. 
You however, may dock the toolbar anywhere you find it convenient. If you 
close any of the toolbars you have expanded from their ‘cabinet’ positions, they 
merely revert to these if closed. So you can open them by simply expanding, 
dragging and docking at absolutely anytime.  
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Editing text baselines. 
 
I-Cliqq provides you with fascinating power over baselines. Because I-
Cliqq operates in Bezier , and Arc-Spline modes in general, you have a 
freestyle method of modifying baselines and nodes, in a manner that you 
can force on any specific baseline, changing the nature of its shaping 
capability. I-Cliqq baselines are not static, so you can add or delete 
nodes, and modify the nodes to perform as Bezier Curves, or Arc-Spline 
lines/curves. You can do absolutely the same thing to any outlines 
created in I-Cliqq, so you can experiment with these exact techniques, 
even on satin column outlines, runstitching, or tatami  outlines. 
 
It is essential to learn at least the basics of Bezier node editing, even if 
you prefer the simplicity of Arc-Spline mode , because most vectors, and 
clipart vectors from graphic programs do utilize this nodetype. Initially, 
many find Bezier  mode a bit daunting, but you will find that even if you 
do not use it as an everyday creation method, you can force it on arc-
spline ( or other ) digitizing modes, and really modify these curves 
quickly. 
 
Your general method of creation, may find you using many nodes in yur 
designs. I-Cliqq is designed to encourage you to create less nodes, so that 
even when you handle graphics, you’ll find the values of creating the 
least nodes. If you have used other software, you may also inadvertently 
have learned to try to create high degrees of ‘accuracy’ by using many 
nodes. This is in essence a myth, because all it really does, is strain your 
system resources, and can in fact give you shapes and curves that are not 
really conducive to ‘good embroidery shapes’. 
 
As you experiment with I-Cliqq  outline manipulation, and baseline 
editing, you’ll find that you can create great curves by practicing a few 
moves at a time, each day, and within a short period, you can actually 
become quite the wizard at manipulating outlines. While the manual 
introduces you to the basics, as you work, you will find that I-Cliqq 
contains a variety of different ways to achieve a similar end, with special 
ways suiting different operations. Sharing Tips and Cliqq’s ( Tips ‘n 
Trix)  is highly recommended, and your presence in the online forum will 
develop over time to yield informative and beneficial information. 
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To Edit a Baseline 
 
 

Use the  Outline Edit Tool (Edit & Digitizing Toolbar) to edit text 
curves/lines. 

  
 

Use the Outline Edit Tool  to modify  baseline shapes. 
 
 
 

 
Note: You can create absolutely any practical baseline shape. Take care in 
the shapes you create, so that it conforms to general practical embroidery 
shapes. Doing this will ensure you have the least corrections to perform if 
you have created awkward shapes. We all know that some graphics contain 
lettering that is not conducive to good embroidery, so  you have the power 
to modify as necessary. 
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A Default Text Creation 

 

 
Rest the cursor over a node, while in Outline Edit Mode,  hold 
down and drag it . 

 
 
 

 
Release at the desired new node point. 

 

 
 
The text will align to the new curve instantly. You can perform 
this on any node, as many times as you like, to modify the 
baseline shape. Double click on the baseline to add control 
nodes. 
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Text parameters 
 

Click Properties or press a e to open the properties dialog box. 
Select Text  to see text parameters. Change the parameters and click Apply 
or OK to apply the changes. You can also press Enter once you input 
values. The following are a few basics you can adjust in the main 
properties . Once you select any created text, you will see these, and 
related options in the tabbed pages. 
 

 
 

Auto kerning 
This can correct some kerning issues, but since embroidery lettering rarely has 

the exact space characteristics as graphics text, you may consider manually 
kerning the text. 

 

 
 

Letter spacing 
I-Cliqq provides the capability to change letter spacing by percentages. 

 

 
 

Italic 
I-Cliqq provides an easy way to italicize text. 

 

 
 

Bold and Thin effects 
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*Note : You may prefer changing the Pull Compensation value 
as opposed to using BOLD, as this gives you more control over 
the look. This is merely a suggestion, if you find you are doing 
designs that need constant variations. 
 
 
Text Controls. 
Text Controls are simple, and effective. I-Cliqq handles 
up to 4 color layers independently, without you having to 
Separate Text Elements, or break your text group apart 
unless you really need to. The controls act to provide you 
with smooth control. Once you Separate Text Elements, 
then you can handle individual letters, but you will not be 
able to kern it as was before separation. Overall, you will 
find text easy to manipulate, and control . 
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As you float your cursor over, you will see the icon 
change. 
 

 Hold Down on the control. Drag left. 
 

Hold Down. Drag left or right. 
 

Hold Down. Drag right 
 
These 3 controls also operate differently, when used with 
keys. 

 

 Hold Down v  Drag left. 
 

Hold Down v Drag left or right. 
 

Hold Down v Drag right 
 

This changes overall LETTER HEIGHT 
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 Hold Down q  Drag left. 
 

Hold Down q Drag left or right. 
 

Hold Down q Drag right 
 
This changes overall LETTER WIDTH 
 

 
 
 
Holding down v q together while dragging transforms 
height/width simultaneously. 
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If one letter is selected, you can hold down keys to perform sizing 
operations . The symbol now view is now a single symbol, although 
it looks similar to the kerning symbols. 

 

 
 

Selecting a letter or text string using Object Edit   
Allows you to perform the same actions as you would with any 
other created object. 
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An example of the diamond color split on 4 color text. 

 
 
 
 
 
 
 
 

 
 
 

I-Cliqq User Manual 508 



Multi color page 
 

 
 
The parameters in this page will effect on multi color fonts. If you select 
Sort By Color (Less Color Change), letters will be sorted by colors and 
you will have less color changes. You can also select a needle color for 
second, third and fourth color. 
 

 
 
 
Using the  Functions parameters page on properties dialog you can apply 
different functions and add a color change to each letter of a text object. 
 

 
 
You can apply color, and functions to single letters or text strings. 
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Position parameters 
The POSITION tab page will show you options. 
 

 
 

 
 

 
 

Both, Top and Bottom curve effect 
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Fixed and Auto text height 

Note: Auto Height will adjust text height according to curve length. 
Alignment will be dimmed in auto height mode. 
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Text alignment 

 
 

 
 
 

 
Rotate text effect 

 
 

 
 

Normal character appearance on envelopes 
 
 

 Click Select Envelope to choose an envelope 
for text. The Envelope selection dialog will open. 
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Rest the pointer on an envelope and click to select it and click Apply 
to finish. 
 

 
Selecting an envelope for text 
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Envelopes 
 

You can use pre-defined text envelopes or  create your own envelopes by 
editing text curves.  
 

Use  Outline Edit Tool to edit text curves and create your own 
envelopes. Disable Normal Character Appearance effect of text 
properties to fit characters inside envelopes. 

 

 
Normal Character Appearance checked. 

 
 
 

 
Normal Character Appearance Unchecked. 

I-Cliqq User Manual 514 



 
 
 
To save an envelope 

1. Select the current shaped text by using  Object edit Tool. 
2. Right click, a popup menu will open. 
3. Select Set As >Text Envelope…,  the text envelope save dialog 

will open.  
 

 
 

Right click to save text envelope 
 

 
 

4. Enter a name in File name field. 
5. Select Save. 

 
Now you will see the new custom envelope on the text envelope dialog. 
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To rename or remove an envelope 
 
Right click on the envelope on text envelope dialog box, to rename or 
remove an envelope. A popup menu will open, select to remove or 
rename the envelope. 
 

 
 

Right click to rename or remove an envelope 
 

• Select Rename to rename the envelope, rename dialog will open. 
Enter a new name and select OK. 

 

 
 

• Select Remove to remove an envelope. Remove confirmation 
dialog will open, confirm deleting by selecting OK. 
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Note:  Preferably, do not rename /remove program’s predefined 
envelopes. 

 
 
You can perform multiple edits . Remember to create 
practical shapes and be considerate of stitching when you 
envelope text. 
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True type fonts 
 

The Text tool lets you convert any installed true type font installed on 
your system to an embroidery object.   
 

 
 

To convert true type fonts 

 
Using true type fonts are similar to creating lettering using the  Text Tool. 
Click Properties or press a e to open properties dialog box. 
Select Text tab page. 
 

1. Select TTF (true type font) 
2. Select stitch type 
3. Select a true type font from font dropdown list 
4. Enter a desired text in text edit box. 
 
If you want to write in languages other than English, change the 
language from the taskbar and select language character set from 
properties dialog box. 

I-Cliqq User Manual 518 



 
The TTF’s installed on your system will preview. 

 
 
 

Select a true type font 
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Editing letters individually 
 

Select Arrange > Separate Text Elements to convert a text object into 
individual letter groups. Each letter would be relegated to a branching 
grouped object. You can edit, resize, move and remove letters 
individually. You can also change the enter-exit points of each letters. 
Your primary aim, should really be NOT to Separate Text Elements, as 
preserving your text allows you to change styles, baselines, and kerning . 
This feature is here, for when you absolutely need to break the text group. 
 
An example of such a condition is if trying to create a continuous run 
effect when separating Runstitch text elements, and you wish to convert 
eg. To Contour Stitch. 
 
When you initially separate the text elements, and there are more than 2 
objects in a letter, eg ‘A’, which is made of of 3 basic objects, then you 
will still see this letter as a group. To further break it to its individual 
objects, you can Ungroup the letter. 
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To separate text elements 
 

1. Select the text object by Object Edit Tool. 
2. Select Arrange > Separate Text Elements.  

The text letters would be relegated to separate branched groups. 
3.  

 
 

 
 

 
 
 
 
 
Note: The Text elements cannot be separated if Normal Character Appearance 
effect of text properties is not active. 
 
Press * to change only the entry-exit points of a selected letter: 
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Creating a new font 
 

You can create and use your own custom fonts. You may opt to import a 
complete range of characters of the font you want to create. We do this by 
creating a TTF text object and use it as a backdrop. This is very useful 
because you can import all characters at once without any extra process 
and you can snap to the text object which will help you digitize letters 
very fast and accurately. Then you will have to digitize letters using satin 
object because the program will make a branching of each letter to 
optimize entry and exit points. You can also digitize letters from specific 
image backdrops if you do not wish to use TTF outlines. It can be any 
hand drawn text or characters. Finally you can save characters into a font 
file you have already created. 
 
To create a new empty font file 
 

1. Select Tools > Compose New Font…, Create New Font 
File dialog will open. 
 

 
 

2. Enter a name in New Font File Name field. 
3. Select a character set from Language Character Set 

dropdown list if you want to create a non-English font. For 
example set it to Thai if you want to make a Thai font. 

4. Select OK to finish. 
 
Note: I-Cliqq only reads font sources on startup, so after creating a new 
font file, you will practically need to restart I-Cliqq. If you have installed 
TTF fonts while I-Cliqq is open, you need to restart I-Cliqq to see those 
fonts ‘registered’. 
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Preparing backdrop letters 
 

You can use graphic programs to create basic letters for using as 
backdrop for digitizing, but we suggest you use text tool to create TTF 
text object. In this case you have the advantage of saving this text object 
and use it to change the font style for making more new fonts. 
 
To create TTF text object as backdrop 
 

1. Select Text tool and click on design working area to create a bottom 
curve text. Change the text properties to TTF font and select a 
running stitch type then type all the possible characters in text edit 
box. And create all characters in one line. 

 
 

 
 
Change design working area size from Design Properties if the text 
is wider than design working area. 
 

2. Select Arrange > Separate Text Elements (in order to be able to use 
snap to each object when digitizing). 

3. Press G to group all objects. 
4.  Select Lock Object(s) to lock the grouped object in order to 

prevent it shifting by mistake. 
 

Now you can use this text object as a backdrop and start digitizing. 
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Digitizing letters 
 

Digitize letters using the  satin tool. You don’t need to worry about the 
digitizing sequence, because I-Cliqq will use branching techniques to 
sequence satin objects.  
 
To digitize letters 

1. Select satin tool 
2. Digitize each section of the letter 
 

Note: Consider overlaps and underlaps when stitches cover a section 
when digitizing. 

 
Consider overlaps and underlaps when digitizing. Avoid making large 

overlapped sections. You can edit as needed, in using keyboard lettering. 
 

 
If you create letters like above, with aligned nodes, you will 

have better results when sequencing. 
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Saving letters in font file 
 

When you finish digitizing letters, you should save them individually in  
the created font file. Whether you saved single, or multicolor text, you 
just need to save each letter with its colors to the font file. 
 
I-Cliqq also has the ability to save letters of differing color layers. 

 
If you created a font like above, simply select each letter,and 
save it. 
 
Before you start saving the letters in font file, set the design Zero Base 
Point to letters base line. See page 38 for how to change design zero 
point. If you set the design zero point on letters base line, you will not 
have to set the base line every time you export a letter to font file. 
 

 
Locate zero point (Y axis) on letters main base line to prevent setting base 

line each time save a character 
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To save letters in font file 
 

1. Select letter’s objects by using the  Object Edit Tool. 
 

2. Right click, a popup menu will open. 
 

3. Select Set As > Font Character…, character save dialog will open. 
 

 
 

 
Make sure you see all objects in the save preview. 
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Select font                Enter character number or Type it here 
     Spacing when  

   pressing spacebar 
 

  
 

Character base line on zero point 
           Character right and left margin 
 
4. You will see the selected objects view in the character display area.  
5. Set the right margins when using English. ( This determines the 

default letter spacing. 
6. Select Base Line on Zero Point to adjust the base line 

automatically. You will need to select this option once. If you have 
one line of text, its fine. If you have created multiple lines, but still 
want it on a zero baseline, then just set the baseline before saving 
the letters on the different lines.  

7. Select the font from Place in dropdown list. You will need to select 
the font file once. It will be remembered for subsequent letter saves. 

8. Select the character or enter character number 
9. Select OK to save. 

 
Note: To re-save a character in the event that you made a mistake, or are 
replacing  a character, simply save it again, and overwrite the existing 
character when prompted. 
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Word Spacing 
 

 Select Set Space Width to define the spacing 
between ‘words’ when you press x key. Set it to a distance 
about half of a character width because if the spacing is small value, you 
can press x . If you would like your word spacing to be 4mm by 
default, then enter this value once. 
 

Select Create Sample Bitmap, to create a sample for 
font preview when selecting a font. You will only need to create a sample 
bitmap once and it can be when you finished saving all characters. You 
can enter your own sample in Sample Text Field. A message will tell you 
if the bitmap was created successfully. 
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Created sample bitmap is displayed in font preview window 

 
Note: You can use a font in which you have not saved all the characters 
yet. Only the existent characters will appear if you create a text objects. 
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Importing characters from a font file 
 

.To import a character  
 

1. Select File>> Import, import dialog will open. 
2. Select Fonts folder from I-Cliqq installation folder. 
3. Set the File of Type to  Font Files (*.vfn). Font files will be listed.  
4. Rest the pointer over a font file and click to select it. 
5. Click Open to open the font file. Open Character dialog will 

open and you can choose which character to import. 
6. Select the character and Select Import.  
 

 
 

 

I-Cliqq User Manual 530 



The selected character will be imported into the 
workspace. 
 
 

 
 
 
 
You can then modify any letter, and save it again if 
necessary. You can use it for any other purpose. 
 
 
Creating a text baseline from a vector outline 
 
You can simply create any shaped text baseline using the 

Vector/Outline Tool  . I-Cliqq can then convert that to a text 
baseline. You can even paste a vector outline into I-Cliqq from 
any application that supports the Windows Clipboard feature 
regarding its vector copies. 
 

 
Once you create the outline, and its selected, you will see 
the conversion icon highlight on the Text Toolbar. 
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Once you click the icon, you will see the outline converted, 
and the icon will dim. It appears highlighted when you have 
selected a vector for conversion.  
 
Once you have created a baseline, you are ready to apply any text to 
that shape. 
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To create an offset baseline. 
You can also create a text baseline from a practical stitch object.  

 
1- Double click on a node, on one side of a satin object to select 

that ‘outline’ , then click on the  Offset Selected Path icon. 
2- Hold down the v key and move your mouse cursor to 

offset the outline. 
3- Click to set the outline, and press ESC. 

 
Note: If for some reason you wish to make multiple offsets, you can 
continue moving the cursor, and clicking, before pressing ESC. You may 
want to use these as guides, or to convert to stitch objects. 
 

 
 
Once you create the offset object, you can then convert that to a text 
baseline. 
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Changing Densities, Stitchtypes and Colors 

 
You can simply select any letter, using the Letter Select 
Diamonds (LSD) and apply changes in stitchtype, density, FX, 
or Underlay . Click on a Color Select Diamond ( CSD) to select 
all letters or a color, to apply overall changes. 
 

 
 
Once selected , you can apply a variety of possible effects, so 
once you have selected a letter, or letter string, you can 
proceed to experiment with everything from underlay, to 
density, to changing color. Changing a letter color, is exactly 
the same as changing an object color. Simply select a color 
from the palette. There is no real limit to the effects you can 
apply. All you need to do is be aware of things like the number 
of color changes you create, and the practicality of fonts with 
regards to the fabrics you stitch on. 
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User Split 
This feature is applicable to lettering, in exactly the same way as 
it affects any other wide satin objects. The power of I-Cliqq User 
Split , together with Stitch FX is probably the most versatile and 
powerful in the embroidery industry today. 
 

 
 

You can turn practice on the various effects possible by 
randomizing factors on the pattern bar. The maximum stitch 
length, is the length at which the stitch splits will ‘kick in’ on an 
object…so, if you set a value of eg. 5mm , then as soon as this 
length is exceeded, you will see the split effects active. If 
shorter, you will just see normal satin stitches. 
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Switch between Modes 
 

 
 
While letters or Stitch Objects are selected, you can adjust the 
patterns to create absolutely custom effects that will have your 
competitors gasping. No competitor will really be able to match 
your split effects, and after some experimentation, you may see 
that emulating such stitch effects is almost impossible. 
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Lettering Connectors 
 
The basis of lettering connection is the same as object connection. This is 
just handled differently, because of the text groups. 

 
 
When you select a text group, you will see the connector properties 
highlight on the Machine Functions Toolbar. 
 
 

 
 
By right clicking on a function icon, you will see the ‘Text and Groups’ 
tab open in properties. You can experiment with the settings while 
lettering is selected. 
 
See video for additional information on connectors. 
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The related connector information opens exactly the same as it does 
for Object Connectors, except these affect lettering. 
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Chapter 11 
 
Changing the Entry/Exit points on Letters 
I-Cliqq supports changing entry/exit points on lettering. There are also a 
few ways to create optimum running or custom running of keyboard 
lettering. There are also various controls to kern text, reshape it and 
modify lettering to achieve the specific look. While it may be rarely 
required, it is essential to move points sometimes. This may be in 
instances of fabric seams, or to avoid jumps or trims near other objects. 
 
 
You will see the entry and exit points of a letter string highlight in 

Outline Edit mode.  
 
 

 
The entry/exit points operate in a color mode, that tries to optimize 

for best view under differing color conditions. 
 

You will see these entry/exit points under two conditions.  
 

 
1- As above, in the initial state of Outline Edit mode. This allows 

you to change the Lettering Sequence, which we will cover next. 
2- When you change the entry /exit on individual letters 
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To Change Entry Exit Points on individual Letters. 
 

 
 

Select any text using the Object Edit Tool 
 

 
 

Click on a Letter Select Diamond (LSD) 
 

 
 

You’ll see the Object Select handles appear. 
 

To change to Outline Edit mode , simply tap the Spacebar or click 
the icon. 
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 Zoom in for such operations. You’ll see the above view depending on 
the letter you clicked. You are now ready to drag the points to new 
positions. 
 
 

 
Simply float the cursor over a point, and you’ll see the icon change. 
Hold down and drag , using the Left Mouse Button. 
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The action is the same for moving either the entry or exit point. You can 
move  or adjust as necessary. 
 

 
Once you release the point icon, you will see a new trim/jump 
indicator appear automatically, depending where you have placed the 
point. If you have placed it close to a letter, in relation to the next 
letter’s entry point, connectors will be active if set to connect 
automatically. 
 

  Zoom in to position accurately. 
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Sequences 
 

 
This is a normal sequence of stitching. 1-7 

 
I-Cliqq allows you to change lettering sequences on the fly, Simply drag the entry point 
to a new position, and the sequence of stitching will change automatically, so let’s say 
you have to change this lettering to a cap design, and you’d like the lettering to stitch 
from the center outward :  
Just drag the entry point to the preferred start. 
 

 
The entry point is now positioned at the center. 

 

 
The sequence will change onscreen immediately. If you now travel by 

stitches, you’ll see the numbers stitch in the above order.  

 
 

Properties will show you the default Sequence A 
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Sequence B 
 

 
In the same lettering, while its selected, click on Sequence B. 
 

 
The new sequence will now stitch in the above order. 

 
You can switch between sequences at any time. 
 
 
 
To Revert After Moving Entry/Exit points 
 

 
Original Text 

 
Text After all exit points modified 

 
Any New text string created, will always be in default Sequence A, if you 
change the entry/exit on a text string. 
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The Power Of I-Cliqq Sequences 
 

 
You can test the sequencing power of I-Cliqq by relocating the entry and 
exit points to any letters, then travel on the stitching sequence. You can 
also switch between Sequence A, and Sequence B . Each time you move 
the entry/exit points, the sequence will update instantly. Whether you 
want the lettering to start at the center, or in an off-center position, you 
can do this in a few moves. Cap designs sometimes require an optical 
center, rather than an absolute center, or you may just have layouts that 
require such treatment. You may initiate such actions for balanced 
stitching, or reducing pucker. Whatever the situation, you can empower 
your stitching with a practical sequence. 
 

Just select the text in Outline Edit Mode,  and drag the entry/exit 
points.. Its that simple. Practicing on a few lettering strings, will allow 
you to familiarize yourself with the possibilities and practicalities of 
your actions. 
 
Note: You CANNOT place the entry/exit points on the SAME letter. 
For sequencing to occur, these must be on different letters. 
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To revert the modified points, check Entry/Exit Points tab in 
Properties. Select the modified text, see that the settings are shown 
as in the image, and click APPLY. The lettering will revert to as shown 
in ‘Original Text’ You can really drag the entry/exit points at will, but 
if you want to just revert the points, this action reverts it. 
 
Modified exit points will be active even if you modify the baseline, as 
long as you have not changed the text. In general, you have no need to 
really modify the exit points, because the default text will always be in 
closest point connect mode. 
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About Entry/Exit Points. 
 
You need to understand the slight difference between the action of 
entry/exit points on a ‘Text String’ , and an ‘individual letter’ , and then 
your understanding of entry/exit points is complete, and modifying these 
will be simple. The exact operations are possible on any stitchtype 
supporting entry/exit points, so the same logic of entry/exit points run 
throughout the software. 

 
A text string is basically a word, or word set that you type into the 
text box. 
 

 
An example of entry/exit on an individual letter. 
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Entry Exit Point on a few Stitch Objects 
 
 
 

 
 
As a designer, you have the  maximum control over engineering a 
stitching sequence, to provide the most economical and smooth 
running stitch files. By understanding the entry/exit modifications, 
you can change sequences, modify these points if you move objects 
and correct a variety of conditions that may appear in embroidery 
tasking. 
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Chapter 12 
 
 
Changing the Color of Letters and dealing with Color 
 

 

Select text using the Object Edit Tool  
 

 
Click on the Letter Select Diamond (LSD) 
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You can click the arrows, and the selected letter , text or objects will 
change , or just click as shown below to open the color palette. 

 
 
 
The new color appears as selected. You can do the same for other 
letters. 
 
 
 
 

 
 
Click as shown to open the palette, and select the new color. Click it. 
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These are just preset screen colors, that you can change at absolutely 
any time. If you eyedropped a color, the palette will update the selected 
color instantly. 
 
 

 
 

Selected Color is Green 
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Updated Color Palette 
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Modify Palette Colors 

 Click to open Design Properties, and select the ‘Needles’ tab. 
 
You can also modify background color and related parameters in the 
‘Background’ tab. 
 
 

  Click on any color while a needle # is selected, and you can 
change it on the Color Slider. 
 
 

 Move around by dragging to change a shade. 
 
 

 
 
 
If someone has sent you specific RGB values, you can set a color 
exactly 
 

 
 
If you use the eyedropper tool, you’ll see that I-Cliqq features 
RGB/HSB detection. 
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 Click to set the color of object outlines. 
 
 
 

 

 
Selecting a color to view object outlines. You can change at any time. 
Selecting ‘Non-Needle Color’ will just allow I-Cliqq to randomize 
depending on different background colors. 
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Change the color of outlines in Properties 
 
 

 
 
Change the solid fill colors if you created closed curve outline types. 
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Selecting a Color for an appliqué view. 
 
 
 
 
 
 
 
** Note: The I-Cliqq Color Manager is very advanced, but indicating all 
color levels does pose a few limitations. Displaying color within a multilayered 
group is considered extreme complexity, which is why you will rarely, or never 
see any color manager similar in capability to the I-Cliqq Color Manager. The 
color manager attempts to indicate color correctly even when text is re-colored, 
but operations such as ‘re-order by needle color’ are not available when 
handling lettering. 
If text is separated, or you are handling normal objects, the display of color is 
very accurate, but when keyboard text has color changed, you need to be aware 
of some limitations. 
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Note how the indicators reveal 3 blocks in this instance. 
 
 
If you have changed a letter color, and its followed by an ordinary 
stitch object, you will see the color indicator display 2 color blocks. 
This indicates and highlights your selection. In such instances, you 
should remember that the ‘split color blocks’ which are noticeably 
smaller than the normal color indicators actually still indicate ONE 
color if you check File>>Design Information. 
 

 
 
If you export as a dst, dsb, zsk or other machine filetype , you will 
find the actually physical sequence is correct. This level of color 
operations are to assist you when working in the native CLQ file 
operations, and native design creation. 
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Because of the complexity of some group, text and color 
operations, and because embroidery tasking  handles 
actual ‘machine functions’ unlike simple graphic 
operations relating to print, you need to be aware that 
some color  operations may not seem to  appear in 
perfect logic or to absolute expectation each time. This is 
not a software ‘error’ , but a known limitation regarding 
some impossible conflict resolutions. While you simply 
need to be aware of this, there is no need for concern as 
your actual thread sequences remain intact, and exact. 
You can check this at any time by looking at the design 
information, or checking a Print Preview. 
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Density ( Stitch/Row Spacing) 
 
Density is generally the number of stitches over the length of a 
column in satin columns, or the spacing between rows in a tatami 
object. It is usually referred to as ‘stitch density’ or ‘stitch spacing’ . 
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There are various effects you can apply by just selecting a few 
styles,and applying to overall text strings, or individual letters. Not 
every stitchtype will apply effectively on every font, but you really 
have unbridled access to numerous effects and density or underlay 
changes on lettering. These apply exactly as they would on other 
created stitch objects. There is no difference to the manner in which 
the Properties parameters effect on selected objects. Whether you 
created satin columns, or tatami shapes using absolutely any 
digitizing method, once you get acquainted with the Properties Box 
and experiment with parameter changes, you will be able to modify 
any objects’ parameters with relative ease. Changing color, and 
modifying stitchtypes  go hand in hand, so you can really experiment 
with effects and color at the same time. 
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A Note on Metric Measurements. 
 

 

 

 
 
The 10 units that compose 1 millimeter, are what you will generally 
see as defining the density input in I-Cliqq. 
 
In the image, let’s say you look at 2cm. 
 
Between 2 and 3 cm , you will read each of the bars as: 
2.1mm /2.2mm/ 2.3mm ---on to 2.9mm and 3cm will follow. 
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The 10 parts of 1 millimeter are comprised of : 
0.1mm 
0.2mm 
0.3mm 
0.4mm 
0.5mm 
0.6mm 
0.7mm 
0.8mm 
0.9mm 
1.0mm follows this decimal indicator of zero ‘0’ :commonly , its called 
1mm 
 
So, if you have 3 millimeters, and 4 parts of a millimeter, it 
would read as 3.4mm 
 
You will see Pull Compensation default at 0.2mm. 
This is 2 parts of the size of 1millimeter. These are very small 
increments. Its easy to remember, because it increases ..so, if you’d 
like your pull compensation to be more, you would key in eg 0.4 or 
0.6 and you will see that factor increase. 
 

 
 
The smallest parts of the bars, which are very tiny increments are 
what you may see referred to as 0.45 with the (5) part being 5 parts 
of the very small increments which are again just in parts of 10. 
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The metric system of density is simple and accurate. 
 
0.6mm is considered 'low density' 
If you input values like 0.5 mm/ 0.6 mm/ 0.7 mm /0.8 mm/ 1mm/ 
2mm etc. you will see very light filling. 
These densities are used on light fabrics like silks or leathers. You can 
also use similar densities on cottons, depending on your designs. 
 
 
0.4mm is considered 'normal density' 
0.39/ 0.38/ 0.37/ 0.36 mm 
/0.35 /0.34/ 0.41/0.42/ 0.43 mm 
These will give you normal type of filling...used on most fabrics like 
cottons etc. 
Values between 0.36 , and 0.4 will be fine on piques, depending on 
your designs. 
 
 
0.2mm is considered 'high density' 
Some use values of 0.2mm to perforate foam. Some cover with 0.25. 
Some use Double Zigzag underlays at 0.5mm, and cover with satins 
of 0.33mm . Densities are relative nowadays, and you can have 
reduced densities depending on the stabilizers used, and the number 
of stabilizer layers. 
 

• Note 
These values will always be RELATIVE, depending on 
the type of thread you are using. Thicker types of 
threads require lower density.  

• Thread types with very thin filaments will require 
higher density  to provide good coverage. 

• The average cones used on embroidery machines are 
normal weighted threads. 
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Chapter 13 
 
Creating Vector Lineart in I-Cliqq. 
 
You can create your own lineart in I-Cliqq. Additional uses of the 
Vector/Outline Tool are creating quick guidelines for your work, without 
really having to use the grids/guidelines or you can really use a 
combination of features if it suits you. You can change the width, color, 
have closed or open curves, and really manipulate the outlines in any way 
you prefer. 
 
Most tools in graphics programs utilise BEZIER MODE. Most people 
actually take a while to learn, and for many it remains a totally daunting 
mission. For this reason, I-Cliqq also allows you to create outlines in any 
of the digitizing modes. If you feel comfortable to create your artwork in 
left, or right clicks, you can .  

Simply select the Vector/Outline Tool.  
 
Using the Vector/Outline tool can assist you in creating accurate 
guidelines, even over bad artwork...so it really has numerous uses in 
many different situations. 
 
Artwork for embroidery purposes, usually just requires closed curves, or 
simple outlines. If you prefer to create your line art in I-Cliqq, because of 
the varying , and simplified creation methods, that’s fine. If you want to 
apply special effects or need to use the art for more graphic applications, 
you can just Copy, and Paste your art into any program that supports 
Windows Clipboard capability. 
 
There is no real limit to the intricacy of line art that you can create. Take 
some time to experiment with the Vector/Outline and Shape tools. 
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Create Shapes 
 
 

 
 
Select the Vector/Outline Tool. 
 

 
 
Select a Digitizing Style. Try Arc-Spline Mode first. Actually, once you 
select the Digitizing Mode, it will remain in that mode unless changed, 
or a Bezier, Arc, or Spline  created object has been selected. 
 

 
Click onscreen using left/right clicks. 
 

 Click this icon if you enjoy the alternate mouse button actions. It 
will swap the current left/right actions. 
 

 
Continue creating your shape. 
Press e to end at any time 
You can also press s 
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To  create a CLOSED CURVE, simply click on the initial node. 
 
Press e to end the first outline, and continue to make another as 
part of that outline group. 
 
You can also press s  to exit that mode, then create a totally 
separate outline. 
 
Pressing e is however very fast, and practical. You can create 
multiple vectors that will appear as one group. Once you convert 
that, it will separate into individual objects. You can use this if you 
intend converting it as one outline..eg if you created a vector to use 
as a redwork design. 
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As you get fluent, or if you wish to experiment, you can seamlessly 
select other digitizing methods, and try out the different actions. 
 
 

 
 

If you receive really bad art, you can create quick vector guides, if its 
not possible to really vectorize well, creating accurate guides for a 
backdrop. 
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You can convert vector outlines to numerous different stitchtypes. 
 
 

 

 
 
You can even convert a vector to an editable normal satin type. 
You can experiment , but be cautious as you create curved shapes. 
Some may require additional editing depending on how the initial line 
was created. 
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Closed Curves can be converted to tatami shapes. 
 

 
 
If you assigned a solid fill color to a Closed Curve, converting it to 
tatami will render the fill color as tatami, and the outline color will 
default to a runstitch outline…so, the conversion in this instance 
converts the outline, and solid area. If both are the same color, you 
will just see a tatami fill created. 
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Generally, you will find multiple uses for the Vector/Outline tool, 
whether its creating art, outlining lettering or objects, using the lines as 
additional guides, creating shapes, making appliqué cutlines to export or 
copy to graphics programs, extracting outlines from embroidery designs, 
or absolutely any use you can find for vector outlines. You can use your 
line creations for absolutely any application, whether its vinyl cutting, 
engraving or guides for rhinestone creations. 
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Chapter 14 
 
Stabilizers  
 
As you all know, and see often, stabilizers are not what they used to be 
years ago. Its now all very specialized, and a good degree of research 
goes into how stitches can be held, and how the stabilizer will hold up in 
washes etc. If you are an ‘old school’ digitizer, you may lean towards  
settings on edge run, zigzags and centerlines combined etc, without 
realizing that backings today make these less 'pressurizing' on a digitizer.  
 
You may end up spending a lot of time messing with just the right 
settings for all that, when generally, because of a certain stabilizer, you 
may just need a simple center run underlay, with a few manual bits in 
strategic places. So, overall, you can get a really good design with the 
least stitches. On your first run, you can really just add in a bit of density 
if you have to. Nowadays you see seminars and webinars on 'stabilizers'. 
In years gone by, you'd just use tearaways or cutaways and the game was 
over. Now, you can get many variations of new types, so your digitizing 
can also be more fluent than it used to be. 
 
 
This does not mean you must not use underlay as you know it to be, 
it merely means, you may have to change with the times and modify 
your design perception and capability slightly. 
 
 
There are numerous types of stabilizers now available. Many companies 
deal with stabilizers and research . 
 
Thread, Thread Age, Bobbin Tension, Upper Thread Tensioners, 
Stabilizer, Design and Operator knowledge of speeds, needles, 
settings, and general care in hooping all go into creating productive 
designs. 
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New Technology Digitizers 
 
You may consider yourself a puncher, and the hunt is on for new names 
today as many believe that software will soon replace the embroidery 
design programmer, or digitizer. Perhaps we they will become 
‘automizers’ or ‘stabitizers’, or perhaps ‘digilizers’ ! 
 
I-Cliqq , allows for you to expand your horizons. When you see designs 
so dense with underlays, you have to really wonder what the bottom line 
is really about. Today, as mentioned, the latest stabilizer technology 
really means that you can streamline your use of underlay, and actually 
still produce great embroidery. 
 
 
The following are excerpts courtesy of Lebow Consulting.  
 
Embroiderers today have it so good. Fast yet affordable 
machines, high-tech framing devices, and other advances 
have made a decorator’s job easier than ever 
before. But there’s another critical area that has seen 
equally impressive developments throughout the years, 
even though it doesn’t get as much attention and that’s 
stabilizers. 
 
With very few exceptions, stabilizers provide the foundation 
for all commercial embroidery. They have come a 
long way from the earliest versions, which were borrowed 
from the apparel manufacturing industry. In those 
days, the most commonly used versions were stiff interlinings 
made out of materials like horse hair and canvas 
for lining pockets, collars, and coats. In addition to being 
stiff, they often were scratchy and rough against the skin. 
There is no comparison to the soft stabilizers available 
today. 
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The introduction of specialized, commercial stabilizers in 
the late 1970s was of great significance to the burgeoning 
embroidery industry and played a role in today’s 
widespread acceptance of embroidered goods by the 
public. This new generation of stabilizers improved registration 
significantly. They draped better and were much 
softer against the skin. Instead of a stiff board behind an 
embroidery, you had something that was not visible to 
the eye from the front of the garment. Another plus was 
that embroiderers had a material that was the perfect 
weight and thickness. They no longer had to use multiple 
layers, which often added unsightly bulk to a design. 
These new materials saved time because they were 
quicker to use and money because you needed less of 
them. 
 
The Manufacturing Process 
 
The biggest breakthrough in embroidery-specific stabilizers 
came about when a new manufacturing process was 
developed called wet-laid. Sewing interlinings are made 
with a dry-laid process and includes two types: carded 
saturate or random. This produces a one-directional 
material, meaning it stretches in one direction. This 
works fine for interfacings—but is not ideal for embroidery. 
The wet-laid process is similar to how a high-quality paper 
is made. Fiber is dispersed in a solution. A screen 
rises and the solution dries yielding a multidirectional and 
uniform nonwoven material. 
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This new wet-laid process was ideal because the goal of 
an embroidery stabilizer is to help achieve proper fabric 
tension in the hoop. It should be taut, like a tambourine 
skin, with the tension spread evenly in all directions. This 
is called multidirectional or nondirectional tension. If the 
stabilizer is too loose, the needle deflects and design 
registration is adversely affected. Wet-laid stabilizers do 
not stretch in any direction and provide a smooth, uniform 
surface. 
 
Initially, this thin, wet-laid, nonwoven material was used 
for pocket welts, but it was soon discovered to also work 
well as an embroidery stabilizer. The first version, which 
was made by International Paper, was a 1.5-ounce cutaway 
that included silicone, which aids in needle glide. 
This density was suitable for medium to low stitch counts 
and was soon followed by a variety of additional weights 
for other applications. 
 
These are just a few of the many developments that 
have taken place in embroidery stabilizers over the 
years. It would be difficult to mention them all. But the 
age of innovation and the development of new products 
are not over. Look for suppliers to continue making progress 
in stabilizer technology, including different types of 
fusibles and other specialty products that will help embroiderers 
decorate an even wider range of products 
more easily and with better results. 
 
Biography 
Fred Lebow has been developing nonwovens and 
interlinings for the sewn products market for 31 
years. For the past 20 years, he has focused on 
embroidery stabilizers and has been a pioneer in 
the development of many new products that are in 
widespread use today. 
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Chapter 15 
 
Expanding your digitizing capabilities. 
 
If you attended classes at any time, you’ll probably be familiar with 
thoughts like: 
 

• Didn’t he just say these stitches should be angled this way? 
Suddenly its another? 

• I don’t get it! A minute ago I heard that such a satin column 
must have diagonal underlay! 

• I’m ready to pull my hair out, I’ve tried this 10 ways, and 
nothing works! 

 
If you have these thoughts less frequently, then you have entered a 
comfort zone, and you’re now ready to take your digitizing to the 
next level.  
 
Getting Started 
 
 The example silhouette, is just a random image. It’s a medium 
quality jpeg, which may be considered mediocre art. I-Cliqq allows 
you the basics for image manipulation, but depending on the image 
condition you may require more extensive editing. 
 
 
 
 
In Tools > Preferences> OPTIONS: 

 
Select the browse button to access an image editor. You will need to 
find the location of your preferred editor and click on that exe file to 

select it as the default image editor. 
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This will access your assigned image editor. You can modify the 
image, and when saved in the editor, the modified image will 
automatically be returned to I-Cliqq. It merely depends on what you 
intend to do at the time. Some images require no editing, and you 
can start digitizing immediately. 
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Work with an actual size image close to the digitizing backdrop image to help 
you visualize the actual scale when you view at 100%. Use your ruler tool to set 
effective dimensions. 
 
Effectively visualizing, and working in practical screen color reduces 
eye strain. You may receive art in the strangest forms, and not all 
artwork is readily available in vector form, so quickly assessing what 
may be necessary to perform your task prevents you from losing 
time. There is huge hype over what format art should be tendered in, 
and numerous times art is sent in formats that are either difficult to 
read, or has people hunting around for ways to convert it to a 
readable format. The runaround can cause time loss, and really put 
you under pressure, so making sure you request your art in standard 
formats is essential. Even when dealing with corporate, you are 
usually dealing with HR managers or receptionists who really just 
want the job done, and are not interested in the nittygritty of 
‘formats’.  
Most are familiar with jpg, bmp or pdf formats. The issues usually 
come in with ‘vector’ formats. You can request EMF ( Enhanced 
Metafile) . Why should I? The reason is simple. It’s usually all you 
really need, and can be viewed in any email or by standard Windows 
™ viewers. 
 
 
Popular graphics packages easily export this format. If your 
embroidery software imports vector files, simply import and you’re 
ready to begin. This example shows an ordinary bitmap image. 
Generally, its good to work 10-15% bigger than the actual finished 
size. Again, this is relative to the type of design. In this instance it is 
not a very complex design so even 50% larger can be reduced with 
limited adjustment required. In more complex designs 10-15% larger 
allows you to downsize to the finished size giving you enhanced 
accuracy. You can also work in 100%  image mode where practical. 
 
Even relatively simple looking art can present complexity in digitizing. 
Bridging the gap between knowing inches and the metric system 
constantly frustrates many digitizers, but quickly sizing your images 
is essential to get you off the mark fast. Setting up grid and guide 
parameters is usually an excellent assistance. 
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An example of resized art. For the purpose of this demonstration, we’ll just create a 1-1.5 
inch high eagle. 
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Select the image to be resized. You can do it easily using Object Edit 
or by accessing the I-Cliqq Pro-Edit functions. 

 
 
If you don’t have vector art, you might consider sectioning off the art. 
It does help to be slightly artistic as being a digitizer usually means 
you have to be able to touch up, recreate and modify artwork fast, 
and even present clients with modified artwork before digitizing. A 
vector trace can assist you. Being able to ascertain design pitfalls, 
and presenting optimum solutions before going ahead with designs is 
essential to avoid time wastage . A high percentage of clients may 
not really notice modifications you make, but you can be sure that 
everyone will notice if your result is bad. Be confident , and upfront 
about what modification is necessary to make a design work. You will 
get forceful and insistent clients, but letting them know what is 
practical in advance,  and being plain about costs to redo designs 
contrary to your advice will serve you well in the long run. Personally, 
I create many designs where a client says ‘my customer insists that it 
must be the same as this image’ . 
 
You might call it ‘digitizing license’ but I believe that it is an 
imperative for a digitizer to exert such influence over the design 
process, as is practical to the outcome of the embroidery stitching 
process. 
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An example of the bitmap vectorization window in CorelDraw © 
 
Most advanced graphics programs allow successful vectorization, but 
from an embroidery perspective, not all that’s vectorized is gold! Be 
sure to always try to obtain the least nodes in vectors, and you will 
be overjoyed to know that editing vector outlines will then not take 
you all year. Most find the Bezier Style common to graphics programs 
quite daunting, but learning to edit and manipulate outlines is simpler 
than graphics creation for many. 
 
Depending on your embroidery software, you may have drawing and 
shaping tools to allow you to create or modify vectors. The ability to 
manipulate outlines allows you to modify your backdrop. 
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The condition of vector imaging can vary. A point to remember: 
Always try to create the least nodes, in your designs, and when using 
vectors. Digitizing styles in I-Cliqq do try to force you to some extent 
to create less nodes. You may notice this when you attempt digitizing 
nodes close together at different zoom levels. This is not a fault, it is 
merely I-Cliqq cautioning you that your node placements are unduly 
close. 
 
Modifying and manipulating vectors within a graphics package will 
require you studying that package manual. 
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Node Reduction in graphics software 

There are various graphics packages that allow for advanced image/vector 
manipulation. The above is an example from CorelDraw™. 
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Almost ready to digitize… 
 
 Modify the shape, and add in technical guides for yourself. If you 
found yourself sold on converted vectors materializing into excellent 
embroidery in a click, you may find a degree of disappointment in 
attempting more than simple designs, without being fully conversant 
in outline manipulation, and on average that means being familiar 
with the Bezier mode  of most graphics programs. When you look at a 
flat piece of art, like this eagle, you really need to see some ‘form’ to 
assist you in digitizing, so practice ‘creating’ to the best of your 
ability. Creating designated sectors will not only simplify your work, 
but also allow you to complete designs faster, and still give you a 
better end product. If you do decide to create the design while 
bearing ‘ possible future edits’ in mind, then you have lessened your 
workload today, and tomorrow. 
 
 

 
Graphic  Creation within I-Cliqq Embroidery Software 
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Enlarged wingtip section 
 
Note the blurred background art. Modifying your artwork before 
beginning can really also just avoid eye strain, and struggling to judge 
segmentation, when no guide exists. You don’t need to spend all day 
creating the art…just a few quick linear guides can really save you a lot 
of time when doing your actual digitizing. 
 
Modify awkward sections in art, so that you can create it easily. 
Remember when zoomed in, on very small designs, trying to create 
sections with high accuracy is really just time wastage, and positioning of 
unnecessary nodes, because factually at a 1:1 scale , the time you can 
spend on creating a very accurate curve shape, can really translate to 
‘nothing’ . 
 
Many spend countless hours on trying to be ‘exact’ and trying to operate 
with engineering precision , when embroidery is actually more about 
‘targeted accuracy’. This means, yes : accuracy is necessary , but you do 
not need to be as precise as microscopic fractions of unit measurements. 
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Complete Quick Guide Vector Outline in I-Cliqq Embroidery Software 
 

 
Your modified artwork may look something like this. Recreating the 
outlines quickly removes the irritation of working with a grainy image. 
As a ‘next level digitizer’, you need to be able to work with what a 
client provides. Not all have the luxury of receiving vectorized art, 
and demanding that type of art from clients also puts them into new 
financial territory. As a digitizer, you also need to hone your skill sets 
in the related field of graphics, because contrary to what many think, 
it is an essential, in the field of digitizing. Besides speeding up your 
work when you have reached a reasonable level of proficiency, you 
will find that it can usually set you apart from competitors that lay 
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such demands at the feet of clients. The truth of the matter is, clients 
have no real interest in what goes on behind the scenes, and all they 
really want is to just get back a design. You are not required to be 
Picasso, you just need to fine tune your skills to take care of some 
basic artistic building blocks. 
 
Having a bit of foresight, generally means never having to worry 
about hindsight. Every design you create will require a varied 
approach, and sometimes even the initial design you created will 
require quick modifications. From the very outset, you need to create 
the design architecture in a way that allows you to easily modify. 
 

 
Vector View with the Original jpeg deleted. 
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Recreating your guide outline should take 5-10 minutes if you have 
no further  purpose for it after digitizing. If you decide it will be used 
for print or engraving purposes, you can spend longer to refine it, and 
save that vector file. Once you have a clearer visualization of the 
image segmentation, you are immediately capable of an enhanced 
digitizing result. Strangely enough, the degree of complexity with 
small designs can in many ways be higher than larger designs, and 
creating depth and appeal even with tiny details is what helps set you 
apart from competitors. The initial minutes you spend on preparing 
your art, ensures that you save time in digitizing. Working without 
effective guides, can really cause you to zoom in/out , struggle to find 
definition, and create unpleasant shapes, only to find you need to 
redo parts to correct that. Although I-Cliqq offers you extensive 
power, no digitizer likes to go back and forth on the same objects.  
 
Yes, digitizing is fun, but its is also very tedious and painstaking work 
at times. I-Cliqq ,while not providing every tool yet, does take some 
degree of frustration out of digitizing. There are multiple fine details 
in I-Cliqq that actually become part of your peripheral vision as you 
work. You will notice many tooltips in play, and also many color 
indicators that change as you select colors of object groups. 
 
 
 
Let’s start digitizing… 
 
This simple eagle, may not be as simple as it seems to many 
digitizers, especially if you just received the flat black art as initially 
shown. 
 
Considering we decided the initial size will be relatively small, you can 
consider digitizing a part for a lighter weight thread with a finer 
needle, and continue the rest of the design for normal thread. This 
can ensure a sharpness on finer details. 
 
You can prepare any special density settings from your digitizing 
templates, or just set them as necessary. Now the you have guides to 
your art, you can really fly with your digitizing work, and zoom in at 
will. Vector outlines have 100% clarity in any zoom mode. 
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Change outline widths while any line is selected. 
 

 
 

You can also color vectors in solid, or hatched modes to improve your 
visibility if creating color fill areas. 

 

I-Cliqq User Manual 590 



 
 
Now that you have a vector guideline, you can zoom in or out without 
worrying about a grainy image, and clarity issues while you work. Ten 
minutes of pre- digitizing preparation can save you lots of time in 
your actual work. Creating vector guides in your work for absolutely 
any other reason is also practical, so while you have the benefit of 
gridlines and guidelines, you should create additional lines as 
necessary. Your software may include information tooltips that show 
you the exact length and angle of stitch placements, which is 
excellent for digitizers that constantly work in high zoom factors. 
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Sections with lighter weight thread/finer needle. 
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 You can complete the rest of the design in a normal weight thread. 
 

 
 

You now have a 2 color design, that will now run as 2 cone colors of 
the same shade, just different thread weights. 
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Your design is now complete… 
 
 

 
Your finished design may resemble the above ‘stitch representation’. 

 
 

 
 

At the end of each design, you should usually check that Autoset 
Center is ON, and always view the design to see that the indicators 
are positioned centrally, or custom positioned as you may decide. 
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You may make numerous modifications to the amount of detail you 
decide to use. Again, this is relative to the sizes you work with. As 
you go smaller on design sizes, its prudent to keep the design as 
simple as possible, so eg. Although the eye is doodled into the 
graphic at a small size, there is no need to really depict that in a 
simple embroidery, although it can actually be shown depending on 
the thread weight used. The design size will ALWAYS determine how 
much detail you can allow. Learning this comes with time, and 
practice, and watching many designs sew out. Essentially, before you 
attempt advanced digitizing, its prudent to spend many hours 
watching other designs stitch out, so that you have a practical visual 
in you mind of what may occur on a machine. Doing this constantly, 
will assist you in your onscreen creations , and increase you ability to 
edit design outlines effectively. 
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Possibilities 
 

 

 
 
This is a simple example of what you can do with just the initial 
vector trace, with no real modification. The conversion takes a few 
seconds, but editing the ends of the fill areas to compensate for the 
push, and pull on fabric can take a short while. As you can see, the 
results of conversions, are only as good as your art preparation is. As 
a digitizer, you need to quickly determine what the extent of the 
vector creation means.  
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Using I-Cliqq’s pattern capabilities, you can apply numerous effects. 
 
In many cases, backdrop images are discarded, so deciding what 
possible merit creating an initial vector may have, is paramount to 
whether you maintain your bottom line. It’s pointless going into 
sometimes tedious operations of vector conversion, editing your 
vector, and modifying it only to use as a backdrop that you’ll just 
discard anyway. It is only useful to spend time creating a vector if 
you have a specific additional purpose, which may be a vector graphic 
that you’d like to use for print purposes, laser engraving, a vinyl cut 
or any other purpose that may specifically require fine tuned vector 
art. 
 
As with most interpretations of artwork, the approach taken by 
various digitizers will vary. The semblances however, should be 
similar to give you the best quality small design. This is just one 
example of an approach to a design. In embroidery, absolutely every 
design may require a myriad of modifications and inspection, in 
relation to its position, fabric, stabilizer, thread type, stitch angles, 
stitch types, machine tensions and speeds. Practicing on a new type 
of image each few days will assist you in practical segmentation 
before digitizing. With each attempt, you will find that you will begin 
to work much faster once you create the initial areas to digitize. 
Constant practice will also teach you that every design does require a 
unique approach, and while many may try to categorise settings, or 
maintain a single approach to what may ‘seem’ similar, it should be 
remembered that in embroidery, almost everything is ‘relative’. 
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Selecting and applying underlay to the various segments you created 
is easy. Remember that you have to consider your fabric type , 
possible overlapped embroidery sections, and your stabilizer type n 
use. Some objects really require no underlay and although you may 
see this in many designs, most times its usually totally unnecessary 
and only serves to push up a stitch count. Remember those 
sometimes ‘bulletproof’ embroideries  you hear about? Excessive 
underlays are usually among the causes. 
 
Something very difficult for many to accept, is that underlay has now 
become an aspect that should be viewed ‘strategically’. Why have 
1000 , 2000 or more stitches unnecessarily ? It may mean nothing in 
running 1-2 pieces, but when your production is in hundreds or 
thousands, you are sure to feel the bite in not only your bottom line, 
but in ‘time loss’. 
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Even experienced and advanced digitizers tend to veer away from 
what may be deemed ‘automatic’ features in software. In many 
instances this does make good sense, but technology can also be 
embraced , and used at relevant points in the design process. The 
fusion of digitizer skill, and software capability does lend itself to 
enhanced output. Contrary to what many may feel, all embroidery 
software does not do ‘the same thing’ Different digitizers also have 
varied approaches, so neither are digitizers the same.  I would tend 
to agree that many offer similar seeming feature sets, but these are 
always subject to the requirement and capability of the digitizer. 
Enhancing your capability actually  does depend to some degree on 
the software you use. Taking your digitizing to the next level is 
actually quite an interesting journey. Enjoy it! Along the way, you are 
bound to find the many myths exposed in the wash, and also find 
techniques and processes that you didn’t even consider, that can 
speed up your design work, and the all important bottom line. 
 
 
 
 
 
 
 
Learning to use all the features of I-Cliqq will take you some time, as 
different logic, will apply in different design situations. As the I-Cliqq 
feature range increases, you will also find your creative power 
becoming more dynamic, and productive. 
 
http://icliqqdemo.ning.com/ 
 
Even as a user, you may find it useful to join the I-Cliqq Public 
Forum. This is merely a matter of preference, but you may also find it 
useful for making new contacts, and advertising your business. 
Remember this is an open forum, and while I-Cliqq can take no 
responsibility for comments made there, we will moderate it if 
complaints are received. 
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Chapter 16 
 
I-Cliqq Pro Edit Features and I-Cliqq Object Stream 
 
These two aspects are advanced forms of edit and selection . All the Pro 
Edit functions are very similar in operation. You can attempt each and 
discover its capability in a few minutes on each aspect. 
 
 
(Note: You can hold down Ctrl while dragging an axis line, and you 
can have the axis of lock at 90° or rotate it in increments. If not 
pressed, you can move the axis in a freestyle manner.) 
 
 
I-Cliqq Pro Edit 
 

 
 

Right click on any selected object to access Pro Edit capabilities. 
The flyout will open and you can choose the desired function from the 
PRO range.  
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You can also go to Edit>>Pro Edit 
 
This range or features offers you advanced, freestyle or accurate 
transformation modes. These are excellent to accurately perform 
each of the listed functions. 
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Pro Edit Resize 
 

 
 
Right click an object or selection set, and click on Pro Resize. 

 
The mouse pointer will change to the shown indicator. 
 

 
Drag from example point1 to point 2 using the left mouse button. 
Once you release after the second point, the wireframe will indicate 
as you move the pointer. When you see the desired size indicated, a 
left click will then effect the new size on that object, or set of objects. 
 
Press ESC to exit this mode or cancel if you selected incorrectly. 
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Pro Edit Rotate 
Right click an object or selection set, and click on Pro Edit Rotate 
 
 

 
The mouse pointer will change to the shown indicator. 
 
 

 
 
 
Hold down the left mouse button on eg. Point1 , and drag to point 2 
creating two reference points to rotate the object or object set. 
 
 

 
 
Once you release the mouse button on point 2, the wireframe 
indication will let you rotate , and when you are happy with the angle, 
just click with the left mouse button, and the transformation will 
occur. 
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 Pro Edit Resize Rotate 
This features a combination of resize + Rotate. 
 
Right click an object or selection set, and click on Pro Edit Resize 
Rotate.  
 
Perform exactly the same actions as for Pro Edit Resize, and the only 
difference is that the wireframe will now rotate and resize 
simultaneously as you move your cursor. The object tooltip 
constantly updates, letting you perform the actions accurately. 
 

 
When you select Pro Edit Resize Rotate, the cursor indicator will 
display as shown. 
 
 

 

 
Rotate/Resize, and when you see the wireframe fit your desired 
size/rotation, just left click to effect that transformation. 
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(Note: You can hold down Ctrl while dragging, and you can have the 
axis of lock at 90° or rotate it in increments. If not pressed, you can 
move the axis in a freestyle manner.) 
 
Pro Edit Mirror 
 
Select the object , or object set to mirror. This feature, mirrors the 
selected object or object set. 
 
Select Pro Edit Mirror 
This feature is used in a high % of embroidery operations, so you will 
probably find yourself using this, and Pro Copy+Mirror often. 
 

 
 
R/Click object and select Pro Edit Mirror 
 
 

 
 
Use the left mouse button to drag a line of reference for the mirror. 
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As you hold down the left mouse button and drag, you’ll see the 
wireframe indicator show the mirror position. As soon as you release 
the button, the object will be mirrored. 
 
(Note: You can hold down Ctrl while dragging, and you can have the 
axis of mirror lock at 90° or rotate it in increments. If not pressed, 
you can move the axis in a freestyle manner.) 
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Pro Copy Combo 
 
This feature allows multiple copies, and resizing simultaneously. 
 

 
Select an object 
 

 
Hold down with the left mouse button, and define 2 reference points 
by dragging from eg. Point 1 to point 2, and then release the mouse 
button. 
 
Once you have define the first 2 points, you are now ready to put Pro 
Copy Combo into action. This can be used for freestyle repetitions, or 
very accurate duplications. Once defined, all you need to do, is 
continue dragging subsequent sets of reference points, using the left 
mouse button, then releasing it each time. 
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Each subsequent drag using the left mouse button, will present you 
with a new object. 

 
You can repeat this as many times as necessary, and press ESC to 
exit this mode. 
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If you find yourself working over a backdrop with guides, or you have 
set up any kind of accurate guide for repetitions, you can produce 
symmetrical results fast. 
 

 
 
This example is just of a circular arrangement. 
 

 
 
Continue dragging 2 reference points each time. 
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You can create multiple object ‘combo’nations  at will. 
‘Combo’ merely refers to a combination of the features. 
 
 
If this diagram looks familiar, you may say ‘Hey! I can also use I-
Cliqq Array!’ , and that would be absolutely true, but this is also an 
option. I-Cliqq  Circular Array can give you exactly the same effect in 
double quick time, but this may suit you at different stages of design 
approaches. 
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Pro Copy Mirror Combo 
 
 
 

 
Select an object. 
 
 
 
 

  
 
Select Pro Copy Mirror Combo. 
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Define 2 reference points by dragging with the left mouse button. 
Point 1 to Point 2 ( You can define any mirror axis line as you desire) 
 
Press ESC to exit this mode when complete. 
 
Pro Copy Rotate 
This feature creates rotation copies or duplicates. 
 

 
 
Select an object  
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Select Pro Copy Rotate 
 

 
Drag holding down the left mouse button, from point 1 to point 2 and 
release. This defines your axis of rotation for the new copy 
(duplicate). 
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Once you have created the rotation axis, you can then drag from 
point 3 to point 4 , and repeat this drag action to make additional 
copies as suits your purpose. The object size will remain exactly the 
same. All you will now be doing is duplicating, but redefining an angle 
for that each time. 
 
Press ESC  when complete. 
 

 
You can create as many new objects as you need, all at user defined 
rotations. 
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Pro Copy Mirror 
This is probably every designer’s favorite feature, as this is used in 
almost daily tasks in numerous instances. If you are in fashion 
design, its invaluable…in fact, it is invaluable in probably 80% of daily 
operations. 
 
In this feature, all you have to do is select an object, and I-Cliqq will 
automatically create, and flip the object for you, letting you merely 
define an axis to complete your task. 
 

 
 
Select any object or set of objects. Remember that  using Mirror, 
usually means that the entry, and exit points of the objects to be 
mirrored should practically be in the same place if you’d like that 
mirror sewout  to run seamlessly with no jump connector. 
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Select Pro Copy Mirror 
 

 
 
The mouse pointer icon will display as above. 
 

I-Cliqq User Manual 616 



 
 
Hold down the left mouse button and drag from Point 1 to Point 2 , 
and release. While held down, you can actually change the mirror 
angle to any you prefer, but generally, the aim is to create seamless 
running embroidery, even with mirrors, so you would practically 
define the mirror axis along a grid or guideline you created. 
While you are dragging the axis, a wireframe will display, indicating 
the mirror position of the object to be created. 
 

 
 
As soon as you release the left mouse button, the transformation will 
take place immediately, and the new object or object set will be 
generated in the defined position. 
 
The mirror is now complete. 
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A general note on Pro Edit and Mirror. 
 
 

 
 
 

This is what you probably do NOT want to see, although technically, 
the mirror has been performed, and that is correct…so, before 
creating any mirror where you’d like the sewout to be seamless, 
make sure that the entry/exit points are in the same position, closest 
to the mirror axis. 
 

 
 
 

An indicator of where your entry/exit points should be on a mirror 
axis. 
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I-Cliqq Object Stream 
 
You are familiar with the normal actions of object selection by object 
edit of by polygon. I-Cliqq Object Stream , is actually an enhanced 
method of selection that will allow you a stepped up selection 
capability, where you can add or delete selection objects , that will 
actually remain in what we call a ‘phantom selection’ or ‘shadow 
selection’ until you physically deselect these objects. 
 
What does this do for me?? 
 
Well, the answer is simple. It means that you actually have a very 
simple, and accurate selection method without incurring the irritation 
of trying to select objects, then suddenly losing them as others are 
selected, then going through the entire task again. 
 
 How many times have you selected objects then suddenly lost them 
just when you thought you had that pinned down?? Its really 
irritating in a crunch. Did your fingers get all shivery and your 
stomach feel weak when you have a design deadline and things just 
keep slipping out of your grasp?? 
 
If you did, I-Cliqq’s Object Stream is for YOU! 
 
We made it really easy, and its pretty much like your shopping cart, 
so give this a try. 
 

 
 

The 3 shopping cart-like icons refer to the I-Cliqq Object Stream 
 

 
 
When no objects are a part of the object stream, these icons will 
appear greyed out or dimmed. 
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Tools>>Preferences>>HIGHLIGHT 
 

 
 
Select a color for how the Object Stream color will display. As with all 
function indicators, and any other that you will use as definition 
colors, you should select a color that you do NOT use in your normal 
palette colors for stitch display. This is so that you can easily 
recognize colors that are not part of the general ‘embroidery design’ 
display colors. 

I-Cliqq User Manual 620 



 
An example: 
For the purpose of this example, the Object Stream color is set to 
WHITE. You can choose any color as a default, or change the color at 
any time, depending on your workspace background, but remember 
to always choose a color for practical and optimal visibility. 
 

 
 
 
Let’s say we have this set of 5 objects: 
 

 
 
Now, we’d like to select object objects 1,3 and 5 to add to the Object 
Stream. 
 

 Using the standard Object Edit tool, left click on object 1 , and 
merely tap ‘A’ on your keyboard. 
 

 Object Check In/Out 
Tap ‘A’ to add/remove objects from the selection.   
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As soon as you tap ‘A’ you’ll see the object turn white. 
 
 
 
 

 
 
Repeat the steps above, clicking on an object and tapping ‘A’ each 
time. You’ll see the object Stream icons remain highlighted indicating 
that Object Stream is now ACTIVE. 
 
Note. Tapping ‘A’ once, highlights and adds that object, while tapping 
‘A’ again while it’s white, will deselect that from the Object Stream 
and return it to the former temporary level of Object Edit type ‘select’ 
mode, where you just see the normal ‘dashed select. 
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You can also just click on the icon, and you’ll see the former normal 
dashed view. 
 
 

 
 
You can also use the shortcut keys as displayed in the Information 
Tooltip ( Hint) 
 

 
 
Further to that, you can just hold down the SHIFT key, select a 
stream of objects by clicking the button repeatedly, add all 5 objects 
to the selection, and then tap ‘A’ , and you will see all objects turn 
white as they add to the Object Stream selection. 
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Clicking this icon, selects ONLY the highlighted objects in the Object 
Stream. So, whatever purpose you may have selected these objects 
for, you are now ready to execute operations on them. It may have 
been to modify the stitch densities, convert to a different practical 
stitchtype, move, rotate, resize etc. Whatever it may be, you are now 
ready to perform those tasks. 
 
Even if you click in open screenspace, and you see all objects 
seemingly ‘deselected’ , your phantom selection remains intact, and 
you can modify it, leave it in that ‘cart’ and continue working. This 
Object Stream selection will be unaffected by your normal operations. 
 

 Deselect Object Stream 
 
When you have no further use for the Object Stream, you can click 
the above icon. 
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This will revert Object Stream, to the normal Object Select Mode 

 
 
 

 
These are merely the basics of the I-Cliqq V1.0 capabilities. It is 
impossible to explain every aspect as many of the features operate 
on different levels, allowing you reasonable flexibility. Users are 
invited to share their Tipps ‘n Cliqq’s in the I-Cliqq demo forum as 
time permits. 
 

 
www.i-cliqq.com 
 
www.i-cliqq.com.au 
 
www.i-cliqq.de 
 
The distributor page on the i-cliqq site, will let you know who to 
contact closest in your region. There will be various information 
becoming available regarding tutorials, classes, webinars, and 
training. 
 
 
 

I-Cliqq User Manual 625 

http://www.i-cliqq.com/
http://www.i-cliqq.com.au/
http://www.i-cliqq.de/


General Shortcut Keys 

Shortcut Definition 

v& 
Bezier Curve Drawing Style 

v* 
Arc Curve Drawing Style 

v( 
Spline Curve Drawing Style 

vD 
Duplicate Selected Objects 

v- 
Extend Outline Symmetrical (Horizontally)  

v+ 
Extend Outline Symmetrical (Vertically) 

* 

Change Object Specifications, This key acts regarding  object type, For 
example, when a Tatami or a Motif object is selected, this key lets you change 
entry/exit points and fill angle visually on screen, if it contains a pattern, you 
can change pattern size, row and column distance. On Satin you can change 
entry/exit points. Outline Edit Tool ( ) will also let you change some of these 
parameters on screen. 
 

( 
Full Screen (without menus and toolbars, but shortcuts will work) 
 

v( 
Full Screen with menus, toolbars and shortcuts 

a& 
Show Stitch Directions 

qp 
Move Selected Object(s) to Front 

qr 
Move Selected Object(s) to Back 

vp 
Forward (Selected Objects) One 

vr 
Back (Selected Objects) One 

ap 
(Move Object) In Front  Of 

ar 
(Move Object) Behind … 

a+ 
Swap outlines (on dual curve objects like Satin) 

ve 

Always Refresh. When you edit the outline of an object, you can use this 
option to disable automatic stitch generation in order to edit outlines faster. As 
long as this option is active, the stitches of the selected object will not be 
shown 
 

aR 
Slow Redraw 

vY 
Snap To Grids 

- 
Snap To Objects (to snap to nodes of the currently being digitized objects, hold 
a and click on a node, in latest development, clicking on first node, will 
close/open the curve, hold q and click on first node to edit) 

+ 
Snap To Guidelines  
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x 

To end a column- Tap x 
The digitizing interchange depends on the last 2 selected stitchtypes. 
 
If you are digitizing, the tool will change like this if Auto Snap to Exit is not set 
to ON. 
Default : 
 

      
  Tap x then  becomes active edit the outline if required, 

tap x then  becomes active, if no clicks then tapping 

xwill give you , here you can  or tap xto 
change the tool to   again. 

 
Input change will swap the tool between the first selected tool (e.g ) and 

, when the tool switches to , you can select another tool, e.g. , 
then the input change will swap between  and , until you change the first 
tool ( ) 
 
You will need to practice a few column creations to experiment. 

e 
Add holes to objects (Tatami, Motif, Satin Fill, Contour Stitch, Cross Stitch and 
Satin with carve lines) If tapped while using Cross Stitch, subsequent 
segments are automatically branched. 

D Switch between 3D view ( ) and last active normal view ( ) 

H 
Highlight objects on mouseover ( )  

when active the mouse pointer shows ( ) 

L 
View Outlines eg. If in 3D Sewout mode, tap L to also see object outlines. 

. 
View stitch points. See Tools>Preferences>Enhanced to set color/style. 

Z 
Zoom in 

qZ 
Zoom out 

aZ 
Zoom 1:1 
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Standard Tool Bar 

 
 

Tool Bar Shortcut Definition 

 a N New 

 v  O Open a design 

 v S Save design 

  Print 

 v X 

When using  , Cut selected objects (to clipboard) 

When using  , Cut selected nodes (to clipboard) 

When using  , Cut selected stitches (to clipboard) 
 

 v C 

When using  , Copy selected objects to clipboard 

When using  , Copy selected nodes to clipboard 

When using  , Copy selected stitches to clipboard 
 

 v V 

When using  , Paste selected objects from clipboard 

When using  , Paste selected nodes from clipboard 

When using  , Paste selected stitches from clipboard 
 

 v Z Undo 

 q v Z Redo 

 a e Open/Close  properties dialog box 

  Import a design into current design 

  Export stitches 

  Zoom factor 

 (Off) 

 (On) 
 

f 

Insert mode 
Off: inserts new object at the end 
On: insert new object after the last selected or at current 
stitch point ‘within’ objects  ( nesting) 
 

 /  v f Lock/unlock background images 

 /  a @ 
Background image on/off 
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Drawing Tool Bar 
 

 
 

Tool Bar Shortcut Definition 
   

  
Object Edit Tool, This is the default active tool. If you use 
other tools, and when you are finished, or if you press 
s, or x, this tool will become active 
 

 v 1 Outline Edit Tool 

 v 2 Stitch Edit Tool 

 v 3 Cutter Tool 

 & Measurement Tool 

 

  (Mouse scroll wheel) Zoom in/out by mouse pointer 
location 

@ 

Zoom Tool 

 Zoom in 2X, set mouse pointer at screen center 

 Zoom out 2x, set mouse pointer at screen center 

 (click drag release) Zoom Window 
 

Z Zoom In 
q Z Zoom Out 2x 
a Z Zoom 1:1 

# Zoom Previous 
$ Zoom to All 
% Zoom to Selected  

 

^ 

q +  

v +  

Pan 
 
Horizontal Pan 
Vertical Pan 
 

 M Manual Stitch 

  Shape Tool (non embroidery objects) 

 q P Vector / Outline 

 R Running 

 Q Sequin Running 

 E E Stitch 

 q S Single Path Satin 
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 P Pattern Stitch 

 C Contour Stitch 

 q C ontour Single Path C

  Cross Stitch 

 S Satin 

  Satin (Double Divided) 

  Satin (Multi Divided) 
   

  Satin (Curve Lines) 

  Satin (E Style) 

  Satin (With Patterns) 

  Satin (Random Fill) 

 q mi  T Non Parallel Tata

 O Contour Tatami 

  T e Properties) Tatami ( For Trapunto se

  Single Curve Tatami Fill 

  Dual Curve Tatami Fill 

 q M Motif 

  Spiral Fill 

  Satin Fill 

 X Text 

  Star (Circular) 

  Star (Rectangular) 

 v R 
Rectangle (first select a digitizing tool like running or 
satin, then pick a shape tool) 
  

 v E Ellipse (first select a digitizing tool) 

  Triangle (first select a digitizing tool) 

  Rounded Rectangle (first select a digitizing tool) 

  Star (first select a digitizing tool) 
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  User Defined Shapes (first select a digitizing tool) 

 v T 
uto Trace, to use this tool, an image must be imported  

(first select a digitizing tool) 
 

A
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Property Tool Bar When Using  (Object Edit Tool) 

 
 

Tool Bar Shortcut Definition 

  Object(s) Horizontal Center Position 

  Object(s) Vertical Center Position 

  Object(s) Width 

  Object(s) Height 

 /   
Size (inch or mm) / Scale (%) 
 

 /   Proportional / Non-proportional Sizing 

  Object(s) Rotation Angle 

  Absolute Object(s) Rotation Angle 

  Flip Horizontal 

  Flip Vertical 

 G Group Selected Objects 

 q G Ungroup Select Groups 

 v G 
Add Object(s) To Previous Group (if there is no previous 
group, a new group will be created) 
 

  Group Branching 

  Group , Optimized connections 

  
Insert selected from closest point to first object in 
selection set, sequentially  

  
Insert selected from closest point to first object in 
selection set, individually 

  Add outline to object 

 v A Select All Objects 

 s Deselect objects 

  Invert Selection 

 v F Filter Selection 

  Select First Object 
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 q t Select Previous Object 

 t Select Next Object 

  Select Last Object 

 p  Travel by : Previous10 Stitches ie. go back 10 stitches 

 

J 
a j 

 

Previous Stitch 
Previous Function 

 

L 
a l 

 

Next Stitch 
Next Function 

 r  Travel by :Next 10 Stitches ie. go forward by 10 stitches 

 

 
v j 
v l 
v i 
v k 

 

Move Objects Left 
Move Objects Right 
Move Objects Up 
Move Objects Down 

 
\ 

v \ 
Increase Movement Value (mm: * 10) (inch: * 2) 
Decrease Movement Value (mm: / 10) (inch: / 2) 
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Additional Shortcut Keys When Using  (Object Edit Tool) 
 

Shortcut Action Definition 

s  Cancel any action 

q Resizing Resize selected objects by center 

v Resizing Increase the size by x2 , x4 , … 
Decrease the size by x½ , x¼ , … 

a Resizing Non proportional resizing 

q 
Mouse click on an 

object 
 

Add/Remove clicked object from the selection set  

q l  Add/Remove  next object to/from selection set 

q j  Add/Remove  previous object to/from selection set 

q
h 

 
Select objects from the currently selected to the first 
object 
 

qu  
Select objects from the currently selected to the last 
object 
 

v 
Mouse click on a 

blank area 

Lasso object select (  / ) , double click will end lasso 
mode and will selects objects 
if q is held down before double click, Objects within 
the lasso area will be added or removed to/from selection 
a + A will switch between lasso and normal 
selection mode 
 

 3 Add/Remove Sequin A 

 4 Add/Remove Sequin B 

 5 Add/remove Sequin A+B 
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Property Tool Bar When Using  (Outline Edit Tool) 
 

 
 

Tool Bar Shortcut Definition 

 
Double Click on an 

outline 

Add Node to Curve. This tool will add a node to the 
middle point between previous and next nodes. A mouse 
double click at any point of the curve will add a node at 
that point 
 

 y Remove Selected Node(s) 

 q 1 Convert Curve To Line (Bezier Mode) 

 q 2 Convert Line To Curve (Bezier Mode)  

 1 Make Node a Cusp (Bezier Mode) 

 2 Make Node Smooth (Bezier Mode) 

 3 Make Node Symmetrical (Bezier Mode) 

 4 
Remove Right Handle of the selected node (Bezier 
Mode) 

 5 Remove Left Handle of the selected node (Bezier Mode) 

  Size Selected Nodes 

  Rotated Selected Nodes 

  Offset Selected Outline 

 
A Or mouse click 

on first node in 
digitizing mode 

Auto Close Path . eg On a runstitch, clicking on the first 
node at the end automatically closes the shape. 

  Extended Selected Path 

  
Add outline (holes) to Object, if object supports that (eg 
Tatami holes) 

 v G Add Object(s) to Previous Group 

  Select First Object 

 q t Select Previous Object 

 t Select Next Object 

  Select Last Object 

  
View dragging curve type.  
 

  
Display tooltip when digitizing 
 

 
I-Cliqq Professional Software – Shortcut List 

 

10 



  

Swap mouse left and right buttons. Active in digitizing 
modes that support left and right clicks. 
Dimmed in Bezier Mode. 
 

  
Bezier drawing style (Enhanced Graphic Competence) 
 

  
Arc drawing style 
 

  
Spline drawing style (Similar to Arc-Spline) 
 

  
Arc-Spline drawing style (Traditional Simple Preferred) 
 

 

Additional Shortcut Keys When Using  (Node Edit Tool) 
 

Shortcut Action Definition 

s  Cancel any action 

q 

Creating a dual 
curve object (like 

Satin) 
 

Enter node position relative to the opposite node, only in 
horizontal or vertical position 

v 
Moving a node or a 

handle 
 

Move only in horizontal or vertical direction 

a 
Moving or creating 

a node 
 

Snap to the other nodes of the same object (to snap to 
other objects, you can use “Snap to Objects” - ) 

a 
Moving a Bezier 

handle Move handle point only in handle direction 

 

Mouse double click 
on a node 

 
Select all nodes of the curve 

v 
Mouse click on a 

blank area Lasso mode, double click to end lasso mode 

  
Cut / Copy / Paste outlines from one object  into another 
object 
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View Tool Bar 
 

    
 
Tool Bar Shortcut Definition 

 v ! Draft view, views outlines only  

 v @ Normal view, views outlines and stitches 

 v # Enhanced view, views outlines + stitches + stitch points 

 q 1 Stitches view, views stitches only 

 q 3 Stitches enhanced view, views stitches + stitch points 

 q 2 3D View 

  
Antialias Drawing, Smooth line drawings: if active, the screen 
refresh will be a bit slower 

  View Design Start End  = ON 

  AutoSet Design Center  

  Design Start (Click to custom select a point) 

  Design End (Click to custom select a point) 

 W View Schiffli repeats on screen 

  Open/Close object manager 

 
 

Property Tool Bar When Using  (Stitch Edit Tool) 
 

 
 

Tool Bar Shortcut Definition 

 
 Add  nodes between other nodes on outlines 

 

 y Remove Selected Nodes 

 1 Convert selected stitches into Normal Stitch 
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 2 Convert selected Stitches into Jump Stitch 

 3 Add/Remove Sequin A 

 4 Add/Remove Sequin B 

 5 Add/remove Sequin A+B 

  Size selected stitches 

  Rotated selected stitches 

  Align selected stitches 

  Stitch point display size 

  Insert stitches  

  Select first object 

 q t Select previous object 

 t Select next object 

  Select last object 

 p Previous 10 stitch increments 

 

j 
a j 

 

Previous stitch 
Previous function 

 

l 
a l 

 

Next stitch 
Next function 

 r  next stitches in increments of 10’s 

  
Cut / Copy / Paste Stitches from one object  into another 
object 
 

 

Additional Shortcut Keys When Using  (Stitch Edit Tool) 
 

Shortcut Action Definition 

s  Cancel any action 

v 
Moving selected 

stitches 
 

Move only in horizontal or vertical direction 

a 
Creating Manual 

Stitch 
 

Snap to the other stitches of the same object (to snap to 
other objects, you can use “Snap to Objects” - ) 

 
Mouse double 
click on a stitch Select all the stitches on an object 

v 
Mouse click on 

a blank area 
 

Lasso stitch select, double click to finish lasso mode. 
You can use the combination of q and v keys. 
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va 
Mouse click on 

a blank area 
 

Intelligent lasso stitch select, detect and select a block of 
stitches. Double click to finish lasso mode. You can use the 
combination of q and va keys. 
 

q 
Mouse click on 

a stitch 
 

Add stitches from the current stitch to the clicked one, to the 
stitch selection set. 

q l  Add/Remove next stitch to/from the stitch selection set 

q j  Add/Remove previous stitch to/from the stitch selection set 
 

q p  Add/Remove next 10 stitches to/from the stitch selection set 

q r  
Add/Remove previous 10 stitches to/from the stitch selection 
set 
 

qh  Select stitches from the current position till the first stitch 
 

qu  Select stitches from the current position till the last stitch 
 

h  Go to first stitch 

u  Go to last stitch 

y  Delete current stitch and move to next stitch 

n  Delete current stitch and move to previous stitch 

v j 
v l 
v i 
v k 

 

 

Move selected stitches left 
Move selected stitches right 
Move selected stitches up 
Move selected stitches down 

\ 
v \  

Increase movement value (mm: * 10) (inch: * 2) 
Decrease movement value (mm: / 10) (inch: / 2) 
 

 



Stitch Property Tool bar  

 
The icons on this tool bar will change regarding the kind of underlay you are creating or editing 
 

Tool Bar Shortcut Definition 

  
Underlay, enabled/disabled. Click the small triangle to 
expand/drag out the underlay toolbar if necessary or preferred. 

  
Center running underlay 
 

  
Edge running underlay 
 

  
Zigzag underlay 
 

  
Dual zigzag underlay 
 

  
Diagonal zigzag underlay 
 

  
Dual diagonal zigzag underlay 
 

  
Edge running underlay (closed curves) 
 

  
Tatami underlay 
 

  
Double tatami underlay 
 

 
a 1  

… 
 a 9 

Digitizing template,: will be activated when you pick a stitchtype 
too. Before becoming active, some user defined parameters 
need to be set. When set, as soon as you click on ‘default ‘ a 
popup showing the values will appear. 
 

  

Auto stitch generation on/off. When this option is ‘on’ the stitches 
of the object will be generated automatically while it is being 
edited and if ‘off’, the stitches of the object will remain 
unchanged. Note screen messages when activating. 
 

  Lettering font style 

  
Text Overall letter height 
 

  
Text width adjust 
 

  
Text height adjust   
 

  
Text width and height non-proportional resizing  
 

  Runstitch  length 

  
Column Width ( SPS) also known as midline columns. 
 

  
Center line position 
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Density 
 

 
  
General Tool Bar 
 

 
 

Tool Bar Shortcut Definition 

 
 

 

Convert Objects 
 Convert to Manual Stitch (remove path) 
 Convert to vector/object outline 
Convert to Running 
 Convert to Satin 

 
Width: Satin width (converting single curves to dual) 
Displacement: Center line positioning 

 Convert to Tatami 
 Convert to Motif 
 Convert to E Stitch 
 Convert to Single Path Satin 
 Convert to Non Parallel Tatami 
 Convert to Contour Tatami 
 Convert to Single Path Contour 
Convert to Contour Stitch 
 Convert to Pattern Stitch 
 Convert to Spiral Fill 
 Convert to Satin Fill (press * for angles) 
 Convert to Cross Stitch 

  

 K Lock Selected Objects 

 qK Unlock All Locked Objects 

  Hide Selected Objects 

  Show All Hidden Objects 

 a ! Guidelines On/Off 

 a # Grids On/Off 

 a % Cross Hair Cursors On/Off 

 V View unstitched objects  

 H Highlight object on mouseover 
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 a ^ Connectors on/off 

  Tooltip on stitch travel on/off 

  Filter Short Stitches 

  Highlight stitches of a preset length (Short Stitches) 

  Object Processor, Increases or reduces stitch counts 

 a - Reverse Selected Objects (swaps first/last stitch) 

 J Join Selected Objects (Note Object End to Object Start) 

  Retrace ( running objects) 

 
 
Machine Functions 

 
 
Tool Bar Definition 

 View Special functions (displayed symbols on screen)  

 Add/Remove Trim on selected stitch point 

 Add/Remove Stop on selected stitch point 

 

Tie In 
 Tie in by distance 
 Tie in off 
 Tie in always 

 

 

Tie Off 
 Tie in by distance 
 Tie in off 
 Tie in always 

 

 

Trim 
 Trim by distance 
 Trim off 
 Trim always 

 

 Tie in , Tie off, Trim inside groups and text objects 

 Show / Hide additional machine functions 
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Color Manager 

 
 

Tool Bar Definition 

 Select previous color in sequence 

 Current color (click to select a new color from color palette) 

 Select next color in sequence 

 
Eyedropper tool 
 

 Background color (or background image for 3D view) 

 
Object outlines color 
 

 /  Close / Open Color Manager 

 Reorder colors in use 

 Increase reduce image size 

 

Colors in use 

 Left click to select objects by color (you can also use q or v+ L/Click) 

 Right click view objects by color (you can also use v + R/Click) 

 double click to open Design properties to change color or choose a thread from charts 

 Select previous color in sequence 

 Select next color is sequence  

 View all colors 

 
Hoop Tools 

 
 
Tool Bar Definition 

 
Choose a new Hoop (hoop will be saved with the design, and every design can 
have a different hoop, but only one hoop) 
 

 Change Hoop Color 

 Remove Hoop 

 
Reposition Hoop 
 

 Rotate Hoop 
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View / Hide Hoop 
 

 

Property Bar When Creating Shapes (  ) 
 

 
 

Tool Bar Definition 

 

Width. This tool will take effect when creating a shape using a dual 
curve object like Satin, if you hold down the v key before any 
mouse click on screen, a ring will be created and this tool will define 
the width of the ring. 
 

 Shape Rotation Angle 

 Start Corners, affects on Start Shape 

 Star Corners Sharpness, affects on Star Shape 

 
Additional Shortcut Keys When Using Shapes 
 
Shortcut Action Definition 

s  Cancel any action 

q Resizing Resize by center of shape 

a Resizing Proportional resizing 

v 
Before any clicks 
on dual curve 
objects e.g. satin 

Create a Ring 

 
 
 

Property Bar When Using  (Auto Trace Tool)  
 

 
 

Tool Bar Definition 

 
Trace a hole or sub-path (if the object can have sub-paths, like Tatami) 
 

 
Reduce Nodes, A higher value will trace a path(outline) with less 
nodes 

 Color Tolerance, reduces colors of the image for better trace 
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I-Cliqq Object Stream 
 

 
 

 A 
Add /Remove Object Stream content 
(tap A while an object is selected) 

 q A 
Select Object Stream 
 

  
De-Select Object Stream 
 

  Refresh Stitches ( Should such instances occur) 

 
Dynamic Zoom Overview 
 

 

B 
Show/Hide Overview 
 

 

Digitizing Options 
 

  
Depressing this icon simulates holding down ALT – 
allows digitizing node on node. 
 

  

Draw as Open Curve. Switching this icon off/on 
determines whether you see an autoclosed appearance 
on tatami while digitizing. 
 

  
View Dragging Curve Off/On – Determines how you see 
outline creation as digitizing. 
 

  View Tooltip Info while Digitizing 

 
 
Additional Notes or Changes will appear as Release Notes 
Specifications are subject to change without notice. 

 
© I-Cliqq Professional Embroidery Software 
www.i-cliqq.com 
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